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Please read the Operation Guide before using the printer.
Keep it close to the printer for easy reference.




Caution

NO LIABILITY IS ASSUMED FOR ANY DAMAGE CAUSED BY IMPROPER INSTALLATION.

Legal Restriction on Printing

It may be prohibited to print copyrighted material without permission of the copyright owner. It is prohibited under any
circumstances to print domestic or foreign currencies. Printing other items may be prohibited.

Notice on Software

SOFTWARE USED WITH THIS PRINTER MUST SUPPORT THE PRINTER'S EMULATION MODE. The printer
is factory-set to emulate the PCL Sc. The emulation mode can be changed by following the procedures described in
Chapter 3.

Notice

The information in this manual is subject to change without notification. Additional pages may be inserted in future
editions. The user is asked to excuse any technical inaccuracies or typographical errors in the present edition.

No responsibility is assumed if accidents occur while the user is following the instructions in this manual. No respon-
sibility is assumed for defects in the printer's firmware (contents of its read-only memory).

This manual, any copyrightable subject matter sold or provided with or in connection with the sale of the page printer,
are protected by copyright. All rights are reserved. Copying or other reproduction of all or part of this manual, any
copyrightable subject matter without the prior written consent of Kyocera Corporation is prohibited. Any copies made
of all or part of this manual, any copyrightable subject must contain the same copyright notice as the material from
which the copying is done.

Trademarks and Notices

PRESCRIBE is a registered trademark of Kyocera Corporation. PRESCRIBE, KPDL, and KIR (Kyocera Image
Refinement) are trademarks of Kyocera Corporation.

Hewlett-Packard, PCL, and PJL are registered trademarks of Hewlett-Packard Company. Centronics is a trade name
of Centronics Corporation. PostScript is a registered trademark of Adobe Systems Incorporated. Macintosh is a regis-
tered trademark of Apple computer, Inc. Microsoft, Windows, and Windows NT are registered trademarks of Microsoft
Corporation. PowerPC is a trademark of IBM Corporation. Energy Star is the name of a program of the U.S. Environ-
mental Protection Agency. All other company, product, and service names may be trademarks or registered trademarks
of their respective companies.

This Kyocera Mita page printer uses PeerlessPrintXL to implement HP LaserJet-compatible PCL Sc language emula-
tion. PeerlessPrintXL is a trademark of The Peerless Group, Redondo Beach, CA 90278, U.S.A.

This product was developed using the Tornado™ Real Time Operating System and Tools from Wind River Systems.
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AGFA € This product contains UFS and MicroType® from Agfa Corporation.




IBM Program License Agreement

THE DEVICE YOU HAVE PURCHASED CONTAINS ONE OR MORE SOFTWARE PROGRAMS ("PRO-
GRAMS") WHICH BELONG TO IBM CORPORATION. THIS DOCUMENT DEFINES THE TERMS AND CON-
DITIONS UNDER WHICH THE SOFTWARE IS LICENSED TO YOU BY IBM. IF YOU DO NOT AGREE WITH
THE TERMS AND CONDITIONS OF THIS LICENSE, YOU MAY RETURN THE DEVICE FOR A FULL
REFUND WITHIN 14 DAYS OF PURCHASE. IF YOU DO NOT SO RETURN THE DEVICE WITHIN THE 14
DAYS, THEN YOU WILL BE ASSUMED TO HAVE AGREED TO THESE TERMS AND CONDITIONS.

The Programs are licensed not sold. IBM, or an authorized IBM dealer grants you a license for the Programs only in

the country where you purchased the Programs. You possess no rights other than those granted you under this license.

The term "Programs" means the original and all whole or partial copies of the original, including modified copies or
portions merged into other programs. IBM retains ownership of the Programs. IBM owns, or has licensed from the
owner, copyrights in the Programs.

1. License
Under this license, you may use the Programs only with the machine on which they are installed and transfer possession

of the Programs and the machine to another party.

If you transfer the Programs, you must transfer a copy of this license and any other documentation to the other party.
Your license is then terminated. The other party automatically agrees to these terms and conditions by first use of the
Program.

You may not:

1) use, copy, modify, merge, or transfer copies of the Program except as provided in this license;

2) reverse assemble or reverse compile the Program; or

3) sublicense, rent, lease, or assign the Program.

2. Limited Warranty
The Programs are provided ‘AS IS.’

THERE ARE NO OTHER WARRANTIES COVERING THE PROGRAMS (OR CONDITIONS), EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE.

Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.

3. Limitation of Remedies
IBM’s entire liability under this license is the following:

1) Forany claim (including fundamental breach), in any form, related in any way to this license, IBM’s liability will
be for actual damages only and will be limited to the greater of:
a) theequivalent of U.S.$25,000 in your local currency; or
b) IBM'’sthen generally available license fee for the Program

This limitation will not apply to claims for bodily injury or damages to real or tangible personal property for which IBM
is legally liable.

IBM will not be liable for any lost profits, lost savings, or any incidental damages or other economic consequential
damages, even if IBM, or its authorized supplier, has been advised of the possibility of such damages. IBM will not be
liable for any damages claimed by you based on any third party claim. This limitation of remedies also applies to any
developer of Programs supplied to IBM. IBM’s and the developer’s limitations of remedies are not cumulative. Such
developer is an intended beneficiary of this Section.

Some jurisdictions do not allow these limitations or exclusions, so they may not apply to you.

4. General

You may terminate your license at any time. IBM may terminate your license if you fail to comply with the terms and
conditions of this license. In either event, you must destroy all your copies of the Program. You are responsible for
payment of any taxes, including personal property taxes, resulting from this license. Neither party may bring an action,
regardless of form, more than two years after the cause of action arose. If you acquired the Program in the United States,
this license is governed by the laws of the State of New York. If you acquired the Program in Canada, this license is
governed by the laws of the Province of Ontario. Otherwise, this license is governed by the laws of the country in which
you acquired the Program.




Typeface Trademark Acknowledgement

All resident fonts in this printer are licensed from Agfa Corporation.
Helvetica, Palatino and Times are registered trademarks of Linotype-Hell AG.

ITC Avant Garde Gothic, ITC Bookman, ITC ZapfChancery and ITC Zapf Dingbats are registered trademarks of
International Typeface Corporation.

Agfa Japan License Agreement

1) ‘Software’ shall imply digitally encoded, machine readable, scalable outline data as encoded in a special format
as well as UFST Software.

2) You agree to accept a non-exclusive license to use the Software to reproduce and display weights, styles and
versions of letters, numerals, characters and symbols (‘Typefaces’) solely for your own customary business. Agfa
Japan retains all rights, title and interest to the Software and Typefaces and no rights are granted to you other than
a License to use the Software on the terms expressly set forth in this Agreement.

3) To protect proprietary rights of Agfa Japan, you agree to maintain the Software and other proprietary information
concerning the Typefaces in strict confidence and to establish reasonable procedures regulating access to and use
of the Software and Typefaces.

4) Youagree not to duplicate or copy the Software or Typefaces, except that you may make one backup copy.

5) ThisLicense shall continue until the lastuse of the Software and Typefaces, unless sooner terminated. This License
may be terminated by Agfa Japan if you fail to comply with the terms of this License and such failure is not
remedied within thirty (30) days after notice from Agfa Japan. When this License expires or is terminated, you
shall either return to Agfa Japan or destroy all copies of the Software and Typefaces and documentation as
requested.

6) You agree that you will not modity, alter, disassemble, decrypt, reverse engineer or decompile the Software.

7) AgfalJapan warrants that for ninety (90) days after delivery, the Software will perform in accordance with Agfa

Japan-published specifications. Agfa Japan does not warrant that the Software is free from all bugs, errors and
omissions.

THE PARTIES AGREE THAT ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING
WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE AND MERCHANTABILITY, ARE
EXCLUDED.

8) Yourexclusive remedy and the sole liability of Agfa Japan in connection with the Software and Typefaces is repair
or replacement of defective parts, upon their return to Agfa Japan.
INNO EVENT WILL AGFA JAPAN BE LIABLE FOR LOST PROFITS, LOST DATA, OR ANY OTHER
INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES CAUSED BY ABUSE OR MIS-
APPLICATION OF THE SOFTWARE AND TYPE FACES.

9) New York, U.S.A. law governs this Agreement.

10) You shall not sublicense, sell, lease, or otherwise transfer the Software and/or Typefaces without the prior written
consent of Agfa Japan.

11) Use, duplication or disclosure by the Government is subject to restrictions as set forth in the Rights in Technical
Data and Computer Software clause at FAR 252-227-7013, subdivision (b)(3)(ii) or subparagraph (c)(1)(ii), as
appropriate. Further use, duplication or disclosure is subject to restrictions applicable to restricted rights software
as set forth in FAR 52.227-19 (c)(2).

12) YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT, AND AGREE
TO BE BOUND BY ITS TERMS AND CONDITIONS. NEITHER PARTY SHALL BE BOUND BY ANY

STATEMENT OR REPRESENTATION NOT CONTAINED IN THIS AGREEMENT. NO CHANGE IN THIS
AGREEMENTIS EFFECTIVE UNLESS WRITTEN AND SIGNED BY PROPERLY AUTHORIZED REPRE-

SENTATIVES OF EACH PARTY.




FCC statement (for users in the United States)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This
device may not cause harmful interference, and (2) this device must accept any interference received, including inter-
ference that may cause undesired operation.

Note:

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is not
guarantee that interference will not occur in a particular installation. If this equipment does not cause harmful interfer-
ence to radio or television reception, which can be determined by turning the equipment off and on, the user is encour-
aged to try to correct the interference by one or more of the following measures:

«  Reorient or relocate the receiving antenna.

* Increase the distance between the equipment and the receiver.

¢ Connect the equipment into an outlet on a circuit different from that used for the receiver.
e Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the manufacturer for compliance could void the user's authority
to operate the equipment. Shielded circular cables should be used for interfacing with the computer.

Cautions to the user:

*  Anymodifications without prior permission of Kyocera may cause harmful interference.

« Ifany modifications or changes are made to this equipment without prior permission of Kyocera, Kyocera as the
manufacturer does not guarantee the compliance with the FCC Rules.

*  Theuse of equipment that does not comply with the FCC Rules is prohibited.
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Important Notes for Interface connectors

Be sure to power off the printer before connecting or disconnecting an interface cable. For protection against static
electricity discharge to the printer's internal electronics through the interface connector(s), cover any interface connec-
tor that is not in use with the protective cap supplied.

Use shielded interface cables.

Safety information

Laser safety:

This printer is certified as a Class 1 laser product under the U.S. Department of Health and Human Services (DHHS)
Radiation Performance Standard according to the Radiation Control for Health and Safety Act of 1968. This means
that the printer does not produce hazardous laser radiation. Because radiation emitted inside the printer is completely
confined within the protective housings and external covers, the laser beam cannot escape from the printer during any
phase of user operation.

Laser notice:

This printer is certified in the United States to conform to the requirements of DHHS 21 CFR Subchapter for Class I
(1) laser products, and is certified elsewhere as a Class I laser product conforming to the requirements of IEC 825-1.

Cautions:

+ Laserradiation will open. DO NOT STARE INTO THE BEAM OR VIEW THE BEAM DIRECTLY WITH
OPTICAL INSTRUMENTS.

»  Use of controls or adjustments or performance of procedures other than those specified herein may result in haz-
ardous radiation exposure.

Cautionary Labels

The printer bears any of the following labels.
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U.S. CDRH regulations

The Center of Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration implemented
regulations for laser products on August 2, 1976. These regulations apply to laser products manufactured on and after
August 1, 1976. Compliance is mandatory for products marketed in the United States. A label indicating compliance
with the CDRH regulations must be attached to laser products marketed in the United States.

Ozone concentration

The printers generate ozone gas (O3) which may concentrate in the place of installation and cause an unpleasant smell.
To minimize the concentration of ozone gas to less than 0.1 ppm, we recommend you not to install the printer in a
confined area where ventilation is blocked.

To Prevent Printer from Tipping Over

To prevent the FS-8000C printer from tipping over, the optional CA-31B caster kit must be installed when the printer
is installed with more than one paper feeder or a duplex unit. For detailed information on the CA-31B caster kit, see
page A-11.
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Declaration of Conformity for U.S.A.

Model name: Color Page Printer FS-8000C

Trade name: Kyocera Mita

Responsible party: Kyocera Mita America, Inc.

Address: 225 Sand Road PO Box 40008 Fairfield, New Jersey 07004-0008, U.S.A.
Telephone: (973) 808-8444

Fax: (973) 882-6000

Contact person for technical matter: Ryozo Kojima
Phone: (973)-882-6019

Manufacturer’s name: Kyocera Corporation, Printer Division
Manufacturer’s address: 2-14-9 Tamagawadai, Setagaya-ku, Tokyo 158-8610, Japan

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this
device may not cause harmful interference, and (2) this device must accept any interference received, including inter-
ference that may cause undesired operation.

The manufacturer and its merchandising companies retain the following technical documentation in anticipation of the
inspection that may be conducted by the authorities concerned.

User’s instruction that conforms to the applicable specifications.
Technical drawings.

Descriptions of the procedures that guarantee the conformity.
Other technical information.

Kyocera Mita America Inc.

CE Marking Directive

According to Council Directive 89/336/EEC and 73/23/EEC

Manufacturer’s name: Kyocera Corporation, Mie Plant Tamaki Block
Manufacturer’s address: 704-19 Nojino, Tamaki-Cho, Watarai-Gun, Mie-Ken 519-0497, Japan

Declares that the product
Product name: Color Laser Printer

Model number: FS-8000C / FS-8000CN
(as tested with enhancement optional units; Duplex unit PD-30, Paper Feeder PF-30A, Document
Finisher DF-31 etc.)

Conforms to the following product specifications:

EN55022: 1998 Class B

EN 61 000-3-2: 1995

EN61000-3-3: 1995

EN 55024: 1998

EN60950: 1992+A1+A2+A3+A4+A11
EN 60 825-1: 1994+A11

The manufacturer and its merchandising companies retain the following technical documentation in anticipation of the
inspection that may be conducted by the authorities concerned.

User’s instruction that conforms to the applicable specifications.
Technical drawings.

Descriptions of procedures that guarantee conformity.

Other technical information.
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Declaration of Conformity for Australia

Manufacturer’s name: Kyocera Corporation, Printer Division

Manufacturer’s address: 2-14-9 Tamagawadai, Setagaya-ku, Tokyo 158-8610, Japan
declares that the product

Product name: Page Printer
Model name: FS-8000C
Description of devices: This Page Printer Model FS-8000C is the 30 ppm (monochrome)/8 ppm (color), A4 size and
utilized plane paper; laser; dry toner; etc. The printer can be equipped with several enhancement optional units as a
paper feeder as PF-30A, a duplex unit as PD-30, a mailbox/sorter as SO-30, IB-21E, etc.
conforms to the following product specifications:

AS/NZS 3548: 1995 (EN 55 022: 1998 Class B)

IEC60950 (EN 60950: 1992+A1+A2+A3+A4+All)

IEC60825-1 (EN 60 825-1: 1994+A11)

The manufacturer and its merchandising companies retain the following technical documentation in anticipation of the
inspection that may be conducted by the authorities concerned.

User’s instruction that conforms to the applicable specifications
Technical drawings

Descriptions of procedures that guarantee conformity

Other technical information

The manufacturer has been employed with ISO9001 scheme. JQA and BS have attested the manufacturer.

Kyocera Mita Australia Pty., Ltd.

6-10 Talavera Road, North Ryde, NSW 2113, Australia
Telephone: +61 2-9888-9999

Fax: +612-9888-9588

Canadian Department of Communications compliance statement

This Class B digital apparatus complies with Canadian ICES-003.

Avis de conformité aux normes du ministere des Communications du Canada

Cet appareil numérique de la classe B est conforme a la norme NMB-003 du Canada.

ISO 7779

Maschinenlarminformationsverordnung 3. GSGV, 18.01.1991: Der hochste Schalldruckpegel betrdgt 70 dB (A) oder
weniger gemdf ISO 7779.

Disclaimer

Kyocera will not be liable to customers or any other person or entity for any loss or damage caused or alleged to be
caused directly or indirectly by equipment sold or furnished by us, including but not limited to, any interruption of
service, loss of business or anticipatory profits, or consequential damages resulting from the use or operation of the
equipment or software.
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ENERGY STAR®

As an ENERGY STAR Partner, Kyocera Corporation has determined that this product meets the
/_\ ENERGY STAR guidelines for energy efficiency.
W The basic objective of the ENERGY STAR Program is to reduce environmental pollution by
— encouraging the manufacture and sale of equipment that uses energy more efficiently.

This printer is equipped with a sleep timer function that conforms with the standards of the
ENERGY STAR Program. This function makes it possible to reduce the amount of electrical power consumed by the
printer. For maximum power savings, turn off the printer's power supply when not using the printer for extended periods
of time.

For details on the sleep timer function and printer power consumption, refer to this manual.

Initial settings of the sleep timer function and power saved using the sleep timer function:

. . Power consumption in
Initial sleep mode setting
sleep mode
FS-8000C
34 W (40 W)
FS-8000CD 30 minutes (30 minutes)
FS-8000CN 37 W (40 W)

(): ENERGY STAR program guideline

Kyosera ECO-PRODUCT

This product has been developed and manufactured with the express interest of reducing the
impact on the environment.

Using Kyocera's innovative cartridge free techology, Kyocera has created an advanced printing

3
Q
R system that does not require the wasteful replacement and disposal of a cartridge.
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Chapter 1 Introduction

Welcome to the professional color printer from Kyocera Mita. Using the Ecosys Color Printer,
you can now print top quality documents at 30 pages per minute for monochrome and 8 pages
per minute for color in A4, Letter, and A5 paper sizes.

The Kyocera Mita Ecosys Color FS-8000C Series printers are available in the following three
models:

Ecosys Color FS-8000C

Basic model of the FS-8000C Series. Equipped with two paper cassettes, each with a capacity
for holding 500 standard-size sheets of paper.

Ecosys Color FS-8000CD

FS-8000C Series model which is equipped with a duplexer (for two-sided printing) and a
paper cassette with a capacity for holding 500 standard-size sheets of paper.

Ecosys Color FS-8000CN

FS-8000C Series network model. Equipped with two paper cassettes, each with a capacity for
holding 500 standard-size sheets of paper. This model is also equipped with an network
interface card and a hard disk as the standard features.



1.1 Features

1.1

1.1.1

1.1.2

Features

General

Hardware

This section outlines the common major printer features of the FS-8000C, FS-8000CD, and
the FS-8000CN Ecosys Color printers.

Components with an ultra-long product life

The main printer components such as the imaging drum, development units, and fuser unit
have an ultra-long product life.

The imaging drum has been developed using Kyocera’s leading-edge ceramic technology
that makes full use of amorphous silicon.

High-speed printing

The printer supports print speeds of 30 pages per minute for monochrome outputs; and 8
pages per minute for color outputs. (Actual time varies according to page complexity.)

Superb color printing quality and versatile color control

Multi-bit color depth renders continuous tone images. The intelligent color calibration
system automatically optimizes colors every time the printer is powered.

Variety of paper sizes and types

In addition to ordinary paper, you can use print media such as transparencies, labels, and
other special papers for printouts.

Environmental-friendly materials

The toner container is made of materials that can be incinerated without polluting the
environment. (However, be sure to dispose of toner containers according to your local safety
code or regulations.)

Sleep mode

Conserves energy while printing is stopped.

Advanced Performance Data Processing

A 400 MHz CPU, 64 MB of RAM, and the optional hard disk deliver ideal throughput for
wide varying printing applications.




1.1.3

Software

1.1 Features

Two expansion slots for hardware interfaces

The printer is equipped with two expansion slots for plugging in optional network interface
cards and a hard disk. The expansion slot for network interface cards accommodates two cards
at the same time.

Standard bidirectional parallel interface

Ensures high-speed data transfer between the host computer and printer.

Memory card slot

You can select and read the data in a memory card set in this slot from the printer operator
panel.

Large-capacity paper cassettes

Each paper cassette can hold approximately 500 sheets of 80 g/m2 paper which is 0.1 mm
thick. The printer also has a multipurpose tray that can hold approximately 150 sheets of
nonstandard size paper. Printed sheets can be stacked in the face-down output tray or an
optional face-up output tray.

Displaying printer messages in any of eight languages

Printer messages can be displayed in English, French, German, Italian, Dutch, Danish, Spanish
or Swedish.

e-MPS

‘e-MPS’ is an abbreviation for ‘enhanced-Multiple Printing System,” which is a post-
processing function that combines electronic sorting, job retention, virtual mailboxing, and a
barcode printing system for job retrieval.

When printing multiple copies of a document, the data is transferred from the computer to the
printer only for the first copy; the data is then stored on the printer’s hard disk. Copies of the
document are printed using the stored data.

Printing is performed faster with less computer spooling time and less network traffic.

Furthermore, printed data that is stored on the hard disk can be called up using job retention
functions, such as Quick Copy etc., allowing you to quickly print additional copies of a
document from the printer at any time, without needing to re-spool the document or start up
the computer system.

Printer control language PRESCRIBE

The printer uses PRESCRIBE, Kyocera’s page printer control language with enhanced color
graphics capabilities. The simple commands of PRESCRIBE allow the programmers to easily
define pagination and device control.
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1.1.4

Networking

KPDL3 (Kyocera Printer Description Language 3)

The printer uses KPDL3, Kyocera’s implementation of the PostScript page description
language Level 3. The printer has 136 fonts that are compatible with Adobe PostScript
fonts. (The printer also has 80 PCL fonts.)

PDF417 two-dimensional bar codes

The printer has the built-in two-dimensional stacked bar codes of PDF 417 (Portable Data
File 417).

Ethernet network interface

The FS-8000CN comes built-in with a 10 Base-T/100 Base-TX network interface card for
readily connecting to a network.

SNMP compliance

The printer complies with Simple Network Management Protocol (SNMP). The SNMP is
used for providing and transferring management information (MIB) between the printer and
the host computer.

Support for network printer monitor utility (KM-NET VIEWER)

Allows network wide management of printers. See the readme file in the Kyocera Mita
Digital Library CD-ROM (comes with the printer) for details.
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1.2 Parts and Functions

This section provides explanations and illustrations for you to determine the parts and their
functions. Try to be familiar with the names and functions of these parts for correct use and
optimal performance.

1.2.1 Front

Figure 1-1

1 Operator Panel
Used to specify printer functions and display the printer operating status.

2  Paper-full Sensor
This sensor detects the tray full condition. When the Face-down tray is full, the printer
stops operating and urges you to clear the Face-down tray.

3  Front Cover
When open, this cover gives you access to the internal component for replacing toner
containers. The cover must also be open to clear paper jam.

4  Top Paper Cassette (FS-8000C/FS-8000CN)/Duplex Drawer (FS-8000CD)
The cassette holds up to 500 sheets of AS to A3 sizes. For the FS-8000CD, the top drawer
includes the duplexer for two-sided printing.

5 Bottom Paper Cassette
The cassette holds up to 500 sheets of A5 to A3 sizes as a second paper source (for the
FS-8000C and FS-8000CN).




1.2 Parts and Functions

6 MP (Multi-Purpose) Tray

The MP tray holds up to 150 sheets of standard and non-standard sizes. Transparencies,
envelopes, etc. must be fed using this tray.

Figure 1-2

7  Paper Stopper
This stopper, when flipped up, prevents the printed sheet of large size from falling.

8 Face-down Tray
This tray receives printouts face down.

9 Power Switch
This switch turns printer power on and off.

The power cord must not be unplugged from power at least 30 minutes since the printer
is switched off.

10 Side Cover
This cover is open by pulling the handle to clear paper jams.

11 Face-up Tray
This tray receives printouts face up.




1.2.2

Internal

1.2 Parts and Functions

Figure 1-3

Black Toner Container
This container holds black (K) toner. You must replace the container when the toner run
out.

Main Charger Unit
This is an electrical component used to transfer the toner onto the drum unit. The main
charger unit must be cleaned when you replace the toner container.

Yellow Toner Container
This container holds yellow (Y) toner. You must replace the container when the toner run
out.

Magenta Toner Container
This container holds magenta (M) toner. You must replace the container when the toner
run out.

Cyan Toner Container
This container holds cyan (C) toner. You must replace the container when the toner run
out.

Power Cord Connector
This connector accepts the power cord supplied with the printer.

The power cord must not be unplugged from power at least 30 minutes since the printer is
switched off.

Waste Toner Bottle
This plastic bottle collects waste toner for later disposal. The bottle has a cap which is
used to seal the bottle opening when being disposed of.
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1.2.3

Rear

8  Fuser Unit
The fuser unit fixes the toner permanently on the paper. The fuser becomes very hot
during printing.
9 Paper Feed Unit
The paper feed unit transports paper from the paper source for developing and fixing
images.
10 Separation Charger Cleaning Knob
This cleaning knob (green) is used to clean the separation charger. The separation
charger unit must be replaced after every 100,000 pages of printing and requires
professional servicing. Contact your Kyocera Mita dealer.
11 Primary Transfer Unit
This unit is used to create the image developed by toner and to transfer it onto the
surface of the paper.
@ 0,
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Figure 1-4
1 Vents
Air is purged through these vents to cool down the inside.
2  Parallel Interface Connector
This connector is for a standard Centronics parallel interface cable from the computer.
Connect this connector to the computer’s parallel port.
3  Paper Feeder Side Cover

This cover is opened to clear paper jams in the paper feeder section.
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4  Serial Interface Connector
This connector is for D-sub 25-pin RS-232C cable from the computer. Connect this
connector to the computer’s serial printer port with a serial cable.

5 Memory Card Slot
This slot receives a memory card. A memory card can hold fonts, macros, forms, etc., that
can be downloaded in the printer’s memory. For details, see Appendix A Options, section
A.3.1 Memory Card on page A-7.

6 Network Interface Card Slot (OPT1)
This slot holds an optional network interface card for network printing. (An optional Hard
disk can’t be used in this slot.) For details see Appendix A Options, section A.3.10 IB-20/
IB-21E Network Interface Cards on page A-13.

7  Hard Disk or Network Interface Card Slot (OPT2/HDD)
This slot holds an optional hard disk for storing print jobs or network interface card for
network printing. A Kyocera Mita manufactured hard disk must be used. For details, see
Appendix A Options, section A.3.8 HD-3 Hard Disk on page A-12.

8 Ozone Filter Duct
The ozone filter behind the duct is provided to prevent the ozone generated in the printer
from escaping out the air.

Do not block the cooling air in and out vents and the ozone filter duct against walls or with
other objects. If the flow of cooling air is blocked, heat will be built up in the printer, and
there will be a risk of fire.

1-9
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1.3 Clearance

Allow the following clearance on all sides of the printer.

—lﬂ Prolonged use without sufficient clearance may cause heat to build up within
the printer, resulting in fire.

Rear: 30 cm
(11-13/16 inches)

Left: 50 cm
(19-11/16 inches)

——
(]:
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Right: 50 cm

Front: 60 cm (19-11/16 inches)

(23-5/8 inches)

Figure 1-5




Chapter 2 Handling Paper

The printer can use a variety of media in various sizes. However, any media you will choose to
use with the printer must be in accordance with the guidelines and specifications in this
chapter. Use of paper not satisfying these guidelines and specifications may cause problems
such as frequent paper jams, poor quality printing, and possible damage to the printer
mechanism.

Even meeting the instructions provided in this chapter, special media such as transparencies,
labels, envelopes, non-standard-size paper must be fed directly from the printer’s MP (multi-
purpose) tray and delivered in the face-up tray in ‘straight path’ manner. For details on use of
MP tray, see Chapter 3 Using the Operator Panel, section 3.10.1 MP Tray Mode on page 3-79.
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2.1

211

21.2

General

The Ecosys Color FS-8000C Series printers are designed for high-grade bond (copy) paper,
like those widely used for ordinary xerographic copiers. The printers will also support other
types of paper as long as they meet the standards explained in this chapter.

Selecting the right paper is very important. Use of unsuitable paper can cause paper jams,
misfeed, curling, poor print quality, and even worse, printer damage. This chapter shows
you how to use your printer in a way that will ensure efficient, error-free printing and
minimal printer damage. This practice will increase your office productivity.

Kyocera Mita will not be liable for any problems that may occur if you use paper that
does not meet these standards.

Available paper types

The FS-8000C Series printers can use almost any type of printer paper. These printers
accept paper used for xerographic copiers as well.

Paper comes in three generic grades: economy, standard, and premium. The grades are
determined by how easily the paper can pass through the printer. This depends on the
smoothness, size, moisture content, and cutting of the paper. The higher the grade, the less
risk of problems (such as paper jams), and higher the print quality.

The differences in paper characteristics of different paper makers also affect the printer
performance. High-performance printers can produce high-quality results only when the
right types of paper are selected. Low-priced paper is not always economical, especially if it
ends up causing frequent printing problems.

Paper of the different grades is available in basis weights (explained later). The

recommended basis weights of paper for the printers are 16, 20, and 24 pounds. When

expressed in grams per square meter, the recommended basis weights range from 60 to 90 g/
2

m-.

Paper specifications

Table 2-1 summarizes the basic paper specifications. Details are given on the subsequent
pages.

Item Values

Weight (basis weight) Cassette: 64 to 90 g/m? (17 to 24 Ib/ream)
MP tray: 64 to 220 g/m2 (17 to 58 Ib/ream)’

Thickness 0.086 t0 0.110 mm (3.4 to 4.3 mils)

Dimensions See Table 2-3.

Dimensional accuracy 0.7 mm (£0.0276 inches)

Squareness of corners 90+0.2°

Moisture content 4t06%

Table 2-1
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Item Values
Direction of grain Long grain
Pulp content 80 % or more

Table 2-1 (Continued)

+  Paper of 135 to 220 g/m2 thick should be A4 or Letter size and fed laterally.

21.3 Minimum and Maximum Paper Sizes

The minimum and maximum paper sizes are as follows. For non standard paper such as cut-
sheet, the MP (multi-purpose) tray must be used.

I

Minimum
Paper
Size

5-13/16 inches

148 mm

80 mm
3-1/8 inches

458 mm
18 inches

Maximum
Paper Size

|- -

310 mm
12-3/16 inches

Figure 2-1

21.4 Recommended Paper

The following products are recommended for use with the printer for optimum performance.

Size Product Weight
Letter, Legal Hammermill LASER PRINT 90 g/mz (241b)
A4, A3 NEUSIEDLER COLOR COPY 90 g/m2

Table 2-2

2-3
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2.2

2.2.1

Selecting the Right Paper

Guidelines

To get clean, crisp printouts from laser printers all the time, select high-quality printer paper
that meets the printer’s requirements. Laser printers use laser beams, electrostatic discharge,
toner, and heat, all of which affect the paper. Furthermore, paper slide, bends, and twists as
it passes through laser printers during printing. Therefore, printer paper must be able to
withstand such great stress.

This section describes the major considerations for selecting the right printing paper.

Paper conditions

Do not use paper with folded edges, curls, warps, smudges, tears, or embossing. Also do
not use paper containing lint, clay, or paper debris. Using such paper may cause illegible
printing, misfeeds, paper jams, etc., and shorten the product life of the printer. Never use
paper with surface coating or other surface treatment. The paper surface should be as
smooth and even as possible.

Paper composition

Do not use paper with surface-coating or containing plastic or carbon. The heat of fusing
causes such paper to emit toxic fumes.

Bond paper should have at least an 80 % pulp content. The percentage of cotton and other
fibers should not exceed 20 %.

Paper sizes

Table 2-3 lists the standard paper sizes and dimensions. Note that certain paper sizes are
available only for MP tray feeding (as remarked) and face-up tray delivering. For details on
using MP tray, see Chapter 3 Using the Operator Panel, section 3.10.1 MP Tray Mode on
page 3-77.

The dimensional tolerances for these paper sizes are 10.7 mm (30.0276 inches) for both
length and width of paper. The corner angles must be 90 0.2 °.

Paper Size Dimensions Remarks
Ledger 11 X 17 inches

Legal 8-1/2 X 14 inches

Letter 8-1/2 X 11 inches

ISO A3 297 X 420 mm

ISO A4 210 X 297 mm

ISO AS 148 X 210 mm

JIS B4 257 X 364 mm

Table 2-3
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Paper Size Dimensions Remarks
JISBS 182 X 257 mm

Monarch 3-7/8 X 7-1/2 inches MP tray only
Business 4-1/8 X 9-1/2 inches MP tray only
ISODL 110 X220 mm MP tray only
ISO C5 162 X 229 mm MP tray only
ISO C4 229 X 324 mm MP tray only
ISOBS 176 X 250 mm MP tray only
ISO A6 105 X148 mm MP tray only
Executive 7-1/4 X 10-1/2 inches MP tray only
Commercial 9 3-7/8 X 8-7/8 inches MP tray only
Commercial 6-3/4 3-5/8 X 6-1/2 inches MP tray only
JIS B6 128 X 182 mm MP tray only
Japanese postcard 100 X 148 mm MP tray only
Japanese double-postcard 148 X 200 mm MP tray only
Custom 80 X 148 mm to 310 X458 mm  MP tray only

Table 2-3 (Continued)

2.2.2 Paper properties

Smoothness

Paper should have a smooth, uncoated surface. Paper with a rough or sandy surface can cause
gaps in printouts. However, paper with surfaces that are too smooth may cause multiple-sheet
feeding and fogging problems (fogging is a gray background effect).

Basis weights

Basis weight is the weight in pounds of 500 sheets (called a ream) of paper cut to the basic
size, which is 17 X 22 inches. The number of sheets in a ream and the basic paper size relating
to basis weights depend on paper classifications. In the metric system, the basis weight is
expressed in grams per square meter (g/mz).

Paper that is too heavy or too light may cause misfeeds, jams, and premature wear of printer
parts. Uneven weight of paper can cause multiple-sheet feeding, print defects, poor toner
fusing, blurring, and other print quality problems. The recommended basis weights for this
printer are between 64 and 90 g/m2 (17 to 24 1b per ream).

When you use paper with basis weights of 135 to 220 g/mz, use the face-up tray for high-
quality printouts.

Thickness (Caliper)

Thick paper is called high-caliper paper and thin paper is called low-caliper paper. Paper used
by the printer should be neither too thick nor too thin. If you encounter paper jam, multiple-
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sheet feed, or too light printing problems, the paper may be too thin. If you encounter paper
jam or too heavy printing problems, the paper may be too thick. The recommended
thickness of a sheet for this printer is between 0.086 and 0.110 mm (from 3.4 to 4.3 mils).

Moisture content

Moisture content is the percentage of the weight of water in paper. Moisture affects the
appearance, feeding, curling, electrostatic properties, toner fusing of the paper.

The moisture content of paper varies with the relative humidity in the room. If the room is
too humid, paper will absorb more moisture. The edges will swell and the paper will
become wavy. If the room is too dry and the paper loses moisture, the edges shrink and
tighten, and the print contrast may be degraded.

Wavy or tight edges can cause paper misfeeds and misalignments. The recommended
moisture content is between 4 and 6 %.

To maintain the correct moisture content level, store the paper in an environment that allows
moisture control. These are tips for moisture control:

»  Store paper in a cool, dry place.

* Leave packages of paper wrapped as long as possible. Rewrap unused paper.

*  Return paper to its paper carton, whenever possible. Place the cartons on a pallet or
other furniture so that they are not in direct contact with the floor.

* Before using paper stored for an extended period of time, condition it in the printer’s
environment for at least 48 hours.

* Do not expose paper to heat, direct sunlight, or damp.

Grain

Technically, grain is the direction of paper in the paper machine. Grain is parallel with the
direction of movement in the paper machine. Grain long means that the grain runs along the
length of the sheet, and grain short means that the grain runs along the width of the sheet.
Because grain short causes paper feed problems, always select grain long for the printers.
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2.2.3 Other properties of paper

Porosity

The density of paper structure, which indicates the compactness of the fiber bonding. It is also
the characteristic that allows air to pass through paper (i.e., air permeability).

Stiffness

The ability of paper to resist deformation under stress. In the printer, limp paper can buckle
and too stiff paper can bind. Both conditions result in paper jams.

Curl

Most paper naturally tends to curl one way. To produce flat printouts, load the paper sheets so
that the upward pressure from the printer can correct their curling. When loading paper, it is
also important to distinguish between the front side and backside of the paper. Be sure to
follow the paper loading instructions printed on the paper carton.

Electrostatic discharge

During the printing process, paper is given an electrostatic charge to attract the toner.
Therefore, the paper must discharge the static electricity so that the printouts do not stick to
each other in the output tray.

Whiteness

The contrast of printed images depends on the whiteness of the paper. Whiter paper produces
sharper and clearer images.

Quality control

Uneven paper sizes, corners that are not square, jagged paper edges, irregularly cut sheets, torn
edges and corners, etc. can cause various printer troubles. Before purchasing paper, find out
whether the paper store always takes measures to prevent such problems in its products.

Packaging

Paper sheets should be shipped in strong cartons to protect them from damage during
transportation. Before purchasing paper, make sure the store ships its products in proper
packages.

2-7
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2.3

2.31

Special Paper

Besides plain paper, this printer can use the following types of special paper:

* Transparencies
*  Pre-printed

* Labels

* Bond

* Recycled

e  Vellum

* Rough

* Letterhead
* Color

*  Pre-punched
* Envelope

*  Card stock

e Coated

«  Second side’
e Customs

+  Paper printed using this printer only. You cannot use paper already copied or printed by another
printer.

You can assign one of these special paper type to a paper cassette or MP (multi-purpose)
tray by using the printer’s operator panel keys. Then, the printer can automatically select the
paper cassette or malti-purpose tray to feed the special paper from and internally adjust the
electrical parameters for optimum printing performance according to the special paper type.
For details, see Chapter 3 Using the Operator Panel, section 3.10.4 Setting the Cassette
Paper Type on page 3-82.

Note that some types of special paper do not allow feeding from the paper feeder cassette or
duplex (two-sided) printing.

Selecting the Special Paper

4l

Note

Since special paper differs significantly in paper composition and quality, special paper is
more likely to cause problems than white bond paper during printing. When using special
paper, be sure that they are manufactured for photocopiers and/or laser printers.

Before purchasing any special paper, make a test print using the printer and check whether
the results are satisfactory.

Kyocera Mita shall not be liable for any danger to a person or machine that is caused
by using special paper (e.g., fumes emitted from the special paper).

To avoid problems, stack transparencies, labels, or envelopes on the tray or cassette face up.

Major considerations for each type of special paper are given below.
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Transparency

Transparencies for overhead projectors must withstand the heat of fusing during the printing
process. The recommended transparency product is as follows:

3M CG3700 (Letter, A4)

Transparencies must be placed on the MP (multi-purpose) tray with the long edge towards the
printer. To avoid problems, stack transparencies face up on the face-up tray.

When unloading transparencies (e.g., for clearing jams), hold them carefully by the edges to
avoid leaving fingerprints on them.

Adhesive-backed labels
Label paper must be fed manually.

For printing on labels, use extreme care so that the adhesive may not come in direct contact
with any part of the printer. Adhesives that stick to the drum or rollers will cause printer
damage.

Labels consist of three parts. Printing is done onto the top sheet (also called the face sheet).
The adhesive contains chemicals. The carrier sheet (also called the backing paper or liner)
bears the top sheet. This composition of labels can cause more problems than other print forms
during printing.

— Top sheet (white bond paper)

— Adhesive

— Carrier sheet

Figure 2-2

When using label paper, do not leave gaps between the arranged labels (i.e., top sheets). Labels
arranged with gaps in-between can easily be peeled off during printing, causing serious jam
problems.

When the label paper has extra margin around the label’s outside edges that correspond to the
margins of the printable area, do not remove the extra top sheet from the carrier sheet until
printing is finished.

Allowed Not allowed

~&—Top sheet

Carrier sheet ——»>

Figure 2-3




2.3 Special Paper

When selecting labels, make sure to use only those meeting the following requirements:

Item Value

Top sheet weight 44 t0 74 g/m? (12 10 20 Ib)

Total weight 104 to 151 g/m? (28 to 40 Ib)

Top sheet thickness 0.086t0 0.107 mm (3.9 to 4.2 mils)
Total thickness 0.115t0 0.145 mm (4.5 to 5.7 mils)
Moisture content 4 10 6 % (composite)

Table 2-4

Envelopes

Envelopes must be fed manually.

Since the composition of an envelope is more complex than that of ordinary paper, it is not
always possible to ensure consistent printing quality over the entire envelope surface.

Normally, envelopes have a diagonal grain direction. See section Grain on page 2-6. This
direction can easily cause wrinkles and creases when envelopes pass through the printer.
Before purchasing envelopes, make a test print to check whether the printer accepts the
envelope.

Other handling cautions follow:

* Do not use envelopes that have an encapsulated liquid adhesive.

* Avoid a long printing session for envelopes only. Extended envelope printing can cause
premature printer wear.

* To avoid jams caused by curled envelopes, stack the printed envelopes no higher than
10 on the output tray.

Colored paper

Colored paper should have the same specifications as the white bond paper listed. In
addition, the pigments in the paper must be able to withstand the heat of fusing during the
printing process (up to 200 °C or 392 °F).

Pre-printed paper

Pre-printed paper should basically be bond paper. The inks on the paper must be able to
withstand the heat of fusing during the printing process and must not be adversely affected
by silicon oil. Do not use paper with any kind of coating, such as calendar stock.

Recycled paper

Select recycled paper that has the same specifications as white bond paper. See Table 2-1 on
page 2-2. Recycled paper, however, does not have to be as white as white bond paper.

Before purchasing recycled paper, make a test using the printer and check whether
the print quality is satisfactory.
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Chapter 3 Using the Operator Panel

This chapter provides the information you need to configure the Ecosys Color printer. In
general you need to use the operator panel only to make default settings. You can make most
changes to the printer settings using the printer driver trough the application software. For
details, see Chapter 4 Printer Drivers and Utilities.

Changes to printer settings made using a software application override changes made
using the operator panel.

4y

You can also rely on other printer utilities such as Kyocera Mita PrintMonitor if you need to
change settings that are not available on the printer driver. It will allow you remotely access to
printer settings. Printer utilities are supplied in the software CD-ROM supplied with the
printer.

The chapter describes the operator panel in detail, including its menus and the procedures for
changing various printer settings.



3.1 Understanding the Operator Panel

3.1 Understanding the Operator Panel

The operator panel on the top of the printer has a 2-line by 16-character liquid crystal display
(LCD), eight keys, and three indicators (LED).

— = —
READY DATA ATTENTION

GO Ready
PAR A4 PLAIN

O O

®
@ @
©

— — ———————
INTERFACE  SIZE  TYPE

Figure 3-1

Messages that appear on the display and functions of indicators and keys are explained in the
sections that follow.

3.1.1 Message Display

The message display on the operator panel shows:

»  Status information, the eight messages listed below which are displayed during normal

operation.
*  Error codes, when the printer requires the operator’s attention; as explained in Chapter 5

Troubleshooting.

Status Information

Message Meaning
Self test The printer is performing self-diagnostics after power-up.
Please wait The printer is warming up and is not ready.

When the printer is switched on for the first time, the message
display shows Adding toner which will take several
minutes.

Table 3-1
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3.1.2

3.1 Understanding the Operator Panel

Message

Meaning

Please wait

The color calibration function is being performed automati-

(Calibrating) cally as you powered on the printer.
You can also execute this function manually on the operator
panel. For details, see Section 3.11.4 Color Calibration on
page 3-100.

Ready The printer is ready to print.

Processing The printer is receiving data to print. This is also shown when
the printer is reading a memory card or hard disk.

Sleeping The printer is in sleep mode. The printer wakes from sleep

mode whenever a key on the operator panel is pressed, the
cover is opened or closed, or a print job is received. The printer
then warms up and goes on-line. For details on sleep mode, see
Section Sleep Timer Timeout Time on page 3-107.

Cancelling data

Jobs inside the printer are being canceled. To cancel a job, see
Section 3.1.3 Keys on page 3-6 .

Waiting

The printer is waiting for the rest of print job before complet-
ing thelast page. Pressing the GO key allows you to obtain the
last page immediately. See below.

FormFeed TimeOut

The printer is printing the last page after a waiting period.

Table 3-1 (Continued)

Error codes

See Chapter 5 Troubleshooting.

Indicators in Message Display

AN A
Ready
PAR A4 PLAIN
INTERFACE ~ SIZE ~ TYPE
\/ \J
Figure 3-2

Interface Indicator (INTERFACE)

The interface indicator shows the interface that is currently in use:

PAR Parallel interface is in use.
SER Serial (RS-232C) interface is in use.
OP1(2) Network interface is in use.

--- No interface is in use.

Each interface has a timeout time of 30 seconds during which the other interface should wait to
receive a print job. Even a print job has been complete on the interface, you should wait for
this period until the other interface begins printing the job.
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3.1 Understanding the Operator Panel

Paper Size Indicator (SIZE)

This indicator indicates:

*  While the printer is in standby, the paper size of the cassette. The default paper cassette is
determined by the operator panel keys. For details, see Section 3.10 Paper Handling on
page 3-79.

*  While the printer is printing, the paper size used to format the document to print by the
application software.

The abbreviations used to indicate the paper sizes and their dimensions are as follows:

A3 I1SO A3 (29.7 x 42 cm)

A4 SO A4 (21 x 29.7 cm)

AS ISO A5 (14.8 x 21 cm)

A6 ISO A6 (10.5 x 14.8 cm)’

B4 JIS B4 (25.7 % 36.4 cm)

B5 JIS B5 (18.2 x 25.6 cm)

B6 JISB6 (12.8 x 18.2 cm) '

LT Letter (8-1/2 x 11 inches)

LD Ledger (11 x 17 inches)

LG Legal (8-1/2 x 14 inches)

MO Monarch (3-7/8 x 7-1/2 inches)*

BU Business (4-1/8 inches)

DL ISODL (11 x 22 cm)'

c4 ISO C4 (22.9 x 32.4 cm)'

c5 ISO C5(16.2 x 22.9 cm)'

b5 ISOB5 (17.6 x 25 cm)’

EX Executive (7-1/4 x 10-1/2 inches)T
#6 Commercial 6-3/4 (3-5/8 x 6-1/2 inches)T
#9 Commercial 9 (3-7/8 x 8-7/8 inches)T
HA Japanese Postcard (10 x 14.8 cm)’
OH Return Postcard (20 x 14.8 cm)’

cu Custom Size (8 x 14.8 cm to 31 x 45.8 cm)’

+  Only with MP tray feeding

Paper Type Indicator (TYPE)

This indicator shows the paper type defined for the current paper casette. The paper type can
be manually defined using the operator panel. For more information, see Section 3.10 Paper
Handling on page 3-79.

The following abbreviations are used:

(none) Auto

PLAIN Plain paper
TRNSPRNCY TransparencyT
PREPRINTE Pre-printed paper
LABELS LabelsT

BOND Bond paper
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3.1 Understanding the Operator Panel

RECYCLED Recycled paper
VELLUM Vellum?

ROUGH Rough paper
LETTERHEA Letterhead

COLOR Colored paper
PREPUNCH Pre-punched paper
ENVELOPE Envelope
CARDSTOCK Card stock "
COATED Coated paper

2ND SIDE Second side of paper
CUSTOML (to 8) Custom 1 (to 8)

+ Only with MP tray feeding

READY, DATA, and ATTENTION Indicators

The following indicators light during normal operation and whenever the printer needs
operator’s attention. Depending on the status of lighting, each indicator has the following
meaning:

Indicator Description

Flashing. Indicates an error that you can recover by yourself,
READY such as the loose front cover. For details, see Chapter 5 Trou-
bleshooting, section 5.3.1 Error Messages on page 5-7.

On. Indicates that the printer is ready and on-line. The printer
prints the data it receives.

Off. Indicates that the printer is off-line. Data can be received
but will not be printed until the printer is on-line by pressing
the GO key. Also, indicates when printing is automatically
stopped due to the occurrence of an error. For details see
Chapter 5 Troubleshooting, section 5.3.1 Error Messages on
page 5-7.

= Flashing. Indicates that a data is being received from the
DATA computer.

On. Indicates either that data received is being processed
before printing starts, or that data received is being written to a
memory card or a hard disk.

— Flashing. Indicates that the printer requires maintenance or is
ATTENTION warming up.
On. Indicates the occurrence of a problem or an error. For
details, see Chapter 5 Troubleshooting, section 5.3.1 Error
Messages on page 5-7.

Table 3-2
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3.1 Understanding the Operator Panel

3.1.3

Keys

4

Note

The operator panel keys are used to configure the printer operation. Note that certain keys
have the secondary function.

The printer has a parallel, serial, and an optional network interface. Configuration to the
printer settings made with these keys affect only one of these interfaces that is currently
active (indicated by the INTERFACE indicator on the message display). See Interface
Indicator (INTERFACE) on page 3-3.

GO Key

GO

The GO key switches the printer between on-line and off-line. Use this key to:

+ Toggle the printer’s on-line and off-line states. You can temporarily stop the print job by switching the
printer off-line.
+ Print and feed out one page when the printer displays Waiting.

CANCEL Key

CANCEL

This key is used to:

* Cancel a printing job
«  Stop the alarm sound

* Reset numeric values or cancels a setting procedure while using menu system

To cancel a printing job:

1 While the printer displays Processing, press the CANCEL key.

Print Cancel? appears on the message display followed by the interface which the
job to cancel is on. The interface is indicated by one of the following message:

Parallel
Serial

Option 1
Option 2

If you wish to abort the cancellation procedure, press the CANCEL key again.

2 Press the ENTER key. Cancelling data appears on the message display and
printing stops after the current page is printed.
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3.1 Understanding the Operator Panel

MENU Key

MENU

The MENU key lets you enter the menu system to change the setup and printing environment
of the printer.

Pressing this key during a menu selection will terminate the selection and return the printer to
the normal operation.

®
@ @
®

The four arrow keys are used in the menu system to access a desired item or enter numeric
values.

The arrow key with the question mark (?) may be pressed when the paper jam message has
appeared on the message display. Then a help message will appear to facilitate jam clearing in
the location.

ENTER Key

O)

ENTER

The ENTER key finalizes settings of numeric values and other selections.




3.2 Using the Menu Selection System

3.2

3.2.1

Using the Menu Selection System

Menu System

This section explains how to use the menu selection system. The MENU key on the operator
panel allows you to enter the menu when the printer is in ready state.

The printer operates according to the most recent printer settings sent from the
application software, or from the printer driver, which take priority over the settings
made using the menu selection system.

Road Map

The overview of the printer’s menu system is diagrammed below and on the following pages.
For convenience, the printer can print out the simplified version of menu map. To print a menu
map, see Section 3.3.1 Printing a Menu Map on page 3-14.

The shaded items mean that these are available only when the corresponding optional device is
installed in the printer. For example, @-MPS and its submenus will not appear unless a hard
disk is installed in the printer.

Ready
PAR A4 PLAN

MENU Key
Print
Menu Map
Print
Status Page

e-MPS

>H>Quick Copy H

|
>Private/Stored

N
>Print VMB Data

N
>List of VMB

>List of
Code JOB

>e-MPS
Configuration

> H >>Quick Copy

N
>>Temp.Code JOB H

Size

|
>>Perm.Code JOB
Size

|
>>VMB Size

Continued on the next page
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Continued

Interface >
Parallel

Interface >

Serial

Interface >
Option 1
Interface >
Option 2

Emulation >
PCL 5c

Emulation >
KC-GL
Emulation >
KPDL
Emulation >
| KPDL (AUTO)

Continued on the next page

3.2 Using the Menu Selection System

>Parallel I/F
Auto

>Baud rate

9600
I

>Data Bits
8

>Stop Bits
1

>Parity
None

>Protocol
DTR (pos.) &XON

>Barcode Mode
Off

>NetWare

Off

NetWare >>NetWare Frame
| Oon Auto
>TCP/IP

Off

>TCP/IP >>DHCP

On OFF

v :lj — = =

>Ether Talk
Off

>>IP Address

>OPT.
Off

StatusPage

] >>Subnet Mask

>>Gateway

>Code Set
ISO-6 ASCII

>KC-GL
Adjust

Pen >
Pen (1)

>>Pen(l) Width
01 dot(s)

>KC-GL
[SPSZ]

Page Set

>Pen(l) Color

Black

>Print
Off

KPDL Errs

>Alt. Emulation
PCL 5c

|
>Print KPDL Errs
Off

— = — = I —
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3.2 Using the Menu Selection System

Continued

Font

> >Font Select >
Internal

>Font Select
Option

>

>List of
Internal Fonts

>List of
Option Fonts

]

Page Set

> >Copies
001

>Orientation
Portrait

>Page Protect
Auto

>LF Action
LF only

|
>CR Action
CR only

Print Quality >H>KIR Mode
On

>EcoPrint Mode

Off
|
>Tone
Normal

>Gloss Mode

— | —T —T | —7" | == [.— L—T L/

Low

Opt. ROM > >Read Data |
>List of
Partitions

Hard Disk >HRead Data |
>Write Data |

>> 1000

>>Courier
Regular

>>Letter Gothic
Regular

|
>>Size
012.00 point(s)

>>Pitch
10.00 cpi

>Delete Data

>List of
Partition

Continued on the next page
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Continued

RAM Disk Mode
Off

3.2 Using the Menu Selection System

RAM Disk Mode
On

>

>RAM Disk Size

>Read Data

>Write Data

>Delete Data

>List of
Partitions

Memory Card

>Read Fonts

>Read Data

>Write Data

>Delete Data

>Format

>List of

Partitions

Paper Handling > H

>MP Tray Mode
First

>MP Tray Size
A4

|
>MP Tray Type
Plain

|
>Cassette 1 Type
Plain

>Cassette 2 Type
Plain

|
>Feed Select
Cassette 1

u
>Duplex Mode

None
|

>Stack Select
Face-down tray

>0Opt.StackerMode
None

>Override A4/LT
Off

>Type Adjust >

Custom 1

Continued on the next page

|
>Reset Type >>Paper weight
Adjust Normal
T = =
>>Fuser Mode
Low
|
>Duplex Path
Disable




3.2 Using the Menu Selection System

Continued

Clolor Mode > >RGB Simulation
Color None

l
>Ink Simulation
None

>Color
Calibration

Life Counters >H>Total Print

>01l1 Kit

>New Toner[C]
Installed

>New Toner [M]
Installed

>New Toner[Y]
Installed

>New Toner [K]
Installed

Continued on the next page
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3.2 Using the Menu Selection System

Continued

Others > >MSG Language
English

. =
>Form Feed
Time Out 030sec.

>Sleep timer > >>Sleep Mode
030 min. Oon

>Print HEX-DUMP

>Printer Reset

>Resource Prot.
Off

>Buzzer
Oon

>Auto Continue > >>Auto Continue
Mode On Timer 000sec.
Auto Continue
Mode Off

>Service > >>Print
Status Page

>>Print
Test Page 1

>>Print
Test Page 2

>>Drum

>>Developer

>>Maintenance

(2]
I

>>Maintenance

5]
I

>>Maintenance
[C]

>>Maintenance
[D]
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3.3 Menu Map and Status Pages

3.3 Menu Map and Status Pages

This section explains the procedure for printing the printer’s internal information using the
menu selection system. The menu map is usefull as a reference to guide yourself through the
menu selection system.

The status page is a list of parameters and settings for most basic printer configurations. You
may be required to produce a status page when requesting service to the printer.

3.3.1  Printing a Menu Map

The printer prints a full list of menu selection system — Menu Map. Note that menus shown in
the list may vary depending on which optional units installed in the printer.

1 Press the MENU key.

O

=
m
z
C

2 Press the A or V key repeatedly until Print Menu Map appears.

@ @? Print

Menu Map

®

3 Press the ENTER key. A question mark (?) appears.

O ©

Print
Menu Map ?

If you wish to abort the printing of the menu map, press the CANCEL key.

4 Press the ENTER key. The message Processing appears and the printer prints a
Menu Map.
ENTER
An example Menu Map is shown on the next page.




3.3 Menu Map and Status Pages

2] KYOCERD
~Jmita_

Print
Menu Map

Print
Status Page

Interface
Par.

>Parallel I/F
Auto

Emulation
PCL 5¢

Ve
ECosrsm FS-8000C Page Printer

Firmware version:

| © Menu Continued I |€> Menu Continued I
>M;4Tray Size l >Print HEX-DUMP |
>MP Tray Type >Printer Reset

Plain
>Cassette 1 T) >Resource Prot.

Plain yee l off
>Cassette 2 T) >Buzzer

Plain e l On J
>Feed Select >Auto Continue >

Cassette 2 Mode  Off

>Letter Gothic
Regular
>Pitch
10.00 cpi

>>Fuser Mode
Low

>>0uplex Path
Enable

>Stack Select >>Auto Continue
e St | Face-down tray Tiner 030sec.
|>0vem‘de MIT I >Service > |
Font > off
Internal >Tgpe Adjust > >>Print
> 1000 ustom 1 Status Page
>>Paper_Weight >>Print
= Normal Test Page 1
>Courier
ReguTar

>>Print
Test Page 2
>>Developer

>Color
Calibration

>0rientation
Portrait

>LF Action
LF only

>(R Action
CR only

>Total Print
0005754

>KIR Mode
On

>EcoPrint Mode
Off
>Tone
Normal
Low
RAI\? Mode

Paper Handling >
>MP Tray Mode
First

>011 Kit

0005695
>New Torer [C]
Ted

>New Toner [M]
Installed

>New Toner
nstalled

>New Toner [K]
nstalled

i}

>MSG Languar
F_ngl'igg e

>Form

Time Qut 030sec

>STeep Timer >
030 min.

=>S1leep Mode
On

>Reset Type >>Drum
. Adjust
>List of Fonts >>Maintenance
il
Color Mode > u
Color >>Maintenance
>m;g Gginu ation L]
S|
o . >EE%mtenance

(D]

Released:

Figure 3-3




3.3 Menu Map and Status Pages

3.3.2 Printing a Status Page

You can check the printer’s current status, including available memory space and option
settings by printing a status page.

1 Press the MENU key.

O

<
m
z
C

@ 2 Press the A or V key repeatedly until Print Status Page appears.

@ @? Print

@ Status Page
Q 3 Press the ENTER key. A question mark (?) appears.

Status Page ?

If you wish to abort printing of the status page, press the CANCEL key.

4 Press the ENTER key again. The message Processing appears and the printer
prints a status page.
ENTER
For a sample status page and its full description, see Understanding the Status Page on
page 3-17.




3.3 Menu Map and Status Pages

Understanding the Status Page

The numbers in the following diagram refer the items explained below the diagram. The items
and values on the status page may vary depending on the printer’s firmware version.

(% KYOCERA
Urita__ ECOSYSM FS—8000C Page Prmter

STATUS PAGE

Firmware version:

Releascd:

"
MP Tra A4 Plain Standard memory 65536 KB
Cassette 1 A4 Plain Option memor{
Cassette 2 A3 Plain 32768 KB
Slot 2 £ty 3
Multi tray mode Single user Total 98304 K
Sorter mode Stacker mode User available 47819 KB
Ecoprint mode OFF RAM disk OFF
Buzzer control ON Wr1te protect
Host buffer size 500 Ki 0 kB
Sleep timer 30 M1nutes User available 0 KB
FF time out 30 Seconds
n Installed Options
Sagd d1sk dmve 5
1
Copies 1 Mgrnory card
Network Status » >'_
PCL 5¢ 7
TCP/IP Protocol Status ON KC-GL
1P Address 192.168.110.171 KpoL3
Subnet Mask 255.255.255.000
Gateway 192.168.110.201
DHCP OFF
NetHare Protocol Status O Number Page Count Descrwtwn 8
NetWare Frame Auto 2 7829 Print overrun
7827 Memory overflow
EtherTalk Protocol Status ON
Printer Name KY203F83 Consumable Status
. J Toner (Cyan) Toner (Magenta)
[ ] |
0 100 0 100 9
Toner (Yellow) Toner (Black)
I
100 0 1
\ 0 00 )
e )
Interfaces
Serial Parallel
PCL 5¢ PCL 5¢
lb te code  Courier 1b code  Courier
Codeset name 1S0-6 ASCII Codeset name IS0-6 ASCII
Option1 Option2
PCL 5¢ Not used
lbyte code Courier
Codeset name 1S0-6 ASCII
\_ J

Figure 3-4




3.3 Menu Map and Status Pages

Software Version

This item shows the version and release date of the printer firmware.

Hardware Information

This item shows various printer settings for hardware-related items:

e MP tray paper size and type
* Paper cassette size and type
e Draft mode

*  Buzzer control

*  Host buffer size

*  Sleep time timeout time

*  Formfeed timeout time

Memory
This item shows:

e Standard memory in the printer (64 MB)

*  Option memory slot status (Slots 1 and 2) in megabytes
e Total memory in the printer

*  Current status of the RAM disk

Page Information
This item shows the page related items:

. Tone mode, Normal or Fine
e Number of copies, from 1 to 999
*  Total page count

Installed Options
This item shows the options installed in the printer:

*  Hard disk
e Option ROM
*  Memory card

Network Status

This item shows the IP address, subnet mask address, and default gateway address for the

network interface card in the printer.

Emulation

This item shows all available emulations of the printer. The PCL Sc emulation is set as
default when the printer is shipped from the factory. The emulations are:

« PCL5c
« KPDL3
« KC-GL




8

10

3.3 Menu Map and Status Pages

Error Log

This item shows the last three instances of the following four types of errors, listing them
in the order of occurrence:

KPDL (PostScript) errors
*  Memory overflow

e Print overrun

e File-not-found

The most recent error is displayed on the topmost line of Error Log. Error information is
cleared when the printer is powered off.

The error log information is intended for service purpose.

Consumable Status

This item shows the approximate level of remaining toner. When the value is 100, the
toner container is full. The closer to 0, the smaller the amount of remaining toner.
Interface Information

This information shows the emulation and the default font for all interfaces installed in
the printer.
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3.4 e-MPS

3.4

e-MPS

Note

e-MPS is an abbreviation for ‘enhanced-Multiple Printing System’ which implements the
following functions that are available from the printer driver:

e Job Retention
« Job Storage

In either job mode, when printing a document, the print data is transferred from the computer
to the printer then stored on the printer’s hard disk. Since copies of the document are printed
using the stored data, printing is performed faster with less computer spooling time and less
network traffic.

To use the e-MPS system, an optional hard disk must be installed in the printer. (FS-
8000CN is equipped with a hard disk as a standard feature.) For details, see Appendix A
Options.

Job Retention

Job Retention has four modes as summarized below. These modes are selected when you
choose on the printer driver through the application software:

Mode Quick Copy Proof-and-Hold Private Print Stored Job
Primary function  To later print addi- To proofthe first ~ To hold the docu-  To eletronically
tional copies copy before print- mentin printerto  store documents
ing multiple copies prevent unautho-  sych as fax cover
rized access pages
Start storing by Printer driver Printer driver Printer driver Printer driver
Retrieved by Operator panel Operator panel Operator panel Operator panel
Default number of Same as storing One less Same as storing One
copies printed at
retrieval
Maximum number 32, expandableto 32, expandableto Private jobs are No limit
of jobs stored 50 50 deleted automati-
cally once it is
retrieved.
PIN security No No Yes Yes
Hard disk Yes Yes Yes Yes
required#r
Table 3-3

T Jobs in excess will cause the earlier ones to be deleted.
T+ RAM disk does not work for e-MPS.

Job Storage

Job storage stores print jobs either temporarily or permanently, or in virtual mailboxes, as you
click an appropriate radio button on the printer driver when printing from a computer. If you
select Temporary or Permanent job storage, you can choose to have a unique number and
barcode automatically assigned to each job as it is stored in the printer. This barcode appears
on the printed document. The barcode reader can be used to reprint the document by reading
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3.4 e-MPS

the barcode from the original document or from a List of Code Jobs. For details on this list, see
Printing a List of Code Jobs on page 3-29.

Job storage requires a hard disk installed in the printer. However, printing barcoded job IDs on
documents is possible using the RAM disk feature of the printer. On how to use the RAM disk,
see Section 3.9.1 Setting up the RAM Disk on page 3-69.

Virtual Mailbox

Virtual mailbox is part of Job Storage, which stores print jobs on the hard disk without
printing. It enables you to retrieve jobs later from the operator panel, the KM-NET Printer
Disk Manager utility (in the CD-ROM), or the barcode reader.

Each mailbox may be used by an individual who desires to share the printer in this mode. By
default, each mailbox is numbered from ‘Tray 001,” “Tray 002,’ ... etc. To ‘post’ a job in one of
these mailboxes, you assign a numbered or named mailbox on the printer driver when printing.

To retrieve the stored job for printing, see Retrieving Jobs from Virtual Mailbox (VMB) on
page 3-30.

f ? The virtual mailbox can be used in PCL 5¢ emulation only.

3.41 Using Quick Copy

This mode enables you to print the requested number of copies of a job, simultaneously storing
the job on the hard disk. When additional copies are required, you can reprint the required
number of copies from the printer operator panel. To print a job as a quick copy job, see
Chapter 4 Printer Drivers and Utilities.

The default number of print jobs that can be stored on the hard disk is 32. This value can be
increased to up to 50 from the e-MPS Configuration menu. For details, see Section 3.4.7
Changing e-MPS Configuration on page 3-32. When the number of jobs reaches the limit, the
oldest job will be overwritten by the new one.

When the printer is turned off, all stored jobs will be deleted.
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3.4 e-MPS

Printing Additional Copies using Quick Copy

To print additional copies of a job stored in the printer:

1 Press the MENU key.

O

=
m
z
C

2 Press the A or V key repeatedly until e-MPS > appears.

@? e-MPS >

®

3 Press the > key.

4 Press the A or V key repeatedly until >Quick Copy appears followed by the user
name (Harold, in this example). The user name is assigned at printing using the
printer driver.

®

® ®
@@@@@@@

>Quick Copy
Harold

Q 5 Press the ENTER key. A blinking question mark (?) appears before the user name.

ENTER ?Quick Copy

z o
?Harold
'I\

6 Press the A or V key to display the desired user name, Arlen, in this example.

@ ?
@ @ >Quick Copy

?Arlen

©

7 Press the ENTER key. The job name entered in the printer driver (Report, in this
example) appear with a blinking question mark (?) before the letters.
ENTER

%Arlen
Ny

?Report
Il\

8 Press the A or V key to scroll to the desired job title.

®
@ @
®
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Press the ENTER key. The number of copies to be printed can be set. To increase the
copy count, press the A key; to decrease the copy count, press the V key.

>Report

|
Copies 061’
i

10 Press the ENTER key to finalize the copy count. The printer prints the specified
number of copies for the job.

Deleting a Quick Copy Job

All quick copy jobs are automatically deleted when the printer is turned off. If you desire to
explicitly delete a stored quick copy job, proceed as follows:

1 Follow steps 1 through 8 in the above section to let the title of the job to be deleted
displayed.

2 When the title of the job to be deleted is displayed, e.g. Report, below, press the
ENTER key. The cursor below the copy count starts to blink.

>Report

|
Copies 0017
A

3 Press the V key repeatedly until Delete appears below the title.

>Report

1
Delete i

1S

4 Press the ENTER key. The stored quick copy job is deleted.

3.4.2 Using Proof-and-Hold

MENU

When you print multiple copies, this mode first prints one copy so that you can proof it before
continuing to print the remaining copies. Since you can proof the printouts before printing the
remaining copies, wastage of paper can be reduced.

The printer prints one copy and, at the same time, saves the print job on the hard disk. You can
also change the number of copies when resuming printing from the operator panel.

When the printer is turned off, all stored jobs will be deleted.

Printing Remaining Copies of a Proof and Hold Job

Printing a Proof-and-Hold job on the operator panel is similar to printing a quick copy job. To
print remaining copies of a job held in the printer:

1 Press the MENU key.
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®
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® ®
© ®O 6 0 6

ENTER

®
@ @

©

ENTER

®
OJNCX

©

ENTER

ENTER

10

Press the A or V key repeatedly until e-MPS > appears.

e—-MPS >

Press the > key.

Press the A or V key repeatedly until >Quick Copy appears followed by the user
name (Harold, in this example). The user name is assigned at printing using the
printer driver.

>Quick Copy
Harold

Press the ENTER key. A blinking question mark (?) appears before the user name.

fguick Copy
>

?Harold

'I\

Press the A or V key to display the desired user name, Arlen, in this example.

>Quick Copy
?Arlen

Press the ENTER key. The job name entered in the printer driver (Report, in this
example) appear with a blinking question mark (?) before the letters.

fArlen
">Report
q\epor

Press the A or V key to scroll to the desired job title.

Press the ENTER key. The number of copies to be printed can be set. To increase the
copy count, press the A key; to decrease the copy count, press the V key.

>Report

001’

1S

Copies

Press the ENTER key to finalize the copy count. The printer prints the specified
number of copies for the job.
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3.4.3 Printing a Private Job
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®
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©

ENTER

In private printing, you can specify that a job is not printed until you release the job from the
operator panel. At sending the job from the application software, you should specify a 4-digit
access code in the printer driver. The job is released for printing by entering the access code on
the operator panel. Thus, this function ensures confidentiality of the print job.

When the printer is turned off, all the print jobs will be deleted.

Releasing a Private Job

1 Press the MENU key.

2 Press the A or V key repeatedly until e-MPS > appears.

e-MPS >

3 Press the D> key.

4 Press the A or V key repeatedly until >Private/Stored appears. The name
entered in the printer driver (Harold, in this example) also appears.

>Private/Stored
Harold

5 Press the ENTER key. A blinking question mark (?) appears before the user name.

?Private/Stored

2
‘?Harold
'I\

6 Press the A or V key to display the desired user name (Arlen, in this example).

>Private/Stored
?Arlen

7 Press the ENTER key. The user name and the job name (Agenda, in this example)
entered in the printer driver appear with a blinking question mark (?).

?érlen
?Agenda
1S

>
4
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ENTER

8 Press the A or V key to display the desired job title.

9 Press the ENTER key. The ID input line appears. Enter the four-digit access code
entered in the printer driver and press the ENTER key. To enter the ID, press the <[ or
D> key to move the cursor to the number to be changed and then enter the correct
number by pressing the A or V key.

>Agenda I
ID 0000”
m

10 You can set the number of copies to be printed. To increase the copy count, press the A
key; to decrease the copy count, press the V key.

>Agenda
. s,
Copies 001
™

1 1 Press the ENTER key to finalize the copy count. The printer prints the specified
number of copies for the job.

Deleting a Private Job

1 Follow steps 1 through 8 in the above section.

2 When the title of the job to be printed is displayed (Agenda, in this example), press the
ENTER key. Enter the four-digit access code entered in the printer driver and press the

ENTER key.
>Agenda
, N 4
Copies 001
T

3 Press the V key repeatedly until Delete appears for the number of copies.

>Agenda

1
Delete A

7

4 Press the ENTER key. The private job is deleted from the hard disk.
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3.4.4 Storing a Print Job

You can download a job to the hard disk without printing it. This allows you to store print jobs
that are frequently needed such as fax cover pages, check lists, and order forms, for printing at
any later time using the operator panel.

When the printer is turned off, all the print jobs will be deleted.

Releasing a Stored Job

To print a stored job through the operator panel:

1 Press the MENU key.

O

<
m
=z
c

Press the A or V key repeatedly until e-MPS > appears.

@? e—-MPS >

®
N

®

3 Press the D> key.

® ©

®
©

4 Press the A or V key repeatedly until >Private/Stored appears. The name
entered for User Name in the printer driver (Harold, in this example) also appears.

® @

@?

®

>Private/Stored
Harold

5 Press the ENTER key. A blinking question mark (?) before a user name appears.

O O

?Erivate/Stored
>

?Harold
'I\

6 Press the A or V key to display the desired user name (Arlen, in this example).

®
@ @? >Private/Stored
®

?Arlen

7 Press the ENTER key. The user name and the job name entered in the printer driver
(Agenda, in this example) appear with a blinking question mark (?) before the letter.
ENTER

?Arlen
5% enda
ri\g

3-27



3.4 e-MPS

®

® @

O ©

m
zZ
5
m
o)

®

@ @

O 9

ENTER

®
® @
©

ENTER

8 Press the A or V key to display the desired job title.

9 Press the ENTER key. If you entered an access code for the printer driver, the ID input
line appears. Enter the four-digit access code entered in the printer driver and press the
ENTER key. To enter the ID, press the < or [> key to move the cursor to the number to
be changed and then enter the correct number by pressing the A or V key.

10 You can specify the number of copies to print. To increase the copy count, press the A
key; to decrease the V key.

>Agenda
1,
Copies 081
i

11 Press the ENTER key to finalize the copy count. The printer prints the specified
number of copies for the job.

>Agenda I
?Copies Og;:
1

Deleting a Stored Job

1 Follow steps 1 through 8 in the above section.

2 When the title of the job to be printed is displayed (Agenda, in this example), press the
ENTER key. If you entered an access code for the printer driver, enter the four-digit
access code and press the ENTER key.

>Agenda
. s
Copies 001
R

3 Press the V key repeatedly until Delete appears for the number of copies.

>Agenda

1
Delete N

n

4 Press the ENTER key. The stored job is deleted from the hard disk.
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3.4.5 Printing a List of Code Jobs

If you select Permanent Job Storage on the printer driver, you can have a List of Code Job
printed using the operator panel. The List of Code Job may be used to read the barcode
assigned for the stored job you want to reprint by using a barcode scanner. See Appendix A
Options.

A sample Code Job List is shown in Figure 3-5 on page 3-30.

1 Press the MENU key.

2 Press the A or V key repeatedly until e-MPS > appears.

®© 0

®
®

e—-MPS >

3 Press the D> key.

®
®@® ® @
©

4 Press the A or V key repeatedly until >List of Code JOB appears.

?
@ >List of

Code JOB

®

Press the ENTER key. A question mark (?) appears.

O ©
G

>List of
Code JOB 7

6 Press the ENTER key again. The printer prints a Code Job list as shown in Figure 3-5
below.
ENTER
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0} KYOCERA o \
Jmita__ ECosrsm FS-8000C Page Printer

o

B i

Permanent Job storage size: E(S)z(ajl 58 :g Job delete start:
b e 50 [T
Job output Job name User name Date Job Delete
1 R O R
14:26 12/27/2000
II%I(!{I}I%;EISI(I)I)III \302\213\253\21 10 K1 O

\/\

Figure 3-5

3.4.6 Retrieving Jobs from Virtual Mailbox (VMB)

MENU

@ @

®@ O

® @

© ®e 6 o 6

To retrieve the jobs posted in the virtual mailbox, proceed as follows.

Press the MENU key.

Press the A or V key repeatedly until e-MPS > appears.

e-MPS >

Press the > key.

Press the A or V key repeatedly until >Print VMB Data appears. The virtual
mailbox number will also appear.

>Print VMB Data
Tray001:

If you have named the virtual mailbox with an alias on the printer driver, the alias
(Richard, in this example) will follow the number:

>Print VMB Data
Tray00l:Richard
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5 Press the ENTER key. A blinking question mark (?) appears.

>Print YMB Data
\ls
Tray001?
71>

6 Press the ENTER key. The document in the mailbox is printed and automatically
deleted from the mailbox.

Printing a List of VMB

A Virtual Mailbox list includes the jobs currently stored in the mailboxes.

1 Press the MENU key.

2 Press the A or V key repeatedly until e-MPS > appears.

e-MPS >

3 Press the D> key.

4 Press the A or V key repeatedly until >List of VMB appears.

>List of VMB

5 Press the ENTER key. A question mark (?) appears.

>List of VMB ?

6 Press the ENTER key again. The printer prints a list of jobs currently posted in the
virtual mailboxes as shown in Figure 3-6 below.
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VMB Job storage size: total 500 MB OQutput (1) or Delete (1)
used 3MB
available 497 MB TR e T {1 T
Bin No. Alias Jobs Pages Normal/Shared Size(KB) L GO 2)
@ 1 2 14 2836 / 0 TR Q1R
@ 2 1 5 951 / 0 LTI
Figure 3-6

3.4.7 Changing e-MPS Configuration

You can change the following parameters for e-MPS operation:

e Maximum number of Quick Copy/Proof-and-Hold jobs
*  Maximum space assigned to temporary code jobs

*  Maximum space assigned to permanent code jobs

*  Maximum space assigned to virtual mailboxes

The total amount of storage areas specified must not exceed the total size of the hard
disk. Otherwise, you may only be able to accommodate print jobs of a smaller amount of
Note print jobs than specified.

Changing the Maximum Number of Quick Copy/Proof-and-Hold Jobs

This changes maximum number of Quick Copy/Proof-and-Hold jobs from 0 to 50. The default
is 32.

Q 1 Press the MENU key.

2 Press the A or V' key repeatedly until e-MPS > appears.

@? e-MPS >

@

3 Press the > key.

@ ©

@ ® © 6

3-32



®

®

®

®

®
@
©

®

@?

® ©

@?

® @

@"?

O ©

‘0O © 6
mO@

O

<
m
z
C

3.4 e-MPS

4 Press the A or V key repeatedly until >e-MPS Configuration > appears.

>e—-MPS >
Configuration

5 Press the D> key.

6 Press the A or V key repeatedly until >>Quick Copy appears.

>>Quick Copy
32

7 Press the ENTER key. A blinking cursor (_) appears.

>>Quick Copy '
327
mn

8 Press the A or V key to increase or decrease the value at the blinking cursor. The value
can be set between 0 and 50. Use the [> and < keys to move the cursor right and left.

9 When the desired maximum number of jobs is set, press the ENTER key.

10 Press the MENU key. The display returns to Ready.

Maximum Space Assigned to Temporary Code Jobs

This changes the hard disk space that holds temporary code jobs. You can change the
maximum space from 0 to 9999 (megabytes). The actual maximum size depends on the size of
free hard disk space, however. The default size is 1/6 of the total hard disk space, rounded off
in unit of 50 MB. For example, if the total hard disk space is 3.2 GB, the default size is 500
MB.

1 Press the MENU key.

2 Press the A or V key repeatedly until e-MPS > appears.

e—-MPS >
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10

Press the > key.

Press the A or V key repeatedly until >e-MPS Configuration > appears.

>e—-MPS >
Configuration

Press the > key.

Press the A or V key repeatedly until >>Temp. Code JOB Size appears.

>>Temp. Code JOB
Size 050MB

To change the maximum disk space, press the ENTER key. A blinking cursor (_)
appears.

>>Temp. Code JOB

1
Size 050MB
N

Press the A or V key to increase or decrease, respectively, the value at the blinking
cursor. Use the [> and < keys to move the cursor right and left.

When the desired size is displayed, press the ENTER key.

Press the MENU key. The display returns to Ready.
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3.4 e-MPS

Maximum Space Assigned to Permanent Code Jobs

This changes the hard disk space that holds permanent code jobs. You can change the
maximum space from 0 to 9999 (megabytes). The actual maximum size depends on the size of
free hard disk space, however. The default size is 1/6 of the total hard disk space, rounded off
in unit of 50 MB. For example, if the total hard disk space is 3.2 GB, the default size is 500
MB.

1 Press the MENU key.

2 Press the A or V key and select e-MPS >,

e-MPS >

3 Press the D> key.

4 Press the A or V key and select >e-MPS Configuration >.

>e—-MPS >
Configuration

5 Press the D> key.

6 Press the A or V key and select >>Perm. Code JOB Size.

>>Perm. Code JOB
Size 050MB

7 Press the ENTER key, the message display shows a blinking cursor (_).

>>Perm. Cod\eI ,JOB
Size 050MB
™

8 Press the A or V key to increase or decrease, respectively, the value at the blinking
cursor. Use the [>and <] keys to move the cursor right and left.
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9 When the desired size is displayed, press the ENTER key.

ENTER
Q 10 Press the MENU key and the message display returns to Ready.
MENU

Maximum Space Assigned to Virtual Mailboxes (VMB)

This changes the hard disk space for virtual mailboxes. You can change the maximum space
from 0 to 9999 (megabytes). The actual maximum size depends on the size of free hard disk
space, however. The default size is 1/6 of the total hard disk space, rounded off in unit of 50
MB. For example, if the total hard disk space is 3.2 GB, the default size is 500 MB.

1 Press the MENU key
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2 Press the A or V key and select e-MPS >,

@? e—-MPS >

®

®

Press the > key.

® ©
W

@’?

®

4 Press the A or V key and select >e-MPS Configuration >.

?
>e-MPS >

Configuration

® @

®

5 Press the > key.

® ©

@?

®

6 Press the A or V key and select >>VMB Size.

@? >>VMB Size

® @

®

050MB

7 To change the maximum size, press the ENTER key. The message display shows a
blinking cursor ().

O ©

m
P4
5
m
By)

>>VMB Size

1,
50MB
™

NOr
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Press the A or V key to increase or decrease, respectively, the value at the blinking
cursor. Use the [> and < keys to move the cursor right and left.

When the desired size is displayed, press the ENTER key.

Press the MENU key to exit the menu selection.
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3.5 Changing the Interface Parameters

Communication parameters for the printer interfaces can be adjusted as explained below.

The FS-8000CN has an network interface card installed at the factory. For information on how
to remotely change parameters for the network interface card, refer to the documentation
supplied with the printer.

3.5.1 Changing Parallel Interface Mode

The parallel interface supports a bi-directional/high-speed mode according to IEEE standards.
You can select from the following:

*  Auto (default)

*  Nibble/high speed
e Normal

*  High speed

In order for the change to take place, you must turn printer power once off then on.

Q 1 Press the MENU key.

MENU
@ 2 Press the A or V key repeatedly until Interface > appears.
@ @
3 If the interface is other than parallel, press the ENTER key. A blinking question mark
(?) appears.
ENTER
}nterface
o ,
? Serial
1S
@ 4 Press the A or V key repeatedly until Parallel appears.

@ @? Interface

? Parallel

O 5 Press the ENTER key again. The question mark disappears.

@ ? 6 To change the parallel interface mode, press the [> key. The current communication
mode appears.
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7 To change the communication mode, press the ENTER key. A blinking question mark

(?) appears.
ENTER
>Parallel I/F
Mo
? Auto
'l N
@ 8 Press the A or V key to scroll through the following communication modes:

®@ ®
Nibble (high)
@ Normal

High Speed
Q 9 When the desired communication mode is displayed, press the ENTER key.
ENTER
10 Press the MENU key to exit the menu selection.
MENU

3.5.2 Changing Serial Interface Parameters
You can confirm or change the serial interface parameters including baud rate, data bits, stop

bits, parity, and protocol. These parameters must match those of the computer’s serial
interface.

1 Press the MENU key.

O

<
m
z
c

Press the A or V key repeatedly until Interface > appears.

®
N

®@ @

3 If the interface is other than serial, press the ENTER key. A blinking question mark (?)
appears.

06

m
zZ
3
m
ny)

}nterface

Mo
? Parallel
'I\

4 Press the A or V key repeatedly until Serial appears.

®
@ @? Interface
©

? Serial

5 Press the ENTER key again.

ENTER
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®
Q)
®

@?

6 Press the [> key. One of the following serial parameters is indicated (Baud rate for
example).

Pressing the A or V key toggles through the serial parameters as follows. To change
the serial parameter, press the ENTER key. Use the A or V key to change the value or

selection.
Range
1200, 2400, 4800, 9600 (Default), 19200, 38400, 57600,
>Baud rate
115200
9600

v 4

>Data bits
8

7 or 8 (Default)

v 4

>Stop bits

1 (Default) or 2

1
. None (Default), Odd, Even, or Ignore
>Parity
None
SProtocol DTR (pos.) & Xon (Default), DTR (positive), DTR (neg-

ative), Xon/Xoff, ETX/ACK
DTR (pos.) &XON

v 4

>Barcode Mode
Off

Off (Default) or On f

+  Barcode mode is used when the option barcode reader is connected to the printer to support
reading document IDs (barcodes). Note that Barcode Mode appears in the menu only when
a hard disk option is installed.

For example, to change baud rate from 9600 to 115200, display the baud rate menu following
the above procedure. When the display shows baud rate, 9600 (bps), press the ENTER key. A
blinking question mark (?) appears.

>Baud Rate
1,

? 9600
1S
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Press the A or V key to scroll through values. When 115200 is displayed, press the ENTER
key. Press the MODE key to exit the menu selection.

Some computers may not be able to handle a baud rate of 115200 bps. If you set the
baud rate to 115200 and encounter communication problems, select a lower baud rate.

3.5.3 Changing Network Interface Parameters
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This section applies to the FS-8000C series printers having the network interface card
installed. The FS-8000CN comes equipped with a network interface card as a standard
accessory. For details concerning network issues when using the FS-8000CN, refer to the
supplied manual for the network interface card.

Using the operator panel, you can:

*  Activate or deactivate TCP/IP, NetWare, and AppleTalk

*  Activate or deactivate DHCP

*  Enter IP address, subnet mask address, and default gateway address

*  Determine whether to print a network status page when the printer is turned on

To confirm or change network card parameters, proceed as follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Interface > appears.

3 If the current interface is other than option, press the ENTER key. A blinking question
mark (?) appears.

}nterface >

’
‘? Parallel
?I\

4 Press the A or V key repeatedly until Option appears.

%nterface >
o

5 .
'i\Optlon 1

5 Press the ENTER key again.

6 Press the > key. One of the following menus is indicated. To change settings for the
item, press the ENTER key. Use the A or V key to change the value or selection.
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Range
SNetW S Set this item to On when you connect to a network
etWare using NetWare. In submenu (>), frame mode can be
On selected from Auto, Ethernet, 802.2,and
* * 802.3.
STCP/IP S Set this item to On when you connect to a network
using TCP/IP. Submenu (>) has items including
On DHCEP, IP address, subnet mask address, and gate-
way address. To resolve IP address for the network
* * card, see 3.5.4 Resolving IP Address below.
EtherTalk must be activated (On) for networking
>EtherTalk with Macintosh computers.
Off
>0 Statusp When the item is set to On, the printer prints out a net-
pt. StatusPage work status page when it prints the printer status.
On

7 Activate the appropriate protocol that is required to connect the printer to the network.
To activate a protocol, let the protocol displayed, press the ENTER key, press the A or
V key to change from Of £ to On, and press the ENTER key.

8 Press the MENU key. The display returns to Ready. You can print a network status
page to confirm that the IP address, subnet mask address, and the gateway address have
been properly set. To print a network status page, see Printing a Network Interface
Card Status Page on page 3-44 which follows.
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3.5.4 Resolving IP Address

To connect the printer to the network using TCP/IP protocol, you must set the IP address on
the printer. The IP address must be unique to the printer and should be obtained from your
network administrator.

1 Activate TCP/IP protocol in the manner described above.

>TCP/IP >
On

2 Enter the submenu by pressing the [> key. Each time you press the A or V key, the
selection changes as shown below.

®

>>DHCP
Off

@ ©
®

v 4

>>TP Address
000.000.000.000

v 4

>>Subnet Mask
000.000.000.000

v 4

>>Gateway
000.000.000.000

3 When >>IP Address is displayed, press the ENTER key. A bliking cursor ()
appears at the last digit.
ENTER

>>TIP Address I
000.000.000.0007
/T\

4 Press the A or V key to increase or decrease, respectively, the value at the blinking
cursor. Use the [> and <] keys to move the cursor right and left.

@ ®
Q 5 When the IP address is entered, press the ENTER key.

ENTER

6 Press the A or V key to move to Subnet Mask. Perform the same procedure to
complete entering the subnet mask address.
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Then, press the A or V key to move to Gateway. Perform the same procedure to
complete entering the subnet mask address.

Press the MENU key. The display returns to Ready. You can print a network status
page to confirm that the IP address, subnet mask address, and the gateway address have
been properly set. To print a network status page, see Printing a Network Interface
Card Status Page which follows.

Printing a Network Interface Card Status Page

You can have your printer print out a network status page when the printer prints the status
page. The network status page shows the network addresses, and other information under
various network protocols about the network interface card. The default setting is On (print).

A sample network status page is shown on Figure 3-7 on page 3-46.

1

Press the MENU key.

Press the ENTER key repeatedly until Interface > appears.

Interface >
Parallel

If the interface is other than Option, press the ENTER key. A blinking question mark
(?) appears.

}nterface

S04
? Parallel
'I\

Press the A or V key repeatedly until Option appears. Press the ENTER key.

;nterface
Ny

".;\Option 1

Press the > key and then press the A or V key repeatedly until the display shows
>0Opt. StatusPage.

>Opt. StatusPage
On
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6 The default setting is On. If it is set to Of £, press the ENTER key. A blinking question
mark (?) appears.

ENTER
?Opt. StatusPage
2 0ff
'I\
@ 7 Press the A or V key to select On.
?
@ >Opt. StatusPage

? On

Q 8  Pross the ENTER key again.

ENTER

9 Press the MENU key. The display returns to Ready. The printer prints a network status
Q page as an example shown in Figure 3-7 below.
MENU
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1B-20/21
00:C0:EE:10:0F:00

Mode
Firmware Version:
Ethernet Address:

Default KY100F00
2/10/100 Cunnectmn Not Detected
Admin Password: Not Defined

i e

192 168.101.245
Subnet Mask : 255.255.255.0
Default Gateway: 192.168.101.205
Host Name: KY100F00
Port Number: 9100
DHCP/BOOTP: Disabled
DHCP Lease:
RARP: Disabled
WINS Server (Pri.): 0.0.0.0
WINS Server (Sec.): 0.0.0.0
coge 1D: )
WINS Status: Not Registered
FTP/LPD Banner: Disabled

Read Community: public
Write Community: public
sysContact-

Name
sys ocat )
Authentlcatwn Traps: Disabled

TRAP Recipient 1 Conf'lguration
Trap Community:
Trap IP Address:

0 0 0
Trap IPX Address: 00000000 000000000000

DOLow Paper DAdd Paper
OLow Toner DAdd Toner
OCover Open OPaper Jam

OAn Uthgr Errors

TRAP Recipient 2 Conf1gurat1on
Trap Community:
Trap IP Address:

0 0 0
Trap IPX Address: 00000000.000000000000

OLow Paper DAdd Paper
DLow Toner DAdd Toner
DOCover Open OpPaper Jam
DA Other Errors

FS-8000C

Page lof2

Workgroup:
Comment : P

Pr1nter Name : Not' Detecte
Preferred Zone: Not Detected
Device Type: Not Detected

SMTP Server Name:
Sender Address:
SMTP Port Number:

DNS Server (Pri.):
DNS Server (Sec.):

Signature:

Recipient 1 Conﬁ gur‘at'lon
Recipient 1 A

Chec Prmter Every

Ollow Paper OAdd Paper
OLow Toner DAdd Toner
OCover Ope OPaper Jam

DAT1 Othgr Errors
Recipient 2 Conﬁ guratmn

Reci 1ent 2 A

Checl r‘mter Ever‘y

OLow Paper OAdd Paper
OLow Toner DAdd Toner
OCover Open OPaper Jam

p
OA11 Other Errors

Start of Job Strmg
End of Job String:

SJIS/EUC Sett1 ngs for Japanese Users
Start of Job S

End of Job Str1_ng. \f
Printer Emulation: ASCIT
Tab Size(char.): 8
Page Width(char.): 0
Page Length(1ine): 0

Figure 3-7
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3.6 Making Default Settings

Using the operator panel, you can set the default for the following items. Note default settings
made using the operator panel may be overridden by the printer driver settings and application
software.

3.6.1 Default Emulation

You can change the emulation mode and character code set for the current interface. The
printer is capable of the following emulation modes:

* HP PCL 5c¢ (HP Color LaserJet 8550)
* KC-GL (HPGL 7550A)
* KPDL3 (PostScript 3 Version 3011)

The printer can automatically switch between HP PCL 5c¢ and KPDL3 depending on the print
job that is received from the computer. To do this, select KPDL (AUTO) in the following
procedure.

1 Press the MENU key.

2 Press the A or V key repeatedly until Emulation > appears on the message display.
One of the emulation modes appears, indicating the emulation currently in use.

PCL 5c (default)
KC-GL

KPDL

KPDL (AUTO)

3 To change the default emulation, press the ENTER key. A blinking question mark (?)
appears.

mulation

26cL 5c
'I\

4 Press the A or V key repeatedly until the desired emulation mode is displayed.
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ENTER

ENTER

MENU

5 If you have selected PCL 5c as the default emulation, you can change the character
code set. (Default is IBM PC-8.) Otherwise, press the ENTER key and go to step 6.

To change the character code set of the PCL 5¢ emulation mode, press the > key. The
>Code set submenu is displayed.

>Code Set
IBM PC-8

6 Press the ENTER key. Press the A or V key repeatedly until the desired character
code set appears. Press the ENTER key again to finalize setting.

7 Press the MENU key. The display returns to Ready.

3.6.2 KC-GL Pen Width and Color

The KC-GL emulation mode enables you to set the pen widths in dots, individual pen colors
for pen numbers 1 to 8, and the KC-GL page size.

1 Press the MENU key.

2 Press the A or V key repeatedly until Emulation appears on the message display.

3 If the current emulation is other than KC-GL, press the ENTER key. A blinking
question mark (?) appears.

4 Press the A or V key repeatedly until KC-GL appears.

5 Press the ENTER key.

Emulation >
KC-GL

6 Press the > key to move to the >KC-GL Pen Adjust> submenu.
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3.6 Making Default Settings

To change the pen width and/or pen color, press the ENTER key. A blinking question
mark (?) appears.

>KC—GL\|];en >
Adjust ? Pen (1)
/|\

Press the A or V key repeatedly until the desired pen number of 1 to 8 appears.

When the desired pen number is displayed, press the ENTER key.

To change the pen width, press the [> key, then press the ENTER key. A blinking
cursor appears at the width value.

>>Pen (1) Width

“0%dot (s)
/|V

Press the A or V key repeatedly until the desired pen width in dots (00 to 99) appears.
When the desired pen width is displayed, press the ENTER key.

To set the pen color, press the A or V key. To change the pen color, press the ENTER
key. A blinking question mark (?) appears.

?3Pen(1) Color
3

? Black

'I\

Press the A or V key repeatedly until the desired pen color (Black, Red, Green,
Yellow, Blue, Magenta, Cyan, White) appears. When the desired pen color is
displayed, press the ENTER key.

To set the KC-GL page size, press the <[ key twice, then Press the A or V key until
>KC-GL Page Set is displayed.

To change the page size, press the ENTER key. A blinking question mark (?) appears.

??C—GL Page Set
27 [a2]
'I\

Press the A or V key repeatedly until the desired page size (A2, A1, A0, B3, B2, B1,
B0, and SPSZ) appears. The SPSZ command sets the paper edge limits to the
dimensions of a standard paper size. See this command explained in the Programming
Manual in the CD-ROM. Press the ENTER key to set the page set you just selected.

Press the MENU key. The display returns to Ready.
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3.6.3 Alternative Emulation for KPDL Emulation

The auto KPDL (KPDL (AUTO) ) emulation enables the printer to automatically change the
emulation mode according to the print job received. The emulation mode the printer switches
alternatively can be selected using the operator panel. The default alternative emulation is HP
PCL 5c.

1 Press the MENU key.

O

<
m
z
c

Press the A or V key repeatedly until Emulation > appears.

@ @? Emulation >

PCL 5c

®
N

3 Press the ENTER key. A blinking question mark (?) appears.

O ©

ENTER @r,nulation
S
?PCL b5c
4R
@ 4 Press the A or V key repeatedly until KPDL (AUTO) appears.

@ @? Emulation

?KPDL (AUTO)

O 5 Press the ENTER key.

@ 6 Press the [> key. Press the A or V key until >A1t. Emulation is displayed. The
alternative emulation currently selected also appears — PCL 5c or KC-GL.

7 To change the alternative emulation, press the ENTER key. A blinking question mark
(?) appears.
ENTER
?Alt. Emulation
Mo
?PCL 5c
P18

8 Press the A or V key until the desired alternative emulation appears.

9 Press the ENTER key.

ENTER
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3.6 Making Default Settings

10 Press the MENU key. The message display returns to Ready.
MENU

3.6.4 Printing KPDL Errors

The printer can print error descriptions when printing error occurs during KPDL emulation.
The default is Of £ — the printer does not print KPDL errors.

1 Press the MENU key.

MEN

C

2 Press the A or V key repeatedly until Emulation > appears.

®
@ @? Emulation >
O

PCL 5c

O 3 Press the ENTER key. A blinking question mark (?) appears.

ENTER qulation >
e

2PCL 5c
'I\

4 Select KPDL or KPDL (AUTO) using the A or V key.

®

mulation

*>&pDL
'I\

®
®

Press the ENTER key.

O O

m
pz4
5
m
us)

6 Press the > key. Press the A or V key until >Print KPDL Errs (errors) appears.

®

>Print KPDL Errs
Off

®
9

Press the ENTER key. A blinking question mark (?) appears.

O @

m
Pz
5
m
uy)

Select On using the A or V key.

®
®

>Print KPDL Errs
? On

®
9

Press the ENTER key.

0 9
©
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3.6 Making Default Settings

Q 10 Press the MENU key. The display returns to Ready.
MENU

3.6.5 Default Font

You can select the default font for the current interface. The default font can be one of the
internal fonts or a font that is downloaded to the printer memory or stored on memory card or
hard disk.

In this menu, you can also set the type and pitch for Courier and Letter Gothic; as well as to
print a font list.

1 Press the MENU key.

O

2 Press the A or V key repeatedly until Font > appears.

@? Font >

@

3 Press the [> key. Press the A or V key until >Font Select > appears.

@? >Font Select >

Internal

@

4 To select an internal font, make sure that Internal is displayed and press the > key.
The display changes as shown below. If Internal is not displayed, Press the ENTER
@ ? key, then press the A or V key until it appears.

@

@ ® @ ® @ 6

>> 1000

To select an optional font, press the ENTER key while >Font Select >is
displayed. Press the A or V key repeatedly until Option appears and then press the
ENTER key. Press the [> key next to display the font selection shown above. You can
perform this operation only when optional fonts are installed in the printer.

The letter before the number indicates the location of the font, as shown below:

Internal font

Soft (downloaded) font

Fonts in optional memory card

Fonts in RAM disk or optional hard disk
Fonts in optional ROM (API)

O m R »n H

5 Press the ENTER key. A blinking question mark (?) appears.

]
ENTER >>27000
/|\
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Selecting Regular or Dark Courier/Letter Gothic

3.6 Making Default Settings

Press the A or V key repeatedly until the desired font number appears. For font
numbers of the internal fonts, see Printing Lists of Fonts on page 3-56.

When the desired font is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.

Courier or Letter Gothic font thickness can be selected as Regular or Dark. In the procedure
below, it is assumed that Courier is selected. The procedure is the same for Letter Gothic.

1

Press the MENU key.

Press the A or V key repeatedly until Font > appears.

Font

>

Press the > key. Press the A or V key until >Font Select > appears.

Internal

>Font Select

>

Make sure that Internal is displayed and press the > key.

Press the A or V key repeatedly until >>Courier appears.

>>Courier
Regular

Press the ENTER key. A blinking question mark (?) appears.

>>Courier
Mo
? Regular
'I\

Select Regular or Dark using the A or V key.
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3.6 Making Default Settings

8 Press the ENTER key.

9 Press the MENU key. The display returns to Ready.
MENU

Changing the Default Font Size

You can change the size of the default font. If you selected a proportional font, the character
size can also be changed.

1 Press the MENU key.

O

<
m
=z
[

Press the A or V key repeatedly until Font > appears.

@? Font >

®
N

®

® ©

3 Press the [> key. Press the A or V key until >Font Select > appears.

@? >Font Select >

Internal

®

Make sure that >Font Select > is displayed and press the > key.

® @
Y

@?

®

5 Press the A or V key repeatedly until >>Size appears.

@? >>Size

012.00 point (s)

® @

®

Press the ENTER key. A blinking cursor (_) appears.

O ©

ENTER >>Size '
012. 60'point (s)
A
7 Press the A or V key to increase or decrease the value at the blinking cursor. The font
size can be set between 4 and 999.75 points, in 0.25-point increments. Use the [> or <
@ @ ? key to move the cursor right and left.

©
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3.6 Making Default Settings

8 When the desired size is displayed, press the ENTER key.

9 Press the MENU key. The display returns to Ready.

Character Pitch for Courier/Letter Gothic

You can set the character pitch for fixed fonts when the default font is Courier or Letter
Gothic.

1 Press MENU key.

2 Press the A or V key repeatedly until Font > appears.

Font >

3 Press the > key. Press the A or V key until >Font Select > appears.

>Font Select >
Internal

4 Make sure that Internal is displayed and press the > key.

5 Press the A or V key repeatedly until >>Pitch appears.

>>Pitch
10.00 cpi

6 Press the ENTER key. A blinking cursor (_) appears.

>>Pitch
10.00" cpi
m

7 Press the A or V key to increase or decrease the value at the blinking cursor. The
character pitch can be set between 0.44 and 99.99 characters per inch, in 0.01 character-
per-inch increments. Use the I> or <] key to move the cursor right and left.

8 When the desired size is displayed, press the ENTER key.

3-55



3.6 Making Default Settings

9 Press the MENU key. The display returns to Ready.

MENU

Printing Lists of Fonts

To help you decide in selecting a font, you can printout lists of the internal fonts or the optional
fonts including downloaded fonts. Samples for font lists are shown in Figure 3-8 on page 3-
57.

1 Press the MENU key.

O

<
m
z
C

2 Press the A or V key repeatedly until Font > appears.

@? Font >

®
®

® ©

3 Press the > key.

®
©

4 Press the A or V key repeatedly until >L.ist of Internal Fontsor>List
of Option Fonts appears.

® @

@?

®

>List of
Internal Fonts

Press the ENTER key. A question mark (?) appears.

O ©
G

>List of
Internal Fonts?

6 Press the ENTER key again. Processing appears, then Ready. The printer prints
out a list of fonts with a sample and font ID (number) for each of them. Sample lists of
ENTER fonts are shown in Figure 3-8 on the next page.
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Internal d Bitmapped FontsList | | PRESCRIBE |
| Font Name I l I Bif ! / | P I { Selection  [FSET] Font ID I
Courier <Scalable> None FSET 0p##h080b4099T; 1000 Es=T
CGTimes . | <Scalables \,t None  PSET 1pk#vosobdioiT; 1001 :I
CGTimes-Bd <Scalable> None FSET 1p##v0s3b4a101T; 1002 [—
CGTimes-It . ! . \‘<Bc\01ub;lt§;>vk:: . Nome FSBT 1p#Avisobaiont; 1003 j
CGTimes-Bdlt <Scalable> None FSET 1p##v1e3b4101T; 1004 H
ccomeen . | <scalables  None  FSET iph#vos0b41lsT 1005 H
CGOmega-Bd <Scalable> None FSET 1p##v0s3ba113T; | 1006 il
CCOmegalt . = . t<sé$1inh’&n  None  BSET ipb#visobainsr; 1007 L]
CGOmega-Bdit <Scalable> None FSET 1p##v1s3b4113T; 1008 1
Cornet - . ol . None. PSET 1p##vis0ba116T; 1009 1
Clarendon-Cd <Scalables> None FSET 1p##v4s3b4a140T; 1010 1
Univesmd e | Nome  FSET 1ph#v0a0b4l4sT; o011 &
Univers-Bd <Scalable> None FSET 1p##v083b4148T; 1012 n
UniversMdit ' | <scalables None FSET 1p##v1s0be148T; 1013 n
Univers-Bdit <Scalable> None FSET 1p##v1s3b4148T; 1014 n
 Univers:MdCd <Scalable>  None FSET Ipives0b41esT; To1s B
Univers-BdCd <Scalable> None FSET 1p##v4s3b4148T; 1016 b
Univers MdCalt = Jealanies None FSET 1ph#vss0ba148T; 1017 T
Univers-BdCdlt <Scalable> None FSET 1p##v5s3b4148T; 1018 1
Antiqueolive  <Scalables  Nonme PSET 1pk#v0s0bd168T; 1019 1
AntiqueOlive-Bd <Scalable> None FSET 1p##v083b4168T; 1020 1
An;lqueqn\(e-lt _ <Scalables None PSBT 1p#ivisobalest; 1021 1
GaramondAntiqua <Scalable> None PSET 1p##v080b4197T; 1022 A
Garamond-Hlb . V . -~ Gdaan . None FSET 1p#i#v0s3b4197T; 1023 S
Garamond-Krsv <Scalable> None PSET 1p##v1s0b4197T; 1024 T
Garamond-HIbKrsv <Scalables . PSET 1pbviedbarsrr; 1025 T
Margold <Scalable> None FSET 1p##v0s0b4297T; 1026 T
AlbertusMd ; e None  peer 1pk#v0s1b4362T; 1027 1
Albertus-ExtBd <Scalable> None FSET 1p##v0s4ba362T; 1028 1
Avrial . - <scalables  Nome FSET 1p##v080b16602T; 1029 e
Arial-Bd <Scalable> None FSET 1p##v083b16602T; 1030 A
Arial-tt . \ <Scalables None PSET 1p##visobisoaT; 1031 $
Arial-Bdit <Scalable> None PSET 1p##v1s3b16602T; 1032 e
TimesNewRoman = ’ <Scalable> _ Nonme FSBT 1p##v0s0b16901T; 1033 2
TimesNewRoman-Bd <Scalable> None FSET 1p##v083b16901T; 1034 2
 TimesNewRoman-It 3 <Scalable» None FSET 1p##v1s0bl6901T; 1035 2
TimesNewRoman-Bdlt <Scalable> None FSET 1p##v1s3b16901T; 1036 J
Helvetica :  <Scalable> None  FSET 1piiv0s0b24ssoT; 1037 e
Helvetica-Bd <Scalable> None FSET 1p##v083b24580T; 1038 A
Helvetica-Ob | <scalables Hone PSET 1pkévis0b24580T; 1039 B
Helvetica-BdOb <Scalables> None FSET 1p##v1s3b24580T; 1040 b
5
2
T

Figure 3-8
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3.7 Pagination

In Page Set menus, you can set the number of copies, page orientation, and other settings
regarding pagination.

3.7.1  Number of Copies
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® ®
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®

O ©

®
®
®

O 9

O

<
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You can set the number of copies of each page to be printed for the current interface. The
number of copies can be set between 1 and 999.

1 Press the MENU key.

2 Press the A or V key repeatedly until Page Set > appears.

Page Set >

3 Press the > key.

4 Press the A or V key repeatedly until >Copies appears.

>Copies
001

5 Press the ENTER key. A blinking cursor (_) appears.

>Copies

6 Press the A or V key to increase or decrease, respectively, the value at the blinking
cursor. Use the [> and <] keys to move the cursor right and left.

7 When the desired size is displayed, press the ENTER key.

8 Press the MENU key. The display returns to Ready.
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3.7.2 Print Orientation

You can select portrait (upright) or landscape (sideways) page orientation.

Portrait Orientation Landscape Orientation
A A
I I

1 Press the MENU key.

O

=
m
z
c

2 Press the A or V key repeatedly until Page Set > appears.

@7 Page Set >

®

®

Press the D> key.

®
® O
9
W

4 Press the A or V key repeatedly until >Orientation appears.

@? >Orientation
Portrait

® @

®

5 Press the ENTER key. A blinking question mark (?) appears.

O ©

?Orientation
N ]

? Portrait
Il\

@ 6 Select Portrait or Landscape using the A or V key.
@ @

Q 7 Dross the ENTER key.

ENTER
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MENU

8 Press the MENU key. The message display returns to Ready.

3.7.3 Page Protect Mode
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The Page Protect Menu does not normally appear, however, Page Protect will be forcibly
set to On if a print overrun error occurs due to insufficient printer memory. When this has
happened, be sure to reset Page Protect to Auto (default) in order to maintain the
optimum use of printer memory.

1 Press the MENU key.

2 Press the A or V key repeatedly until Page set > appears.

Page set >

3 Press the > key.

4 Press the A or V key repeatedly until >Page Protect appears.

>Page Protect
On

5 Press the ENTER key. A blinking question mark (?) appears.

?Page Protect
X4

? On
?I\

6 Press the A or V key repeatedly until Auto appears.

>Page Protect
? Auto

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.
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3.7.4 Linefeed (LF) Action

This procedure instructs the printer what to do when it receives a linefeed code (0AH).

* LF Only

Linefeed is performed (Default).
+ CRandLF

A linefeed and carriage return are performed.
* Ignore LF

The linefeed is ignored.

1 Press the MENU key.

O

<
m
z
(=

Press the A or V key repeatedly until Page Set > appears.

@? Page Set >

®
N

®

3 Press the D> key.

®
® ©
@

4 Press the A or V key repeatedly until >LF Action appears.

@? >LF Action

LF only

® @

®

Press the ENTER key. A blinking question mark (?) appears.

O 9
2]

fLF Action
Mo

?
'i\LF only

6 Press the A or V key repeatedly until the desired linefeed action appears.

®
®
9

7 When the desired action is displayed, press the ENTER key.

®
® O
9

Press the MENU key. The display returns to Ready.

O ©

<
m
z
(i
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3.7.5 Carriage-Return (CR) Action

This procedure instructs the printer what to do when it receives a carriage-return code (0DH).

*+  CROnly

A carriage-return is performed (Default).
* CRandLF

A linefeed and carriage return are performed.
» Ignore CR

The carriage-return is ignored.

Q 1 Press the MENU key.

2 Press the A or V key repeatedly until Page Set > appears.

@? Page Set >

Press the > key.

Press the A or V key repeatedly until >CR Action appears.

Q
Y

@ ® © 6
W

>CR Action
CR only

O 5 Press the ENTER key. A blinking question mark (?) appears.
ENTER

>?R Action
(N 4

?CR only
/|\

@ 6 Press the A or V key repeatedly until the desired carriage-return action appears.
@ ®

©

O 7 When the desired action is displayed, press the ENTER key.

ENTER

Q 8 Press the MENU key. The message display returns to Ready.

MENU
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3.8 Setting Print Quality

3.8 Setting Print Quality

3.8.1 KIR

The printer features the Print Quality menu which lets you select:

+ KIR (Kyocera Image Refinement) mode (smoothing function, for monochrome printing
only)

*  EcoPrint mode (toner saver, for monochrome printing only)

*  Tone mode (Normal and Fine)

e Gloss mode (Low and High)

KIR is the Kyocera’s smoothing function. It refines appearance of printed characters that have
jagged or uneven edges. Note that KIR is effective for monochrome printing only.

KIR is On (Default). KIR is Off.

Figure 3-9
The above diagram is an approximate presentation of KIR.

By default, KIR is activated. To confirm the KIR status or deactivate KIR, proceed as follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Print Quality > appears.

Print Quality >

3 Press the D> key.
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3.8.2 EcoPrint

4 Press the A or V key repeatedly until >KIR Mode appears.

>KIR Mode
On

5 To deactivate KIR, press the ENTER key. A blinking question mark (?) appears.

fKIR Mode
Ny

? On
?I\

6 Press the A or V key to set KIR Of f.

7 Press the ENTER key to finalize the selection.

8 Press the MENU key. The display returns to Ready.

EcoPrint enables the printer to consume less toner for a page to save your printing costs. When
EcoPrint mode setting is On, the printing image becomes lighter, but readable.The EcoPrint
setting has no effect on the print speed.

5

;/
3
S

EcoPrint is Off. EcoPrint is On.

x

Figure 3-10

The above diagram is an approximate presentation of EcoPrint. The default is Off. To
confirm or activate EcoPrint, proceed as follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Print Quality > appears.

Print Quality >
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3.8 Setting Print Quality

Press the D> key.

Press the A or V key repeatedly until >EcoPrint Mode appears.

>FEcoPrint Mode
Off

To activate EcoPrint, press the ENTER key. A blinking question mark (?) appears.

fEcoPrint Mode
S

? Off
'I\

Press the A or V key to change from Of £ to On.

Press the ENTER key.

Press the MENU key. The display returns to Ready.
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3.8.3

Tone Mode
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The Tone Mode selects the way the printer handles a pixel for representing the color and
halftoning for each pixel — Normal or Fine. The Fine tone mode uses four-bit smooth halftone
for photographs, image, etc.; and the Normal tone mode uses a one-bit halftone for text, solid
objects, etc. Either of these tone modes consistently affects all objects on a page.

The Fine tone mode provides the print quality better than Normal, but the printing speed is
slower and more memory is required. A summary of memory requirement depending on the
tone mode follows:

Paper size Simplex/ Normal Fine
Duplex Color Mono. Color Mono.
Ad/Letter Simplex 64 MB 64 MB 64 MB 64 MB
Duplex 64 MB 64 MB 96 MB 64 MB
A3/B4 Simplex 64 MB 64 MB 96 MB 64 MB
Duplex 96 MB 64 MB 160 MB 64 MB
Table 3-4

The amount of memory actually required may vary depending on the data to print.

The default tone mode is Normal. To confirm and change the tone mode, proceed as follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Print Quality > appears.

Print Quality >

3 Press the > key.

4 Press the A or V key repeatedly until >Tone appears.

>Tone
Normal
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Gloss Mode

Note

3.8 Setting Print Quality

5 To change the toner mode, press the ENTER key. A blinking question mark (?)
appears.

?Tone

S
? Normal
'I\

6 Press the A or V key to change to Fine.

7 Press the ENTER key to finalize the tone mode.

8 Press the MENU key. The display returns to Ready.

The gloss mode, when set to High, increases the effect of glossiness in printing by reducing the
printing speed by half. The gloss mode cannot be used for duplex printing. The gloss mode is
effective for the following paper types:

Plain
Recycled
Vellum
Color
Prepunched

Depending on the paper used, printing in gloss mode may cause wrinkle in paper. To
reduce wrinkle,try using thicker paper.

The default gloss mode is Low. To confirm or change the gloss mode, proceed as follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Print Quality > appears.

Print Quality >

3 Press the D> key.
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Press the A or V key repeatedly until >Gloss Mode appears.

>Gloss Mode
Low

To change the gloss mode, press the ENTER key. A blinking question mark (?)
appears.

fGloss Mode
.z

? Low
fl\

Press the A or V key to change from Low to High.

Press the ENTER key to finalize the selection.

Press the MENU key. The display returns to Ready.
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3.9 Operating the Storage Device

The printer supports the following storage device:

* RAM disk (shared in the printer memory)
*  Memory card (Option)
* Hard disk (Option)

3.9.1 Setting up the RAM Disk
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The RAM disk is a memory space shared within the printer memory that can temporarily store
print jobs for electronic sorting. The stored print job can then be used to print multiple copies
of the job reducing the total amount of period required to print the whole job. It acts similar to
the option hard disk except that the data is effective only during the printer is powered up.

To set up the RAM disk, the option hard disk must not be installed.

To use the RAM disk, activate and enter the desired size of the RAM disk in the manner
described below. The maximum RAM disk size can be calculated as follows:

Maximum RAM size = Total printer memory - 48 MB

For example, if the total memory installed in your printer is 64 MB (Default), you can set 16
MB of RAM disk. If you attempt to set the RAM disk size beyond this restriction, the printer
automatically round it down so that the size is always 48 MB less than the total printer
memory. Once the RAM disk size is set, the printer must be reset.

By default, the RAM disk is not activated (O£ £). To confirm the RAM disk size or activate the
RAM disk, proceed as follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until RAM Disk Mode > appears.

RAM Disk Mode >
Off

3 To activate the RAM disk, press the ENTER key. A blinking question mark (?)
appears. Press the A or V key to change Of £ to On. Press the ENTER key.

M Disk Mode
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4 Press the [> key to display >RAM Disk Size.

>RAM Disk Size
0055 Mbyte

5 Press the ENTER key again and change the RAM disk size using the A or V key. The
value for the RAM disk is between 0001 and 1024 depending on the available printer
memory.

6 When the desired RAM disk size is displayed, press the ENTER key.

7 Press the MENU key to exit the menu selection. Restart the printer. The setting will be
effective after restarting.

3.9.2 Reading/Writing to an Option Storage Device
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The printer can be equipped with a memory card and a hard disk. For more information about
handling a memory card, see Appendix A Options, section A.3.1 Memory Card on page A-7.

The operator panel provides the following operations for the memory card and the hard disk.

* Reading fonts, macros, data, programs

*  Writing data

* Deleting data, fonts, programs, macros

* Formatting a memory card or hard disk (See Note below)
*  Printing a list of partitions

The following procedure assumes use of a memory card. The similar procedure can be applied
when using a hard disk.

You can format the hard disk using the operator panel when the first time you installed a
new hard disk. About formatting a new hard disk, see also the Installation Guide of the
hard disk for details.

Reading Fonts

Fonts in a memory card are automatically read into the printer when the memory card is
installed in the printer slot when the printer is turned on.

To re-read fonts from a memory card, or to read fonts from the hard disk, use the following
procedure:

1 Press the MENU key.

2 Press the A or V key repeatedly until Memory Card >orHard Disk > appears.

Memory Card >
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Press the D> key.

Press the A or V key repeatedly until >Read Fonts appears.

>Read Fonts

Press the ENTER key. A question mark (?) appears.

>Read Fonts ?

Press the ENTER key. The message display shows Processing as the fonts are read
from the memory card or the hard disk.

When the fonts have been read, the display returns to >Read Fonts.

Press the MENU key. The display returns to Ready.

Reading Data

To read data on a memory card or the hard disk, use the following procedure:

1

2

Press the MENU key.

Press the A or V key repeatedly until Memory Card >or Hard disk > appears.

Memory Card >

Press the D> key.

Press the A or V key repeatedly until >Read Data appears. The name of the first
data in the storage device also appears (DataS001 in this example).

>Read Data
DataS001
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5 To select a data to read, press the ENTER key. A blinking question mark (?) appears
before the data name.

?Read Data

V4
"2Datas002
'I\

6 Press the A or V key to scroll through the data in the storage device.

7 When the desired data is indicated, press the ENTER key. The message display shows
Processing as the data is read from the storage device.

Writing Data to a memory card or the hard disk

You can write data to a memory card or the hard disk using the operator panel. When writing
data to the storage device, a name is automatically assigned to the data. The memory card or
the hard disk must be formatted. Otherwise, the >Write Data message explained below
will not appear on the display. To format a memory card or the hard disk, see Formatting a
Storage Device on page 3-75.

You can format the hard disk using the operator panel when the first time you installed a
new hard disk. About formatting a new hard disk, see also the Installation Guide of the
hard disk for details.

After writing is complete, you can print a list of data stored in the storage device for
confirmation. See Printing a Partition List on page 3-76.

To write data to a memory card or the hard disk, proceed as follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Memory Card > or Hard disk > appears.

Memory Card >

3 Press the > key.

4 Press the A or V key repeatedly until >Write Data appears.

>Write Data

3-72



ENTER

ENTER

3.9 Operating the Storage Device

5 Press the ENTER key. A question mark (?) appears.

>Write Data ?

6 Press the ENTER key. The message display shows Processing, then Waiting. If

you wish to abort writing, press the CANCEL key.

7 While the message display indicates Waiting, send the data to write from the
computer to the printer.

For example, to write data ‘TEST . TXT’ you can use the DOS COPY command as:
COPY TEST.TXT PRN

The data is written to the memory card or hard disk with a unique partition name which
the printer automatically assigns in a sequence as follows:

DataS001 (first data), DataS002 (second data), DataS003 (third data),...DataS127 (last
data)

In the example above, data ‘TEST . TXT’ is renamed and stored as ‘DataS001’ in the
storage device.

8 As the printer receives data, the message display shows Processing, soon followed

by Waiting. Press the GO key. The printer automatically prints a Write Information
page as shown below:

KYOCERA
{g miifa

ECOS}&: | FS-8000C Page Print.

WRITE INFORMATION

Device Name/Number: = MEMORY CARD/A

Partition Type: 2/Printable Data

Partition Name: DataS001 /System define
Write Partition Length: 8654 bytes

Others:

\_/\

Figure 3-11
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This page provides the following information that are automatically generated by the
printer while the data is written:

» Partition Type
Type of data written (only type 2 is supported at the present time)
*  Partition Name
Name of data written
*  Write Partition Length
Length (size) of the data written
*  Others
Additional information, such as error information

After the Write Information page is printed, the display returns to Ready.

If writing was not successfull, the message display displays an error code. For details,
see Chapter 5 Troubleshooting, section 5.3.2 Storage Error Codes on page 5-11.1f this
happens, press the GO key. The message display returns to Ready.

9 Repeat the above steps until you have written all required data to the storage device.
Each time you finish writing data, a Write Information page is printed showing the
information about the data just written. Data contained in the storage device can be
printed anytime by following the procedure described in Printing a Partition List on
page 3-76.

Deleting Data

You can use the printer’s operator panel to delete data from a memory card or the hard disk.

1 Press the MENU key.

O
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Press the A or V key repeatedly until Memory Card >orHard Disk > appears.

?
@ Memory Card >

®
N

®

3 Press the > key.

®
® @
@

4 Press the A or V key repeatedly until > Delete Data appears. The name of the
first data in the storage device also appears (DataS001 in this example).

®’
>Delete Data

DataS001

® @

®

5 Press the ENTER key. A blinking question mark (?) appears before the data name.

O 9

?Delete Data

nNo
?data name
?I\
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3.9 Operating the Storage Device

6 Press the A or V key to scroll through data in the storage device.

When the data you desire to delete is displayed, press the ENTER key. The message
displays shows Processing and the data is deleted from the storage device.

Formatting a Storage Device

A new memory card or hard disk must be formatted before it can be used in the printer. You
can format the storage device using the printer operator panel.

* Formatting will destroy any existing data on a storage device.

*  You can format the hard disk using the operator panel when the first time you
installed a new hard disk. About formatting a new hard disk, see also the Installation
Guide of the hard disk for details.

To format a memory card or the hard disk, use the following procedure:

1 Press the MENU key.

2 Press the A or V key repeatedly until Memory Card >orHard Disk > appears.

Memory Card >

3 Press the D> key.

4 Press the A or V key repeatedly until >Format appears.

>Format

5 Press the ENTER key. A question mark (?) appears.

>Format ?

6 Press the ENTER key. The message display shows Processing while the storage
device is formatted. If you wish to cancel formatting, press the CANCEL key now.

If formatting of the memory card was successfull, the printer automatically prints a
Format Information page as shown below:
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0} KYOCERA
mila

FORMAT INFORMATIO

Device Name/Number: = MEMORY CARD/A
Formatting is completed.

Capacity: 16039936 bytes
Used Space: 53248 bytes
Free Space: 15986688 bytes

Lcosrs.) FS-8000C Page Printer

@

Figure 3-12

Printing a Partition List

Capacity

This page provides the following information that are automatically generated by the
printer while the memory card is formatted:

Total size of the memory card formatted

Used Space

The space used by the printer for its file system

Free Space

The space remaining in the memory card for storing data

When the Format Information is printed, the display returns to Ready.

By following the procedure below, the printer prints a list of all data (referred to as partitions)
stored in a storage device for reference. If a font card is inserted in the printer slot, a list of
fonts in the font card is printed.

1

3

Press the MENU key.

Press the A or V key repeatedly until Memory Card >orHard Disk > appears.

Memory Card

>

Press the > key.

3-76



®
Q)

@?

©

ENTER

ENTER

3.9 Operating the Storage Device

4 Press the A or V key repeatedly until >List of Partitions appears.

>List of
Partitions

5 Press the ENTER key. A question mark (?) appears.

>List of
Partitions ?

6 To print a Partition List, press the ENTER key. A Partition List is printed as exampled
below. Sample list of fonts are shown in Figure 3-13 below.

KYOCERT

g

Lcosis FS-8000C Page Printe
PARTITION LIST |

Device Information |

Device Name/Number: MEMORY CARD/A
Capacity: 31965184 bytes
Used Space: 16784384 bytes
Free Space: 15180800 bytes
Current terminate string: WRED

Write Protect: DISABLED

Partition Information ]
Partition Name Partition Size Partition Type
Datas001 53 Printable Data

\—/—\

Figure 3-13

The list provides the following information that are automatically generated by the printer
about data currently stored in the storage device:

*  Device Name/Number
Description for the storage device. For example, MEMORY CARD/A’ is
indicated for a memory card.
*  Capacity
Total capacity of the storage device in bytes.
*  Used Space
The total space used for data stored in the storage device in bytes.
* Free Space
The space remaining in the storage device for storing more data, including the
memory space required by the printer for its file system.
+  Partition Name
The name assigned automatically by the printer for written data.
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* Partition Size
Size of the written data in bytes.

» Partition Type
The type identifying the written data, i.e., whether it is host data (Data) or font data
(Font).

When the list of file names (partition list) for the memory card is printed, the display
returns to Ready.
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3.10 Paper Handling

This section explains how to change mode for the MP (multi-purpose) tray, the paper size and
type for each paper source, mode for the option sorter, and how to select the paper source and
paper destinations.

3.10.1 MP Tray Mode

The MP tray can be used in either of two modes — first or cassette. The MP tray feed
paper differently depending on the mode:

*  First Mode

The MP tray automatically feeds paper placed on the MP tray overriding another paper
source that is selected on the printer driver. After all paper sheets in the MP tray have been
used up (approximately 150 sheets), paper will be fed from the paper source originally
selected. This mode is convenient to feed paper of special size or type without reloading
the current paper source. However, the MP tray must be kept empty if you desire to feed
paper from the intended paper source.

*  Cassette Mode

This is the default mode. The MP tray acts in the same manner as other paper source. The
printer can correctly feed paper from any paper source as you command on the printer
driver. The cassette mode provides a faster printing speed than the first mode.

To switch the MP tray to Cassette mode, proceed as follows:

1 Press the MENU key.

O
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2 Press the A or V key repeatedly until Paper Handling > appears.

@? Paper Handling >

@

Press the D> key.

@ ©

4 Press the A or V key repeatedly until >MP Tray Mode appears.

@7 >MP Tray Mode
First

@

©@ GO 6 @ 6
W
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5 Press the ENTER key. A blinking question mark (?) appears.

ENTER ?MP Tray Mode
S
? First
'I\
@ 6 Press the A or V key to change First to Cassette.

@ @
O 7 Press the ENTER key. The MP tray mode is changed.
ENTER

8 To exit the menu selection, press the MENU key.

MENU

3.10.2 Setting MP Tray Paper Size

When you use the MP tray in cassette mode, you should set the MP tray size to the paper size
that is used to format the job to print. If the sizes do not match, printing will not be performed
on the correct size paper. The default setting is Let ter size for the U.S. and Canada and A4

for other countries.

For more information about the paper sizes that you can feed from the MP tray, see Chapter 2
Handling Paper.

: ? Feeding the paper having a paper size which does not match the current paper size from
the MP tray can cause paper jam.

Note
Q 1 Press the MENU key.
MENU
2 Press the A or V key repeatedly until Paper Handling > appears.
@ @? Paper Handling >

3 Press the > key.

@’?

®

4 Press the A or V' key repeatedly until >MP Tray Size appears. In this example, the
current MP tray paper size is A4.

@’?

®
©@ G & 0 6

>MP Tray Size
A4
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5 To change the paper size, press the ENTER key. A blinking question mark (?) appears.

6 Press the A or V key to display the desired paper size. The message display toggles
through the following paper sizes:

A4
Executive
Letter-R
Letter
Legal
Ledger

A3

B4

Custom

c4

Hagaki
Oufukuhagaki
Monarch
Business
Comm. #9
Comm. #6 3/4
DL

C5

A6

B6

A5

B5

ISO BS
A4-R

7 When the desired paper size is displayed, press the ENTER key. The paper size is set
for the MP tray.

8 To exit the menu selection, press the MENU key.

3.10.3 Setting the MP Tray Paper Type

®
@
®

MENU

@?

By setting a paper type (plain, recycled, etc.) to the MP tray, you can select the paper on the
MP tray according to the paper type you command on the printer driver. The default setting is
plain paper.

For more information about paper types that can be fed from the MP tray, see Chapter 2
Handling Paper.

1 Press the MENU key.

2 Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >
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3 Press the > key.

4 Press the A or V key repeatedly until >MP Tray Type appears.

> MP Tray Type
Plain

5 To change paper type, press the ENTER key. A blinking question mark (?) appears.

f MP Tray Type
Mo

? Plain
'I\

6 Press the A or V key to display the desired paper type. The message display toggles
through the following paper types:

Plain
Transparency
Preprinted
Labels

Bond
Recycled
Vellum

Rough
Letterhead
Color
Prepunched
Envelope
Cardstock
Coated

2nd side
Custom 1(to 8)

7 When the desired paper type is displayed, press the ENTER key. The paper type is set
to the MP tray.

8 To exit the menu selection, press the MENU key.

3.10.4 Setting the Cassette Paper Type

MENU

By setting a paper type (plain, recycled, etc.) to the paper cassette, you can automatically
select the paper in the paper cassette according to the paper type you command on the printer
driver. The default setting is plain paper for all paper cassettes.

For more information about paper types that you can feed from the paper cassette, see Chapter
2 Handling Paper.

1 Press the MENU key.
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Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the D> key.

Press the A or V key repeatedly until >Cassette # Type appears.

>Cassette 1 Type
Plain

To change paper type, press the ENTER key. A blinking question mark (?) appears.

f;assette 1 Type
>

? Plain
<'|\

Press the A or V key to display the desired paper type. The message display toggles
through the following paper types:

Plain
Preprinted
Recycled
Vellum

Rough
Letterhead
Color
Prepunched
2nd Side
Custom 1 (to 8)

When the desired cassette type is displayed, press the ENTER key.

To exit the menu selection, press the MENU key.
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3.10.5 Selecting the Paper Feed Source
You can select the paper source using the operator panel, from which the printer feeds paper as

the default. If an optional paper feeder(s) is installed, it is also available for the default paper
source.

1 Press the MENU key.

O
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2 Press the A or V key repeatedly until Paper Handling > appears.

®

@? Paper Handling >

®

Press the > key.

®
® ©
9
W

4 Press the A or V key repeatedly until >Feed Select appears.

® @

>Feed Select
Cassette 1

®
9

5 To change the current paper feed source, press the ENTER key. A blinking question
mark (?) appears.

O ©

?Feed Select

N V2
? Cassette 1
'I\

6 Press the A or V key to display the desired paper feed source. The message display
toggles through the following paper feed sources, depending on the installed optional

@ @ ? paper feeders (from the top most paper cassette to the bottom paper cassette):

MP tray

Cassette 1
Cassette 2
Cassette 3
Cassette 4
Cassette 5
Cassette 6

Cassettes 3 and 4 are available for selection when an optional paper feeder is installed.
Cassettes 5 and 6 are available for selection when two optional feeders are installed.
The FS-8000CD is equipped with the PD-30 duplex unit as a standard feature, whose
Casette 1 is occupied by the duplexer. Terefore, Cassette 1 is not available for the FS-
8000CD.

7 When the desired paper source displayed, press the ENTER key.

ENTER

3-84



MENU

3.10 Paper Handling

8 To exit the menu selection, press the MENU key.

3.10.6 Duplex Printing (FS-8000CD)

The FS-8000CD is equipped with the PD-30 duplex unit as a standard feature. The Paper
Handling menu on the operator panel provides you with activating the duplexer for printing
both sides of paper. You can also select the direction the duplex printed pages are bound —
short or long edge binding. See Figure 3-14 below.

Duplex printing is available for the following paper types:

Plain
Prepunched
Recycled
Letterhead
Color
Prepunched
Vellum

The procedure in this section will activate the duplexer as default. Even without
following this procedure, you can conveniently activate or deactivate duplex printing
using the printer driver.

Activating the duplexer on the operator panel is done by selecting either short edge or long
edge binding mode.

Duplex printing can be also performed from the Multi-Purpose (MP) tray. When the MP tray
is set to First Mode (“First”), the paper size and paper type will be the same as those of the
paper cassette currently set at the paper feed source. If the paper to be fed from the MP tray
does not match the paper size and paper type of the current paper feed source cassette, a
paper jam may occur.

Binding Modes

Binding refers to the manner in which printed pages of paper are joined together (by gluing,
stitching, etc.) in book form. The two possible types of binding are: long-edge binding, in
which pages are joined together along their long edge; and short-edge binding, in which they
are joined together along their short edge. In selecting a binding type, you must also consider
the orientation of the printed page. You can use long-edge or short-edge binding with either
landscape or portrait printing.

Depending on the binding type and print orientation, the duplexer provides four types of
binding. These are: (1) portrait, long-edge, (2) portrait, short edge, (3) landscape, long-edge,
and (4) landscape, short-edge. The figure below shows these binding methods.
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Figure 3-14

To select duplex printing and binding from the operator panel, use the following procedure:

(1)

Portrait,
long-edge

(3)
Landscape,
long-edge

1 Press the MENU key.

n~
o

Paper Handling >

Press the > key.

None

>Duplex mode

appears.

>

?
4"

None
N

Duplex mode
N, P

toggles through the following:

No

ne

(default)

Short edge bind
Long edge bind

(2) [

— Portrait,
short-edge

3

I

Landscape,
short-edge

Press the A or V key repeatedly until Paper Handling > appears.

Press the A or V key repeatedly until >Duplex Mode appears.

To activate duplex printing, press the ENTER key. A blinking question mark (?)

Press the A or V key to display the desired binding mode. The message display
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When the desired binding mode is displayed, press the ENTER key. The binding mode
is set.

To exit the menu selection, press the MENU key.

Note on Duplex Printing from the MP Tray

You cannot select the MP tray, when it is set to ‘cassette’ mode, to perform duplex
printing. To perform duplex printing, select a paper cassette.

It is possible to duplex-print using the MP tray if it is set in ‘first’ mode. (See Section
3.10.1 MP Tray Mode on page 3-79.) However, be sure to set the MP tray paper size and
paper type to the same paper size and paper type as those of the current paper cassette. If
the paper size or type differs, a paper jam may occur.
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3.10.7 Overriding Difference between A4 and Letter

When the Override A4/LT is turned on using the operator panel, the printer ignores the
difference between A4 and Letter paper sizes. Printing is performed without an error message
even if the actual paper size in the current cassette differs from the paper size formatting the
job.

By default, this feature is off. To confirm and turn on the Override A4/LT, proceed as
follows:

1 Press the MENU key.

O
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2 Press the A or V key repeatedly until Paper Handling > appears.

®

Paper Handling >

®
©

Press the > key.

®
® @
©
W

4 Press the A or V key repeatedly until >Override A4/LT appears.

® @

>Override A4/LT
Off

®
©

To change overriding mode, press the ENTER key. A blinking question mark (?)
appears.

O ©

m
Pz
5
m
uy)

?Override A4 /LT

2 off
'I\

Press the A or V key to change Of £ to On.

®
)

@?

®

7 Press the ENTER key. The overriding mode is set.

O ©

m
Pz
5
m
oy)

To exit the menu selection, press the MENU key.
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3.10.8 Creating Custom Paper Types
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The Type Adjust menu on the operator panel may be used to create a user-defined paper type
for the printer. Custom paper types allow you to optimize printing parameters such as the fuser
temperature best suited for the paper property. It also enables the printer to automatically select
the paper cassette in which the custom paper is loaded as commanded by the printer driver

Up to eight custom user settings may be registered on the operator panel. Creating a custom
paper type using the operator panel is a 4-step job:

* selecting one of eight custom setting positions (Custom 1 through 8)

» selecting the paper weight

» selecting the fuser temperature

» enabling or disabling duplexing for the paper type

Custom paper types can be reset afterwards by following the steps in Section 3.10.9 Resetting
the Custom Paper Type on page 3-92.

Step 1. Selecting the Custom Type Position

1 Press the MENU key.

2 Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

3 Press the D> key.

4 Press the A or V key repeatedly until >Type Adjust > appears. The first custom
setting is displayed.

>Type Adjust >
Custom 1

5 If you want to change to other custom setting position (Custom 2 to 8), press the
ENTER key. A blinking question mark (?) appears.

?Type Adjust
Mo

? Custom 1
'I\
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Press the A or V key to scroll to the other custom position.

Custom
Custom
Custom
Custom
Custom
Custom
Custom
Custom

O J o U b WN

When the paper type to be customized is displayed, press the ENTER key. Proceed to
the next procedure.

Step 2. Selecting the Paper Weight

Complete Step 1. above.

Press the > key.

Press the A or V key repeatedly until >>Paper Weight appears.

>>Paper Weight
Normal

Press the ENTER key. A blinking question mark (?) appears.

?>Paper Weight
Mo

? Normal
<'|\

Press the A or V key to display the desired paper thickness from the following:

Normal
Heavy (Thick)
Extra Heavy

When the desired paper thickness is displayed, press the ENTER key. Proceed to the
next procedure.
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3.10 Paper Handling

Step 3. Selecting the Fuser Mode

1 Complete Step 2. above.

2 Press the V key.

3 Press the A or V key repeatedly until >>Fuser Mode appears.

>>Fuser Mode
Middle

4 Press the ENTER key. A blinking question mark (?) appears.

?;Fuser Mode
2 Middle
'I\

5 Press the A or V key to display the desired fuser mode from the following:

Low
Middle

6 When the desired fuser mode is displayed, press the ENTER key. Proceed to the next
step.

Enabling or Disabling Duplex Printing for Custom Paper Type

This parameter is valid for the FS-8000CD printer which is equipped with the duplexer as a
standard feature. When this parameter is disabled for a Custom type, the printer does not
duplex print when the custom size is selected for the paper type in a print job.

By default, duplex printing is enabled for custom paper types. To confirm and change this,
proceed as follows:

1 Complete Step 1. above.

9  Press the D> key.

3 Press the A or V key repeatedly until >>Duplex path appears.

>>Duplex path
Enable

3-91



3.10 Paper Handling

O

ENTER

®

@ @

ON°,

O

=<
m
=z
c

7

To change duplex printing, press the ENTER key. A blinking question mark (?)
appears.

f>Duplex path

Mo
? Enable
<'|\

Press the A or V key to change from Enable to Disable.

Press the ENTER key. The duplex printing capability is changed.

To exit the menu selection, press the MENU key.

3.10.9 Resetting the Custom Paper Type
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If you want to reset all custom paper type settings (1 to 8) to the factory default, proceed as

follows:

1

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or V key repeatedly until >Reset Type Adjust appears.

>Reset Type
Adjust

To reset all custom paper types, press the ENTER key. A question mark (?) appears.

>Reset Type
Adjust ?
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Press the ENTER key. All customized paper types, including weight and duplex
printing capability, will be reset to the default. The message display returns to Ready.

3.10.10 Selecting the Output Stack
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The Stack Select menu on the operator panel allows you to select either the face-down tray or
the face-up tray for the output stack. If an optional output device such as the sorter, document
finisher, or bulk stacker, is installed, it can also be selected as an output stack.

1

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the D> key.

Press the A or V key repeatedly until >Stack Select appears.

>Stack Select
Face-down tray

To change the output stack, press the ENTER key. A blinking question mark (?)
appears.

>Stack Select
s!}/

Face-down tray
'I\

Press the A or V key to toggle through the following output stacks:

Face-down tray
Face-up tray

The output stacks change to include the following when an optional bulk stacker or
document finisher is installed:

Face-down tray
Opt.stacker [FU] (Option face-up tray required)
Opt.stacker [FD] (Option face-down tray required)

The output stacks change to include the following when an optional sorter is installed:

Face-down tray
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Opt.stacker [FU]

Opt.stacker

Q 7

ENTER

When the desired output stack is displayed, press the ENTER key.

8 To exit the menu selection, press the MENU key.

MENU

3.10.11 Selecting the Option Sorter Mode

If you install an option mailbox/sorter, you can have your printouts automatically sorted in
three different ways when printing multiple copies. The three methods are:

¢ Sorter mode

The sorter receives a complete set of a document starting from the top tray.

¢ Collator mode

The sorter receives all copies of the same page in each tray starting from the top tray.

¢ Mailbox mode

The sorter receives all copies of the same page in each tray starting from the bottom tray.

These modes are depicted in 7able 3-5 which follows:

Mode

Description

Sorter mode

Copy 1 (1-50 pages)
Copy 2 (1-50 pages)
Copy 3 (1-50 pages)

Copy 4 (1-50 pages)

The sorter mode sorts the output pages by copy as shown in
the example. This mode is useful when you need several
independent copies of a document.

The maximum number of copies is 9. If a tray becomes full
(approximately 200 pages), the printer pauses and indi-
catestheOption tray # paper full message.You
will need to remove all the printed pages from the tray indi-
cated by # in the message.

In the example, four copies of a document of 50 pages long
are printed, and each copy is stacked in trays 1, 2, 3, and 4,
respectively.

Collator mode

200 copies of page 1
200 copies of page 2
200 copies of page 3

200 copies of page 4

The collator mode sorts the output pages by page as shown
in the example. When multiple copies of a file are printed,
all copies of a single page are delivered together to a single
tray. A typical use of this mode is in printing material to be
distributed at a meeting.

The maximum number of copies is 200. If a tray becomes
full (200 pages), the printer pauses and indicates the
Option tray # paper full message. Then, you
will need to remove all the printed pages from the tray indi-
cated by # in the message.

In the example, we make 200-copy stacks of each page of
an 4-page long document.

Table 3-5
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3.10 Paper Handling

Mode

Description

Mailbox mode

Last page

First page

The mailbox mode simply stacks the printed pages into the
sorter’s trays without sorting the pages in any way, starting
from the bottom tray and going to the top tray. When the
top tray becomes full, the printer indicates the Option
tray # paper full message and pauses until you
remove all the pages in the tray indicated by # in the mes-
sage. In this way, you can print a large job up to approxi-
mately 1,000 pages without interrupting the printing
process.

The example shows the sorter having received approxi-
mately 600 pages in the mailbox mode.

Table 3-5 (Continued)

To select one of the stacker modes above from the operator panel, use the following procedure.

1 Press the the MENU key key.

2 Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

3 Press the D> key.

4 Press the A or V key repeatedly until >Opt . StackerMode appears.

>0Opt.StackerMode
Sorter

5 To change mode, press the ENTER key. A blinking question mark (?) appears.

f?pt.StackerMode
>

? Sorter
'I\

6 Press the A or V key to display the desired sorter mode. The message display toggles

through the following:

Sorter
Collator
Mail box
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When the desired sorter mode is displayed, press the ENTER key. The sorter mode is
changed.

To exit the menu selection, press the MENU key.
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3.11 Color Control

This section covers how to use the operator panel for controlling parameters pertaining to
color printing.

3.11.1 Selecting Monochrome or Color Printing

<
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z
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You can use the Color Mode menu on the operator panel to select the Monochrome or Color
printing mode. It also allows you to perform adjustments on color. The Color Mode menu has
the following sub-menus:

*  RGB simulation

Prints using colors close to those projected on a monitor.
* Ink simulation

Used for setting the type of colors to be used, such as SWOP. Ink simulation can be used
only when KPDL and KPDL (AUTO) is chosen as the emulation.
*  Color calibration

Executes manually the color calibration System for the optional color reproduction
performance.
Selecting Monochrome or Color Printing

By default, the printer is set to print in color mode. To change it to monochrome mode,
proceed as follows:

Color Mode >
Color

1 Press the the MENU key.

2 Press the A or V key repeatedly until Color Mode appears. The current color mode
appear under Color Mode.

3 To change color mode, press the ENTER key. A blinking question mark (?) appears.

qolor Mode
YV

? Color
/|\

4 Press the A or V key to change color mode — Monochrome or Color.
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When the desired color mode is displayed, press the ENTER key. Color mode is
changed.

6 To exit the menu selection, press the MENU key.

3.11.2 Matching Colors to Monitor (RGB Simulation)
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Computer monitors use three colors of RGB (Red, Green, and Blue) to reproduce all colors. If
you wish to print data using RGB simulation for color reproduction, use the following
procedure. The printer does not use RGB simulation by default but can be set to use SRGB for
simulation.

1 Press the MENU key.

2 Press the A or V key repeatedly until Color Mode appears.

Color Mode >
Color

3 Press the > key.

4 Press the A or V key repeatedly until >RGB Simulation appears.

>RGB Simulation
None

5 Press the ENTER key. A blinking question mark (?) appears.

fRGB Simulation
Mo

? None
'l\

6 Press the A or V key repeatedly until the desired RGB type — sRGB is displayed.

7 When the desired RGB simulation mode is displayed, press the ENTER key.

8 To exit the menu selection, press the MENU key.
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3.11.3 Using Ink Simulation
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The ink simulation delivers the color results closest to the industry-standard color management
systems. These include:

«  SWOP
* Euro-scale

1 Press the MENU key.

2 Press the A or V key repeatedly until Color Mode appears.

Color Mode >
Color

3 Press the D> key.

4 Press the A or V key repeatedly until >Ink Simulation appears.

>Ink Simulation
None

5 Press the ENTER key. A blinking question mark (?) appears.

iInk Simulation
MNo

?None
4"\

6 Press the A or V key repeatedly until the desired type of ink simulation appears.

7 Press the ENTER key. The ink simulation is set.

8 To exit the menu selection, press the MENU key.
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3.11.4 Color Calibration
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The printer maintains the optimal color reproduction performance using the Color Calibration
system. This function is performed automatically each time you power on the printer or when
the printer reverts to normal operation from sleep mode. You can also use the following
procedure to execute this function even after the printer has been powered on.

1 Press the MENU key.

2 Press the A or V key repeatedly until Color Mode > appears.

Color Mode >
Color

3 Press the > key.

4 Press the A or V key repeatedly until >Color Calibration appears.

>Color
Calibration

5 To let the printer perform color calibration, press the ENTER key. A question mark (?)
appears to let you confirm the execution of calibration.

>Color
Calibration ?

6 Press the ENTER key. The message display shows Please wait
(Calibrating) and calibration will start.

Please wait
(Calibrating)

7 When calibration is finished, the display returns to Ready.
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3.12 Reading Life Counters

You can display the total number of pages printed by your printer whenever it is necessary.
The total number of printed pages can also be checked on the status page. See Section 3.3.2
Printing a Status Page on page 3-16 . For proper maintenance scheduling, you need to reset
the toner counter using this menu each time a new toner container is installed.

3.12.1 Displaying the Total Printed Pages

This procedure displays the total number of printed pages. You cannot change the displayed
value.

1 Press the MENU key.
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Press the A or V key repeatedly until Life Counters > appears.

@? Life Counters >

®
N

®

® ©

3 Press the D> key.

®
©

4 Press the A or V key repeatedly until >Total Print appears and the latest total
print count is shown.

® @

@?

®

>Total Print
0123456

5 To exit the menu selection, press the MENU key.
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3.12.2 Displaying the Oil Unit Life

This procedure displays the total number of printed pages the oil unit has been used since its
previous replacement.

1 Press the MENU key.
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2 Press the A or V key repeatedly until Life Counters > appears.

®

Life Counters >

®
9

Press the D> key.

®
® O
9
W

4 Press the A or V key repeatedly until >011 Kit appears. The latest oil unit life is
displayed.

® @

®
9

>01l Kit
0123456

To exit the menu selection, press the MENU key.
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3.12.3 Resetting the Toner Counter
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The toner containers must be replaced when the printer displays the Low toner or
Replace toner message which will be given depending on the color of toner. The Low
toner message will be shown as a pre-warning that the toner is running out and the printer
will soon stop, at that time showing Replace toner. If you replace the toner container
before Replace toner is displayed, you must manually reset the toner counter as
explained below.

Note that if you reset the toner counter before the toner container is replaced, the subsequent
toner warnings will not be indicated correctly.

1

Replace the toner container according to the message given on the message display. To
replace the toner containers, see Chapter 6 Maintenance, section 6.1 Toner Container
Replacement on page 6-2.

Press the MENU key.

Press the A or V key repeatedly until Life Counters > appears.

Life Counters >

Press the D> key.

Press the A or V key repeatedly until the message display shows the toner container of
the color you replaced — [Clyan, [M]agenta, [Y]ellow, or blac[K]. For example, to
reset the Cyan toner counter, display >New Toner [C] Installed.

Press the ENTER key. A question mark (?) appears.

>New Toner [C]
Installed ?

Press the ENTER key. The toner counter is reset.

To exit the menu selection, press the MENU key.
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3.13 Other Modes

The following modes can be accessed in the Others submenu:

*  Message Language

*  Automatic Form Feed Timeout Setting
*  Sleep Timer Setting

*  Received Data Dumping

e Printer Resetting

* Resource Setting

*  Alarm (Buzzer) Setting

* Auto Continue Setting

*  Service Menu (for service personnel)

3.13.1 Selecting the Message Language

®

®

®

O

<
m
z
[

®

@?

®0® ® O
9

@?

O ©

You can select the language of the messages on the message display by following the
procedure given below. You can optionally download messages in other languages. Contact
your Kyocera Mita dealer for information.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

3 Press the > key.

4 Press the A or V key repeatedly until >MSG Language appears. The default
message language is English.

>MSG Language
English

5 To change the language, press the ENTER key. A blinking question mark (?) appears.

iMSG Language

’
";?\ English
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Press the A or V key. The display cycles through the available selection in the
following order:

English
Francais
Deutsch
Italiano
Nederlands
Dansk
Espafiol
Svenska

If you want to abandon the setting procedure, press the CANCEL key.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.

3.13.2 Automatic Form Feed Timeout Setting
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If the printer receives no data for a certain period, it will time out and release the current
interface. It prints whatever data it has in its buffer and feeds out the page. The default form
feed timeout time is 30 seconds. You can adjust the time-out time as follows:

1

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the D> key.

Press the A or V key repeatedly until >Form Feed Time Out appears.

>Form Feed
Time Out 030sec.
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5 To change the timeout time, press the ENTER key. A blinking cursor (_) appears.

>Form Feed Time.

Time Out O3\O’sec .
T

6 Press the A or V key to increase or decrease the value at the blinking cursor and set
the desired time. The timeout time can be between 0 and 495 seconds, in 5-second
increments. Use the > and <] keys to move the cursor right and left.

7 When the desired timeout time is displayed, press the ENTER key.

8 To exit the menu selection, press the MENU key.

3.13.3 Setting the Sleep Timer
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The printer has a sleep timer that is used to conserve power when the printer is not printing,
processing, or receiving data.

You can turn off or on the sleep timer function using the following procedure.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

3 Press the > key.

4 Press the A or V key repeatedly until >Sleep Timer > appears.

>Sleep Timer >
030 min.

5 Press the > key and display >>Sleep Mode.

>>Sleep Mode
On
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3.13 Other Modes

To turn off the sleep timer, press the ENTER key. A blinking question mark (?)
appears.

i>Sleep Mode
S

? On
fl\

Press the A or V key to change On to Of f.

>>Sleep Mode
? Off

Press the ENTER key. The sleep timer is turned off.

To exit the menu selection, press the MENU key.

Sleep Timer Timeout Time

You can adjust the timer timeout time, the length of time the printer waits before entering
sleeping mode in the absence of data. The default sleep timer timeout time is 30 minutes.

The printer reverts to normal operation mode when the printer receives a print job, the operator
panel is operated, or one of the exterior covers is opened.

Color calibration is automatically executed before the printer reverts to normal operation

mode.

To confirm and change the timeout time, proceed as follows:

1

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the D> key.

Press the A or V key repeatedly until >Sleep Timer > appears.

>Sleep Timelr >

030fin
m
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To change the timeout time, press the ENTER key. A blinking cursor (_) appears.

>Sleep Time

030Mmin.
N

>

Press the A or V key to increase or decrease the value at the blinking cursor and set
the desired time. The timer can be set between 5 and 240 min, in 5-minute increments.
Use the [> and <] keys to move the cursor right and left.

When the desired timeout time is displayed, press the ENTER key.

To exit the menu selection, press the MENU key.

3.13.4 Received Data Dump
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1

Press the MENU key.

You can print data received by the printer as hexadecimal code for debugging programs and
files.

Press the A or V key repeatedly until Others > appears.

Others

>

Press the > key.

Press the A or V key repeatedly until > Print HEX-DUMP appears.

>Print HEX-DUMP

Press the ENTER key. A question mark (?) appears.

>Print HEX-DUMP?
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6 Press the ENTER key again. The message Processing appears for a second,
followed by Waiting.
ENTER

Processing

) 4

Waiting

7 While the message display is indicating Waiting (for 30 seconds by default), send
data to be hex-dumped to the printer. The message display indicates Processing
while the data is being received.

Q You can cancel printing of any more dump data by pressing the GO key and then the

CANCEL key.
GO

8 Once all data has been received, the message Wa it ing will appear. Press the GO key

to finish hex-dump printing.
GO

3.13.5 Printer Resetting

The procedure described below resets the printer’s temporary conditions, such as the current
unit of measurement, page orientation, font, character code set, margins, etc., set by commands
to their default values. Downloaded fonts and macros are deleted from the printer’s memory.

1 Press the MENU key.
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2 Press the A or V key repeatedly until Others > appears.

@? Others >

®

3 Press the D> key.
®’

4 Press the A or V key repeatedly until >Printer Reset appears.

@7

® ®
© GO & 0 6
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5 To reset the printer, press the ENTER key. A question mark (?) appears.
ENTER
6 Press the ENTER key again. Self test appears while the printer is resetting itself,

followed by Please wait and then Ready.
ENTER

Self test

) 4

Please wait

\ 4

Please wait

(Calibrating)

\ 4

Ready

3.13.6 Resource Protection

By default, when you switch from the PCL 5c¢ emulation to another, all downloaded fonts and
macros will be lost. Resource protection preserves these PCL resources in memory so that they
remain intact even when you have switched back in PCL 5c.

: ? Resource protection requires extra memory to store the downloaded fonts and macros.
The total size of the printer memory recommended for using the resource protection
Note option is affected by several factors. See Appendix A Options.

By default, resource protection is deactivated. To activate resource protection, proceed as
follows:

1 Press the MENU key.

MENU

2 Press the A or V key repeatedly until Others > appears.

®
@ @? Others >
©
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3.13 Other Modes

Press the D> key.

Press the A or V key repeatedly until >Resource Prot. appears.

>Resouce Prot.
Ooff

Press the ENTER key. A blinking question mark (?) appears.

>Resouce Prot.
Mo

? Off

'I\

Press the A or V key to select Permanent or Permanent/Temporary for resource
protection.

Permanent
Perm / Temp

When the desired resource protection is displayed, press the ENTER key.

To exit the menu selection, press the MENU key.

3.13.7 Alarm (Buzzer) Setting

You can set an alarm sound in addition to the message displayed when the paper supply is
exhausted, or when paper jamming occurs. This setting is useful, for example, when the printer
is located some distance from the user.

The audio alarm is set to On when leaving the factory. If the alarm is set to Of £, it will not

sound.
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Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the D> key.
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4 Press the A or V key repeatedly until Buzzer appears.

®
@ @7 >Buzzer
©

Oon

5 Press the ENTER key. A blinking question mark (?) appears.

ENTER >Buzzer
Mo
? On
'I\
@ 6 Select On or Of f using the A or V key.

@ @
©
O 7 Press the ENTER key.
ENTER

8 To exit the menu selection, press the MENU key.

MENU

3.13.8 Auto Continue Setting

If you encounter an error that still allows you to continue printing (Memory overflow
Press GO, Print overrun Press GO,KPDL error Press GO,and File not
found Press GO), the next received data is automatically printed after a preset period of
time elapses. For example, if the printer is shared over a network and one person causes one of
the above errors, the data sent from the next person is printed after the set period of time
elapses.

Q 1 Press the MENU key.

MENU

2 Press the A or V key repeatedly until Others > appears.

@? Others >

@

3 Press the > key

@ ©

@ ® @ 6
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3.13 Other Modes

Press the A or V key repeatedly until Auto Continue > appears.

>Auto Continue >
Mode On

Press the ENTER key. A blinking question mark (?) appears.

>Auto gismtinue

\
Mode ? On
/|\

Select On or Of £ using the A or V key.

Press the ENTER key.

To exit the menu selection, press the MENU key. The display returns to Ready.

3.13.9 Setting the Auto Continue Recovery Time

®
® @
® O

@ @

© G 6 6

Follow the procedure given below to change the recovery time for Auto Continue.

1

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the D> key.

Press the A or V key repeatedly until Auto Continue Mode > appears.

>Auto Continue >
Mode On

3-113



3.13 Other Modes

®
@ ©
®

ENTER

Press the [> key and display >> Auto Continue Timer.

>>Auto Continue
Timer 000sec.

Press the ENTER key. A blinking cursor (_) appears.

>>Auto Cont}nue
. 1

Timer 000sec.
T

Press the A or V key to increase or decrease the value at the blinking cursor and set
the desired time. The time must be set between 000 and 495 seconds, in 5-second
increments. If set to 000, printing will be continued immediately without any time
interval. You can use the [> and < keys to move the cursor right and left.

If you wish to abort the setting procedure, press the CANCEL key.

Display the desired time and press the ENTER key.

Press the MENU key. The display returns to Ready.
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3.13.10 Service Menu
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3.13 Other Modes

The service menu is used for maintenance operations to be performed by service personnel.
The following sub-menus are displayed:

Print Status Page
Print Test Page 1
Print Test Page 2

Drum

Maintenance [A]
Maintenance [B]
Maintenance [C]
Maintenance [D]

This section provides only the instruction on how to print a service status page. Other sub-
menus are for use with service personnel only.

Printing the Service Status Page

The service status page contains printer settings information that is more detailed than the
standard status page and is therefore mostly for service purposes. However, since there is a
great deal of information on the service status page that may be useful to you, the procedure
for printing it out is given below.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

3 Press the D> key.

4 Press the A or V key repeatedly until >Service > appears.

>Service >

5 Press the D> key.
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3.13 Other Modes

6 Press the A or V key repeatedly until >>Print Status Page appears.

®
@ @7 >>Print
©

Status Page

7 Press the ENTER key. A question mark (?) appears.

ENTER >>Print
Status Page ?

8 Press the ENTER key. The display indicates Processing and printing starts.

ENTER
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Chapter 4 Printer Drivers and

Utilities

L

Note

This chapter contains the following information:

e  How to install the printer driver
*  Printing from applications
*  Configuring optional units

This chapter provides basic information that let you learn how to setup and run the printer
driver. Further detailed information can be obtained by the printer driver’s online help. To read
the online help, use the Help button on each of the dialog boxes of the printer driver.

For improvement purpose, the user interface design and functionalities of the printer
driver may vary depending on the version. The diagrams used throughout this chapter
are only for examples.



4.1 Printer Drivers and Utilities

4.1 Printer Drivers and Utilities

The printer is supplied with the printer drivers and other printer utilities in the CD-ROM as
listed below.T The latest drivers and utilities are also available on the Internet at http://
www.kyocera.com/w2k.

Operating Software Name Description
System
Windows PCL printer drivers HP PCL 5c¢ compatible printer drivers,
Windows 95/98/Me, Windows NT 4.0/
2000
KPDL printer drivers Adobe PostScript level 3 language com-
patible printer drivers (including PPD
files), Windows 95/98/Me, Windows NT
4.0/2000
KX printer drivers Both KPDL and PCL compatible printer
drivers, recommended for most users,
Windows 95/98/Me, Windows NT 4.0/
2000
IC Link Writes data in an external storage device,
e.g. amemory card.
KM-NET VIEWER Remotely monitors printers in the net-
work.
KM-NET VIEWER for An administrator version of KM-NET
Web Edition VIEWER that runs on a web server.
NDPS Gateway Implements the Novell Distributed Print
Services gateway needed for NDPS sup-
port of Kyocera Mita printers.
KM-NET Printer Disk Helps administor/print jobs in the hard
Manager disk in the printer.
Printer Deleter Deletes an installed printer with its associ-
ated dependent files and registry entries.
TrueType screen fonts Includes model dependent fonts available
for all Kyocera Mita printers.
Online documents Supplements the paper documentation
supplied with the printer
Adobe Acrobat Reader To read online documents
Macintosh PostScript Printer Descrip-  For Kyocera Mita printers
tion (PPD) files
ColorSync profiles Adds support for Kyocera Mita Color
printers, placing them into the Color Sync
folder.
TrueType screen fonts Includes model dependent fonts available
for all Kyocera Mita printers.
Online documents Supplements the paper documentation
supplied with the printer
Adobe Acrobat Reader To read online documents
Table 4-1
¥  The contents of the CD-ROM may vary depending on the CD-ROM version. Also, the version of

the CD-ROM supplied with the printer may differ.
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4.2 Printer Driver

4.2 Printer Driver

The printer driver provides you with control of the various printer features from most
application software. In general, you can access to the printer driver from an application
software by selecting File, Print, then Properties.

4.2.1 Installing the Printer Driver

Use the following procedure to install the driver on your operating system.

Windows 95/98/Me or Windows NT 4.0/2000

1 Set the CD-ROM in your PC’s CD-ROM drive.
Click the Windows Start button, then select Run.
Type [CD drive letter]: \ setup.

Press Enter. After several moments, the main screen appears.

o ODN

i Kyocera Mita Digital Library

Main Menu

|Install Drivers

Driver Tools
Printer Utilities
Networking
Documentation
Select Language

£¥) KYOCERS

Figure 4-1

The main screen will automatically appear if your Windows installation is set to support
CD-ROM auto insert notification.

&

Note

5 Click Install Drivers. Follow the rest of the wizard and finish the driver installation.




4.2 Printer Driver

Macintosh

1 Set the CD-ROM in your Macintosh computer’s CD drive.
Double click the CD-ROM icon on the desktop.

Press Enter. After several moments, the main screen appears.

S WON

Double click the Installer. Follow the instructions on the screen and finish the
installation.




4.3 Configuring the Printer Properties

Configuring the printer allows you:

4.3 Configuring the Printer Properties

Access the option devices (such as the extra paper feeders, duplexer [standard for model
FS-8000CD], sorter, etc.) across all application software

Assign the default output device
Change the default paper source

The following section describes how to configure these basic items using the printer
properties. To configure the printer properties, you must access the printer Properties dialog
as described below.

The printer driver online help will describe the printer settings in more detail.

4.3.1 Printer Properties

Open the Properties dialog to configure the option settings as follows:

1

Figure 4-2

B3 Printers M= 3

J File Edit “iew Go Favorites Help |

j@.».@‘% ?

Back Fanyard Up Cut Copy

J Address I Printers

|>|‘_

¥ &

Add Printer

Open

Fause Printing
Set az Default

Purge Print Documents _—

Sharing...

Create Shortcut
Delete
Fiename

Dizplays the properties of the selected items. i

Click Windows Start, point to Settings, and click Printers.

Right-click the printer icon (F§-8000C KX) and click Properties. The Properties
dialog will open.




4.3 Configuring the Printer Properties

Option Devices

The following procedure will enable the installed option device(s) that are accessible from
the application software.

1 Click the Device Settings tab.

2 Click the checkboxes for the option devices that are installed for your printer.

The following example tells the printer driver that the printer has two extra paper
feeders, a hard disk, and a document finisher installed.

Kyocera Mita F5-8000C KX Properties EHE

General I Dretailz I Color Management I Sharing | Medi aur | Color I Prologue/E pilogue I
Imaging | Dutput Device Settings | About

[ evice Options:

[ Paper Feeder [Cassette 1, 2)
Paper Feeder [Cassette 3, 4]
Paper Feeder [Cassette 5, 6]
O Duplex Unit

M D ocument Finisher
orter Stacker
Offset Stacker
Hard Disk...

Rt Digk

User.. | Memary: |54MB ﬂ
Adminigtrator... | sk Dyeks |12MB ﬂ

QK I Cancel Lol Help

Figure 4-3

3 Click OK.




4.3 Configuring the Printer Properties

Selecting the Default Output Destination

The Output tab allows you to select the output destination, such as a document finisher,
sorter, bulk stacker, etc., which will receive the printed pages in all application software.
Before this selection, you must configure the available devices using the previous procedure.

You can temporarily change the default output destination to another from within the
application software.

1 Click the Output tab.

To reach the Output tab under Windows NT 4.0/2000, Click Windows Start, point
to Settings, and click Printers. Right click the printer icon, then click Document
Defaults (Windows NT 4.0) or Printing Preferences (Windows 2000).

2 Click and scroll down the Output to drop down list and select the desired output
destination.

Printer Default delivers the printed pages into the output destination that you set
using the printer’s operator panel (MENU>Paper Handling>Stack Select).

Kyocera Mita F5-8000C KX Properties EHE
General I Dretailz I Color Manzgemnes Sharing I Media I Layout I Color I Frologue/E pilogue I
Imaging | Device Settings I About

Clutput bo: Copies:

Mailbox [Face-dwn]
Frinter Default
Top

Tray [Face-down)

& | [Uppenlleft
[~ Staple ) Boolilet
£ BLaflet Stk

™ Oifset

Job Settings... |
QK I Cancel | Lol Help

Figure 4-4

3 Click OK.
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4.3 Configuring the Printer Properties

Selecting the Default Paper

The default, paper size for the printer driver is Letter size for the U.S. and Canada, and A4
for other countries. To change the default paper size, proceed as follows:

1 Click the Media tab.

To reach the Media tab under Windows NT 4.0/2000, Click Windows Start,
point to Settings, and click Printers. Right click the printer icon, then click
Document Defaults (Windows NT 4.0) or Printing Preferences (Windows
2000).

2 Click and scroll down the Page Size drop down list and select the paper size that
you desire to use for all application software.

You may want to leave Print Size as Same as Page Size for printing jobs in
normal (100 %) size. Changing Print Size to any other size that differs from the
Page Size will force the printer to automatically enlarge or reduce the page so that
it fits on the paper.

Kyocera Mita F5-8000C KX Properties EHE
Imaging I Olutput I [leyice Settings I About I
General I Dretailz I Color Management I Sharing Layout I Color I Frologue/E pilogue
FPage Size: Letter - 8.5 %11 in.
Frint Size: Letter - 85211 in.
ISame az Page Size j
Orientation:
& Portrait
™ Rotated
" Landscape
Source: IAuto Source Selection j
Media Type: IAuto Media Selection j

QK I Cancel Lol Help

Figure 4-5

3 Click OK.
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4.4 Printing Using the Printer Driver

4.4 Printing Using the Printer Driver

This section explains how to proceed with printing using the printer driver. The explanation
below allows you to select the paper source, select the output device, etc., temporarily
overriding the default settings explained in the previous section.

The printer driver online help will describe the printer settings in more detail.

441 Basic Printing Task

To start printing your document, open the Print dialog (below) from the application software
(File>Print). Then, perform the following:

1 Click the Name drop down list and select the Kyocera Mita FS-8000C KX printer.

Select the range of the pages you want to print in the document. To print the whole
document, select All.

3 Specify the number of copies you want to print in the Number of Copies combo box.

Click OK. Printing begins when the printer is ready to print.

[ 71|
1 Kvocera Mika Fo-f 3 Propetties |
Status: Idle
Type: Kyocera Mika FS-8000C KX
‘Where: 2 ™ Print to fils
Comment:
Page range —Copie:
Lo | Mumber of copies: 3
i Current page £ Selection
" Pages: I [~ Collate
ETIer page NUMDErs anidjor page ranges

separated by commas, For example, 1,3,5-12

Zoom

Print what: IDocument j Pages per sheet: |1 page vl
Pint: [0 pages in range x| | 5cale to paper size: |No Scaling vl

optens._| o)) oo |

Figure 4-6
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4.4 Printing Using the Printer Driver

442 Advanced Printi

ng Tasks

To take full advantage from the printer’s many features, you can change the default settings
on the fly from within the application software. This allows you to:

Select N-up

To perform these advanced tasks, open printer Properties from within the application
software. Then, click the tab on the dialog as instructed below.

Accessing Printer ‘Properties’ from the Application Software

To access the printer Properties from the application software, select Print from the File

Select the paper source and paper (media) type
Select the destination of the printed pages
Select how to handle TrueType fonts sent to the printer

Adjust color using RGB levels or hue, saturation, and lightness.

menu. Then, click Properties.

Print HE
rinker
Mame: | (‘3 Kyocera Mita F5-G000C KX LI .
Status: Idle
Type: Kyocera Mika FS-8000C KX
‘Where: ™ Print to fils
Comment:
'age range HCopie:
Lo | Mumber of copies: |1 5‘

i Current page £ Selection

" Pages: I

Enter page numbers andjor page ranges
separated by commas, For example, 1,3,5-12

=

=
R

:

Zoom

Print what: IDocument j Pages per sheet: |1 page vl
Print: IAII pages in range j Scale to paper sizet |No Scaling hd
Options. .. OF I Close |
Figure 4-7

Selecting the Paper Source

The default printer paper size is Letter for the U.S. and Canada, and A4 for other countries.
If you want to temporarily print using a different paper size, select the paper size in the

Media tab.

Click the Media tab. Select the paper size that matches the document to print in the Page

Size drop down list.
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4.4 Printing Using the Printer Driver

Kyocera Mita F5-8000C KX Properties EHE
' ayoutl Color I Prologue.-"EpiIogueI Imagingl Dutputl About I

Page Size: Letter - 8.5 %11 in.

P-' Fortrait
™ Rotated
" Landscape

Source: IAuto Source Selection j

Media Type: IAuto Media Selection j

glﬂm Frestane [Mefaults |
QK I Cancel | Help |

Figure 4-8

Selecting the Output Destination

To specify the output destination for particular print job, select the output destination in the
Output tab. Available output destinations are dependent on the optional output devices
attached to the printer and their configuration in the Device Settings tab.

If your printer has an optional output device such as document finisher or sorter stacker, you
can select mailbox or bulk stacker as the output destination in Output to drop down list. And
you can also select Finishing Options. If the sorter has been installed and configured, these
checkboxes allows you to select sorter mode. For details on sorter mode, refer to page 3-94.

Kyocera Mita F5-8000C KX Properties EHE
Medial Layoutl Color I Prologue.-"EpiIogueI Imaginbout I

Clutput to: Copies:

II Mailbox [Face-down) - l I|1 ﬂ

Finizhing Options:

IV Caollate Iﬂl Iﬂl

™ Mailbox: IMaiIbox 1 'l

Job Settings..

Fiestore Defaults |

QK Cancel | Help |

Figure 4-9




4.4 Printing Using the Printer Driver

Handling TrueType Fonts

The TrueType Fonts in the Imaging tab specifies how TrueType fonts are sent to the
printer. You may wish to use this function if you encounter problems in printing fonts.

Download TrueType fonts as  This option sends the font outlines of TrueType fonts to the printer.

outline This is the default for handling TrueType fonts. You may wish to
use one of the other selections below if you encounter problems in
printing TrueType fonts.
Download TrueType fonts as  This option will designate TrueType fonts to be downloaded to the
bitmap printer as bitmap fonts.
Kyocera Mita F5-8000C KX Properties EHE
Media I Layout I Color I Prologue.-"EpiIoguutput I About I

Frint Quality:
High [uality J

TrueType Fonts:

& Download TrueType fonts as outline

" Download TrueType fonts as bitmap

1 Substitute with Device fonts:

Fiestore Defaults |
QK I Cancel | Help |

Figure 4-10

Color Mode, Color Correction, and Color Adjustment

The printer automatically optimizes the color and halftoning based on the ambient
conditions when it is powered up (Color calibration). Therefore, you do not have to adjust
the printer's color features unless you desire to customize your color printing jobs.

You can customize color features of the printer and store it in different Custom settings for
later recall.

Following items are available in the Color tab.
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4.4 Printing Using the Printer Driver

Kyocera Mita F5-8000C KX Properties EHE

Media I LayouProIogue.-"EpiIogueI Imagingl Dutputl About I

Color tode:

| || Colar [CHYK) =l I J

Colar Correction:

& Automatic

' None [Application Corected)

" Monitor Simulation (RGE): [HGB [HDTY] 'l

€ Ink Simulation (CvKE  [fore =

o

(YOCER
:g Frestane [Mefaults |

T ——
QK I Cancel | Help |
Figure 4-11
Color Mode Allows you to select between Color and Monochrome (black and white) print-

ing, and to select Custom Color Mode settings. CMYK is an acronym for Cyan,
Magenta, Yellow and Black.

Color Allows you to specify how the printer processes color matching in the job. Color

Correction matching is the process of accurately and consistently converting RGB colors
(how colors are displayed on the video monitor) to CMYK colors (how colors are
used for output printing). Monitor Simulation (RGB) corrects colors in the
RGB mode, as they appear on a monitor screen. Ink Simulation (CMYK) cor-
rects colors in the CMYK mode using either Euroscale or SWOP.

Color Allows you to set and save Custom color adjustments. Under Color Adjust-

Adjustment ment in the Color tab, select Custom 1, Custom 2, or Custom 3, then click
the button on the right of color Ajustment to open the Color Adjustment (Cus-
tom) dialog box. For details, see Color Adjustment dialog box below.
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4.4 Printing Using the Printer Driver

Color Adjustment dialog box

First, in the Color Adjustment (Custom) dialog box, you should select Color Space
that is HSL or RGB. Then, according to the Color Space, you can adjust the followings.

Color Adjustment [Custom 1]

— Hue Adjustment

I I aster = l } IU_

— Saturation and Lightne:

Saturation }

Lightness {:} j

Color Space

& HSL [Hue, Saturation, and Lightness)

 RGE

Ok I Lancel |

Figure 4-12

HSL (Hue, Saturation, and Lightness)

Hue adjustment You can adjust the entire image at once or adjust a specific color.

Select Master (the default setting) and drag the slider right or left to adjust the
entire picture at once by changing each hue to another hue. Every part of the
image becomes a different color. The upper color bar and the 3-D image will
change to illustrate your setting.

Select a specific color from the drop down list and drag the slider right or left
to adjust only that color. The selected color changes to the hue on either side of
the spectrum. The horizontal bracket above the upper color bar shows which
part of the color bar is being edited.

Click Reset to return all hue adjustment settings to normal.

Saturation and You can adjust the brightness, contrast, and vividness of the color.

Lightness * Drag the Saturation slider to adjust levels between vivid and dull.
« Dragthe Lightness ( £¥ ) slider to lighten or darken the graphic images.
*  Drag the contrast ({Jp ) slider to adjust levels between black and white.
*  Click Reset to return all Lightness and Saturation levels to normal.
RGB
RGB Level You can adjust the relative values of R (Red), G (Green), and B (Blue), to the col-

ors of a computer monitor. Click and drag the slider under each bar.

Printing in N-Up

You can specify how many pages of your document to print on one sheet of paper. To
specify the number of pages, select the Layout tab and select the appropriate number for
Pages per Sheet. The maximum number of pages is 25.

Scaling allows you to enlarge or reduce the printed pages from 20 to 500 % with reference
to the original paper size.
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4.4 Printing Using the Printer Driver

If you have the option duplex unit installed in your printer”, you can activate duplex printing
by checking in Print on Both Sides (Duplex). You can then choose from either Flip on
Long Edge or Flip on Short Edge for binding.

Kyocera Mita F5-8000C KX Properties

Figure 4-13

Tt Model FS-8000CD is equipped with the duplex unit as a standard equipment.
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4.5 Configuring the Network Printer

4.5 Configuring the Network Printer

If you have installed an option network interface card on the FS-8000C or purchased a FS-
8000CN (network model), you can attach and configure the printer on a network.

To successfully configure the network printer, you will have to:

* Install the network interface card in the printer (except for the FS-8000CN)

»  Set the IP address, netmask, and gate way

*  Activate the appropriate network protocol (TCP/IP, Novell NetWare, AppleTalk, etc.)
using the software (supplied with the network interface card)

*  Share the printer on the network, if desired

You can use the instructions provided with the option card to complete these steps. In
general, the information you will be required to enter during these steps must be obtained
from your network administrator.

To set the IP address, netmask, and gateway, using the printer operator panel, see Chapter 3
Using the Operator Panel, section 3.5.4 Resolving IP Address on page 3-43 .

To print a network status page, see Chapter 3 Using the Operator Panel, Printing a
Network Interface Card Status Page on page 3-44.




4.6 Installing a Printer Driver for Macintosh

4.6 Installing a Printer Driver for Macintosh

The CD-ROM also contains printer drivers, utilities, and PPD files for Macintosh computers.
These files are separated by country and can be installed by double-clicking on the installer
file (for example, the English Installer) in each country folder.

To install the printer driver in your language, follow these steps.

1

a A ODN

Set the supplied CD-ROM in the CD-ROM drive. An icon will appear on the desktop.
Double-click the CD-ROM icon.
Double-click the Drivers folder. Double click the appropriate language folder.

Double click the appropriate FS-Series installer icon for your environment from the
choices of languages on the screen.

Follow the instructions on the screen and perform the rest of the operation.




4.6 Installing a Printer Driver for Macintosh
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Chapter 5 Troubleshooting

This chapter explains how to handle printer problems that may occur. If a problem cannot be
corrected, contact your Kyocera Mita dealer. This chapter explains the following topics:

*  General Guidelines

*  Print Quality Problems
e Error Messages

*  Clearing Paper Jams



5.1 General Guidelines

5.1 General Guidelines

The table below provides basic solutions for problems you may encounter with the printer.
We suggest you consult this table to troubleshoot the problems before calling for service.

Symptom Check Iltems Corrective Action

Print quality isnot ~ See Section 5.2 Print Quality Problems on page 5-3.
good.

Paperis jammed.  See Section 5.4 Clearing Paper Jams on page 5-13.

Nothing lights on ~ Check that the power cord is properly Turn off the printer’s power, plug in the

the operator panel  plugged into the power outlet. power cord securely, and try turning on
even when power is the printer’s power again.
turned on and th? Check that the power Set the power switch to the On position.
fan makes no noise. s

switch is in the On (])

position.

The printer printsa Check the printer cable or the interface Connect both ends of the printer cable
status page, but cable. securely. Try replacing the printer cable
does not print jobs or the interface cable.

from the computer. Check program files and application ~ Try printing another file or using another

software. print command. If the problem occurs
only with a specific file or application,
check the printer driver settings for that
application.

Table 5-1

511 Tips

Printer problems may be solved easily by following the tips below. When you have
encountered a problem that following the above guidelines will not solve, try the following:

e Turn the printer power off and wait for several seconds. Then, turn on the printer.
*  Reboot the computer which sends the print jobs to the printer.

* Obtain and use the latest version of the printer driver. The latest printer drivers are
available from your local Kyocera Mita web site, or http://www. kyocera.com/
w2k.

*  Make sure that the procedures for printing are correctly followed in the application
software. Consult the documentation supplied with the application software.

» If'the printer prints garbage characters or stalls when the computer is turned on,
particularly when the printer is connected to the computer under Windows 98 via the
parallel port, rename device driver file drvwppqt.vxd. This file may be located in
Windows\System\losubsys or Arcada\System folder. For technical details, visit
Microsoft web site for the device driver.
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5.2

Print Quality Problems

Print Quality Problems

The tables and diagrams in the following sections define print quality problems and the
corrective action you can conduct to solve the problems. Some solutions may require cleaning
or replacing parts of the printer.

If the suggested corrective action will not solve the problem, call for service.

Printed Results

Corrective Action

Completely blank printout

Check the toner containers.

Open the printer front cover and check that the toner
containers are correctly installed in the printer. For
more information on installing the toner containers,
see the separate Installation Guide supplied with
the printer.

Check the primary transfer unit.

If paper is jammed in the primary transfer unit,
remove the paper. See Figure 5-17 on page 5-23 for
details.

Check that the application software is correctly
operated.

All-black printout

Call a service.

Table 5-2
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5.2 Print Quality Problems

Printed Results

Corrective Action

Black or white vertical streaks

ABC
123

ABC
123

Check the operator panel for toner.

Ifthe Toner low TK-82 message is displayed
with color description, install a new toner kit for the
color. To replace the toner container, see Chapter 6
Maintenance, section 6.1 Toner Container
Replacement on page 6-2.

Direction
of Paper
Feed

Clean the main charger and the separation charger.

Open the printer front cover. Pull the green clean-
ing knob slowly in and out a few times. For full
details, see Chapter 6 Maintenance, section 6.5.2
Cleaning the Main Charger Unit on page 6-20.

Have a service person check the fuser unit.

Faint or blurred printing

If monochrome printing, check the EcoPrint (toner
saver) setting. If EcoPrint is unintentionally set to
On, switch it to Off on the operator panel.

Clean the main charger and the separation charger.

Open the printer front cover. Pull the green clean-
ing knob slowly in and out a few times. For full
details, see Chapter 6 Maintenance, section 6.5.2
Cleaning the Main Charger Unit on page 6-20.

Check the primary transfer unit for jammed paper
remaining.

For removal of jammed paper, see /[Paper Jam —
Paper Feed Unit] on page 5-18.

Make sure the paper type setting is correct the paper

ABC
123

ABC
123

being used. See Chapter 3 Using the Operator
Panel, section 3.10.4 Setting the Cassette Paper
Type on page 3-82.

Conduct color calibration either by switching the
printer off then on or using the printer operator
panel (MENU). For full details, see Chapter 3

Using the Operator Panel, section 3.11.4 Color

ABC
123

Calibration on page 3-100.

Try adjusting the color control settings using the
printer driver.

Try switching the tone mode between Normal and
Fine using the operator panel (Menu>Print Qual-
ity>Tone).

Check the operator panel. If the Toner low TK-
82 message is displayed with color description,
install anew toner kit for the color. To replace toner,
see Chapter 6 Maintenance, section 6.1 Toner Con-
tainer Replacement on page 6-2.

Table 5-2 (Continued)
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5.2 Print Quality Problems

Printed Results Corrective Action

Grey background Clean the main charger and the separation charger.

Open the printer front cover. Pull the green clean-
ing knob slowly in and out a few times. For full
details, see Chapter 6 Maintenance, section 6.5.2
Cleaning the Main Charger Unit on page 6-20.

Conduct color calibration either by switching the
printer off then on or using the printer operator
panel (MENU). For full details, see Chapter 3
Using the Operator Panel, section 3.11.4 Color
Calibration on page 3-100.

Clean the rubber belts. See below. For details, see
Chapter 6 Maintenance, section 6.5.1 Cleaning the
Paper Feed Unit on page 6-16.

Clean the main charger and the separation charger.

Open the printer front cover. Pull the green clean-
ing knob slowly in and out a few times. For full
details, see Chapter 6 Maintenance, section 6.5.2
Cleaning the Main Charger Unit on page 6-20.

Clean the parts in the paper paths—such as the
paper cassette, etc.

Check secondary the transfer roller.

If the secondary transfer roller is dirty with toner,
try printing several pages.

Printing incomplete or out of position Check that the application software is correctly
operated.

See 5.1.1 Tips on page 5-2.

ABC

139

Table 5-2 (Continued)

5-5



5.2 Print Quality Problems

Printed Results

Corrective Action

Oily streaks at the top of the page and
approximately 15 cm below

ABC
123

15cm

This may happen when printing is made
using a new oil unit or after the printer has
been left unused for a prolonged period of
time.

Try printing several pages until the streaks
disappear.

Table 5-2 (Continued)




5.3 Error Messages

5.3 Error Messages

The tables on the following pages indicate how to respond to problems indicated by the
operator panel indicators and messages.

5.3.1  Error Messages

The following table lists errors and maintenance messages that can be dealt with by yourself. If
Call service appears, turn off the printer, disconnect the power cord, and contact your
Kyocera Mita dealer.

Some errors cause the alarm sound to sound. To stop the alarm sound, press the CANCEL key to stop the
alarm sound.

Message Corrective Action

Add paper (paper source) The paper has run out in the paper source displayed. Supply paper accord-
ing to the paper source displayed (paper cassettes, MP tray, or optional
paper feeders).

This message is displayed alternately with messages indicating the printer
status, such as, Ready, Please wait,Processing,Waiting,and
Form Feed Time Out. Ifthe number of copies to printis 2 or more,
only the Add paper message is displayed.

Add staples
Press GO

The optional document finisher has run out of staples. Replenish staples
and press the GO key.

Call service
####:0123456

### # represents a mechanical error (#=0, 1, 2, ...). Call a service. The
printer does not operate when this message is displayed. The total number
of pages printed is also indicated, e.g. 0123456.

Call service
F###:0123456

F# ## represents a controller error (#=0, 1, 2, ...). Call a service. The
printer does not operate when this message is displayed.

Call service

This message means an error in data communications between the printer

Person FO  controller and the operator panel. Call a service.
Cassette # The corresponding paper cassette is not installed. Install the cassette. The
not loaded cassette number can be 1 (topmost) to 6 (bottom); and for the duplexer

model, 2 to 6.

Check waste toner
bottle

This message warns following two cases. Install the new waste toner bottle.

e The waster toner bottle is not installed.
¢ The waste toner bottle is almost full.

Clean printer
Press GO

The printer has reached the schedule to conduct cleaning. Clean the inside
of'the printer . See Chapter 6 Maintenance, section 6.5 Cleaning the
Printer on page 6-16. This message will be automatically displayed when
replacing the toner container after the message Replace toner TK-
82 is displayed. After cleaning the inside of the printer, press the GO key
and the printer will resume printing.

Duplex drawer
not loaded

The duplex drawer is not installed. Install the duplex drawer. This message
is applicable to the duplexer model.

Face-down tray
paper full

The face-down tray has become full (approx. 500 pages). You must
remove all printed pages from the face-down tray. When the printer senses
that the face-down tray is empty again, the printer will continues printing
into the face-down tray.

Table 5-3
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5.3 Error Messages

Message

Corrective Action

Face-up tray
path error

The face-up tray is not open although you have attempted to print in the
face-up tray. Open the face-up tray.

File not found
Press GO

You have attempted to print a job that is not contained in the specified tray
of the virtual mailbox,or the specified tray of the virtual mailbox is not
found.

If Auto Continue is set to On, printing will be automatically resumed after
a preset period of time.

Format error
Memory Card

The memory card inserted in the printer is not formatted, and therefore
cannot be read or written. To format a memory card, follow the procedure
in Chapter 3 Using the Operator Panel, section 3.9.2 Reading/Writing to
an Option Storage Device, Formatting a Storage Device on page 3-75.

Format error
Hard disk

The hard disk installed in the printer is not formatted, and therefore cannot
be read or written. To format the hard disk, follow the procedure in the
Installation Guide of the hard disk.

Front cover
open

The front cover is open. Close the front cover .

Hard disk err ##
Press GO

A hard disk error has occurred. Look at the error code given in place of ##
and refer to Section 5.3.2 Storage Error Codes on page 5-11 . To ignore the
hard disk error, press the GO key.

I/F occupied

This message is displayed when you attempt to use the printer’s operator
panel to change the environmental settings on the interface from which
data are presently being received.

ID error

The user ID entered for a private job, or a stored job is not correct. Check
the user ID that you specified on the printer driver.

Insert the same
memory card

You have inserted the wrong memory card when the Insert again
message was displayed. Remove the wrong memory card from the
printer’s memory card slot and insert the correct memory card. The printer
again reads it from the beginning of the data.

Install MK Replace Maintenance Kit A. Replacement of the maintenance kit A is nec-

a1t essary at every 400,000 images of printing and requires professional ser-
vicing. Contact your Kyocera Mita dealer.

Install MK Replace Maintenance Kit B. Replacement of the maintenance kit B is nec-

= essary at every 200,000 pages of printing and requires professional servic-
ing. Contact your Kyocera Mita dealer.

Install MK Replace Maintenance Kit C. Replacement of the maintenance kit C is nec-

[cf essary at every 200,000 images of printing and requires professional ser-
vicing. Contact your Kyocera Mita dealer.

Install MK Replace Maintenance Kit D. Replacement of the maintenance kit D is nec-

o1t essary at every 100,000 pages of printing and requires professional servic-

ing. Contact your Kyocera Mita dealer.

Note: This message is not applicable for European countries and
Australia.

KPDL error ##
Press GO

Current print processing cannot continue because of occurrence of KPDL
(PostScript) error which is categorized by ##. To print out an error report,
display > Print KPDL err(or)s from the menu system, and select On.
Press the GO key to resume printing. You can abandon printing by the
CANCEL key.

If Auto Continue is set to On, printing will be automatically resumed after
a preset period of time.

Table 5-3 (Continued)
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5.3 Error Messages

Message

Corrective Action

Load Cassette #

(paper size)/ (paper type)ﬁ

The paper cassette matching the paper size and paper type of the print job
is empty. Load paper into the paper cassette. The option paper feeder cas-
settes are indicated by #. Press the GO key to resume printing.

Or, if you want to print from a different paper source, press the V or A key
todisplay Use alternative andyoucan change the source for paper
feeding. After selecting a paper source and pressing the MENU key,
Paper Handling >appears. By pressing the A key, the paper type set-
tings menu appears. After setting the correct paper type, press the ENTER
key and printing starts.

If you want to print from a different paper source, see Chapter 3 Using the
Operator Panel, section 3.10.5 Selecting the Paper Feed Source on page
3-84.

Load MP Tray

(paper size)/ (paper type)ﬁ

There is no paper cassette installed in the printer that matches the paper
size and paper type of the print job. Set paper in the MP tray. Press the GO
key to resume printing. (Note that feeding the paper having a paper size
which does not match the current paper size from the MP tray can cause
paper jam.)

Or, if you want to print from a different paper source, press the V or A key
todisplay Use alternative andyou canchange the source for paper
feeding. After selecting a paper source and pressing the MENU key,
Paper Handling > appears. By pressing the A key, the paper type set-
tings menu appears. After setting the correct paper type, press the ENTER
key and printing starts.

If you want to print from a different paper source, see Chapter 3 Using the
Operator Panel, section 3.10.5 Selecting the Paper Feed Source on page
3-84.

Memory card err
Insert again

The memory card is accidentally removed from the printer’s memory card
slot during reading. If you continue reading the memory card, insert the
same memory card into the slot again. The printer again reads it from the
beginning of the data.

Alsosee Tnsert the same memory card.

Memory overflow
Press GO

The total amount of data received by the printer exceeds the printer’s inter-
nal memory. Try adding more memory. Press the GO key to resume print-
ing. You can abandon printing by the CANCEL key.

If Auto Continue is set to On, printing will be automatically resumed after
a preset period of time.

MemoryCard err##
Press GO

A memory card error has occurred. Look at the error code given in place of
## and refer to Section 5.3.2 Storage Error Codes on page 5-11. To ignore
the memory card error, press the GO key

Missing
duplex drawer

The duplex unit is not installed. Install the duplex unit.

Missing
stapler unit

The stapler unit is not installed in the optional document finisher. Install
the stapler unit in the document finisher.

Missing toner
TK-82 ######4

Install the toner container using a toner kit for the particular color. The
printer does not operate when this message is displayed.

Option interface
error ##

A failure has occuerred with the option network interface card. Check the
option network interface card installed in the printer.

Option stacker
cover open

The cover of the optional finishers (bulk stacker, document finisher, or
sorter) is open. Close the cover.

Option stacker
paper full

The optional bulk stacker (ST-30) tray is full. Remove paper sheets.

Table 5-3 (Continued)
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5.3 Error Messages

Message

Corrective Action

Option stacker
path error

The optional bulk stacker, document finisher, or sorter is not installed
properly. Correct the installation.

Option tray ##
paper full

A tray of the optional document finisher (DF-31) or sorter (SO-30) is full.
Remove paper sheets in the corresponding tray as displayed in place of # #.

Paper feeder #
side cover open

The side cover of paper feeder is open. Close the cover of the paper feeder
1 (topmost) to 3 (bottom) as displayed in place of #.

Paper jam
FHEHFH RS

A paper jam has occurred. The location of the paper jam is indicated in
place of the #’s. For details, see Section 5.4 Clearing Paper Jams on page
5-13.

Paper loading

After the paper cassette is closed, papaer loading is in progress in the paper
cassette.

Print overrun'''

Press GO

The print job transferred to the printer was too complex to print on a page.
Press the GO key to resume printing. (The page may break in some
pages.).

You can abandon printing by the CANCEL key.

If Auto Continue is set to On, printing will be automatically resumed after
a preset period of time.

RAM disk error##
Press GO

A RAM disk error has occurred. Look at the error code given in place of # #
and refer to Section 5.3.2 Storage Error Codes on page 5-11 . To ignore the
RAM disk error, press the GO key.

Remove paper
option tray ##

Paper remains in an option document finisher or sorter tray as displayed in
place of ##. Remove paper sheets.

Replace toner
Clean printer

v 4

Replace toner
TK-82 ######4#

Two message items are displayed alternately. Toner has run out in the toner
container(s). Replace the toner container using a new toner kit for the par-
ticular color. The printer does not operate when this message is displayed.

Forexample,ifReplace toner C,Kisdisplayed, replace the cyanand
the black toner containers.

Set paper
Press GO

The MP tray is out of paper. Load paper and press the GO key. (Note that
feeding the paper having a paper size which does not match the current
paper size from the MP tray can cause paper jam.)

Side cover
open

Open the side cover at the printer’s left side, then close tightly.

Toner low
TK-82 #######

Replace the toner container using a new toner kit. Color of the toner con-
tainer that needs to be replaced is represented by ## ##### : C(Cyan), Y
(Yellow), M (Magenta), and K (black).

Unsupported
external device

A device not supported by the printer is installed. Install an optional bulk
stacker supported by the printer.

Virtual mail box
full

The storage area in the hard disk for the virtual mailboxes is full. Print out
accumulated jobs in the virtual mailboxes.

Warning
low memory

The printer’s internal memory is running low due to too many numbers of
fonts and macros downloaded. Try deleting unnecessary fonts and macros.

Table 5-3 (Continued)

t  These messages may be displayed altogether such as Install MK [A] [B][C][D].

1 Messages separated by °/* are displayed alternately.

T11 After this error has happened, page protect mode will be automatically turned on. To maintain op-
timum use of memory during printing, we recommend you manually turn off page protect mode.
See Chapter 3 Using the Operator Panel, section 3.7.3 Page Protect Mode on page 3-60.
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5.3.2 Storage Error Codes

5.3 Error Messages

Hard Disk Errors
Code Meaning
01 Hard disk format error. If this error recurs even if the power has been turned off and then on,

reformat the hard disk.

02

The disk system is not installed. Recheck the requirements for using the system and the
devices.

03

Cannot write in the hard disk because write protection is enabled. Disable write protection.

04

There is no available hard disk space. Delete unnecessary files, etc., in order to free up space.

05

The specified file does not exist in the hard disk.

06

There is no memory available to the hard disk system. Increase the available memory.

10

Formatting is not possible because host data is being spooled on the hard disk. Wait until the
hard disk is ready, and then format.

20

The hard disk was installed in the incorrect (OPT1) slot. Reinstall the hard disk in a different
(OPT2/HDD) slot.

85

VMB: Alias error. The alias setting was lost, or the virtual tray corresponding to the alias
does not exist. Set the alias again.

86

VMB: Password error. There is no password specified, the password is incorrect, or the pass-
word setting is lost. Confirm the correct password.

87

VMB: Although an attempt was made to use a virtual tray job stack, the stack size reached the
maximum limit.

88

VMB: An unreadable job or page was found while outputting the jobs in a virtual tray. The job
is damaged.

97

The number of permanent code jobs that can be stored reached the limit value, and no more
can be saved. Either delete some unnecessary jobs, etc., or increase the limit.

98

An unreadable page was found in a job (The job is damaged.).

Table 5-4

Memory Card Errors

Code

Meaning

01

The printer does not support the memory card inserted. The memory card must meet the
requirements described in Appendix A Options, section A.3.1 Memory Card on page A-7.

02

The memory card is not installed.

03

The memory card is write-protected. Cancel the write-protection of the memory card.

04

The memory card is full and cannot hold further data. Purge unnecessary files or use a new
memory card.

05

Specified file is not on the memory card.

06

Insufficient printer memory to support the memory card system. Expand printer memory.

Table 5-5




5.3 Error Messages

RAM Disk Errors

Code Meaning

01 Format error. Try turning the power off and on again.

02 RAM disk mode is Of £. Turn RAM disk mode On from the operator panel.

03 Cannot write to the disk system because it is write protected. Remove the write protection.
04 No disk space. Purge unnecessary files.

05 Specified file is not on disk.

06 Insufficient printer memory to support the RAM disk system. Expand printer memory.
Table 5-6
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54 Clearing Paper Jams

5.4 Clearing Paper Jams

If the paper jammed in the paper transport system, or no paper sheets were fed at all, the
Paper jam message appears and the location of the paper jam (the component where the
paper jam has occurred) is also indicated. The printer automatically goes off-line when this
message is displayed. Remove jammed paper. After removing jammed paper, the printer will
re-start printing.

5.4.1

Possible Paper Jam Locations

The figure below explains the printer’s paper path including the options, for example, the
document finisher and the duplexer (a standard accessory for the FS-8000CD). Possible areas
where paper jam can occur are indicated by the letters A through M, each explained in Table 5-
7 below. Paper jams can occur in more than one component on the paper path.

PD-30 (Duplexer + Paper
Feed cassette)

PF-30A
o IS4 iS4
Figure 5-1
Possible location of Jam Reference

A Feeder 1 Cover See Section 5.4.3 [Paper Jam —

B Feeder 2 Cover Feeder # Cover] on page 5-15.

Cc Feeder 3 Cover

D MP Tray See Section 5.4.5 [Paper Jam — MP
Tray] on page 5-16.

E Cassette 1 (FS-8000C/FS-8000CD) See Section 5.4.4 [Paper Jam — Cas-
sette #] on page 5-15.

Table 5-7
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5.4 Clearing Paper Jams

Possible location of Jam Reference

E Duplexer (FS-8000CD) See Section 5.4.6 [Paper Jam —
Duplexer Drawer] on page 5-17.

F Cassette 2 See Section 5.4.4 [Paper Jam — Cas-

G Cassette 3 sette #] on page 5-15.

H Cassette 4

| Cassette 5

J Cassette 6

K Option Stacker See Section 5.4.9 [Paper Jam— Option
Stacker| on page 5-24.

L Side Cover See Section 5.4.8 [Paper Jam — Side
Cover] on page 5-23.

M Paper Feed Unit See Section 5.4.7 [Paper Jam — Paper

Feed Unit] on page 5-18.

Table 5-7 (Continued)

5.4.2 General considerations for clearing jams

Bear in mind the following considerations when attempting jam removal:

f? When you remove paper jams, be sure to remove all of the jammed paper in the printer.

» Ifpaper jams occur frequently, try using a different type of paper, replace the paper with
paper from another ream, flip the paper stack over, or rotate the paper stack 180
degrees. Selection of paper is fully discussed in Chapter 2 Handling Paper on page 2-1.
The printer may have problems if paper jams recur after the paper was replaced.

*  Whether or not the jammed pages are reproduced normally after printing is resumed
depends on the location of the paper jam.

Utilizing Online Help Messages

Online help messages are available in the printer’s message display to provide simple
instructions for clearing jams. Press the ? key when the paper jam message has appeared.
Then a help message will appear to facilitate jam clearing in the location.
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5.4 Clearing Paper Jams

5.4.3 [Paper Jam — Feeder # Cover]

The paper jammed inside the feeder side cover as the paper leaves the paper cassette. Clear the
jam in the indicated feeder cover.

1 Open the paper feeder side cover. Pull the paper outward. Close the cover.

Figure 5-2

5.4.4 [Paper Jam — Cassette #]

The paper jammed in the paper cassette as indicated by # (=1,2,3...), from the topmost feeder
cassette to the bottom feeder cassette. Clear the jam in the indicated paper cassette.

1 Open the paper cassette. Remove the paper.

Figure 5-3




5.4 Clearing Paper Jams

545 [Paper Jam — MP Tray]
The paper jammed in the MP tray. Clear the jam in the MP tray.

1 Remove the jammed paper on the MP tray up and towards the right.

I

Figure 5-4

2 Reset the sheets on the MP tray.

Open and close the front cover to notify the printer of the completion of jam
removal.




5.4 Clearing Paper Jams

5.4.6 [Paper Jam — Duplexer Drawer]

This message is relevant to the FS-8000CD.
The paper jammed inside the duplexer drawer. Clear the jam in the following locations:

*  Upper cover
* Lower cover

1 Open the duplexer drawer towards you.

First, open the upper plastic cover of the duplexer drawer to remove the jammed paper
under the cover.

Upper Cover

Then open the lower plastic cover of the duplexer drawer to remove the jammed paper
under the roller.

Lower Cover

Figure 5-5

When the jammed paper sheets are removed, close both covers of the duplexer. Close
the duplexer drawer completely.




5.4 Clearing Paper Jams

5.4.7 [Paper Jam — Paper Feed Unit]

The paper jammed inside the paper feed unit. After checking and clearing the jam in the
paper feed unit, also check the fuser unit and the primary transfer unit. Clear any paper jams
in these components.

1 Open the front cover.

Front Cover

Figure 5-6

2 Grasp the handle at the end of the paper feed unit and pull the unit out completely.

Paper Feed Unit

Figure 5-7

5-18



ing Paper Jams

5.4 Cleari

3 Swing the green-colored lever to the right. Remove the jammed paper, if any, inside the

cover.

Figure 5-8

4 If there is jammed paper on the belts in the middle of the paper feed unit, remove the

paper.

Figure 5-9
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5.4 Clearing Paper Jams

If the paper is jammed in the fuser unit, open the fuser access cover by pressing the
green-colored lock lever.

—lﬂ The fuser unit is hot. Wait for a while until the fuser unit cools down.

Lock Lever
(Green-colored)

Fuser Access Cover

Figure 5-10

Open the fuser top cover by simultaneously pulling the two lock levers (green-
colored). Remove the jammed paper.

Lock Lever (green-colored)

Lock Lever (green-colored)

Top Cover

Figure 5-11
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5.4 Clearing Paper Jams

7 If the paper is hard to remove, raise the sub-cover by grasping the clip marked as A on
the rear side while removing the paper.

Sub-cover

Figure 5-12

8 If the paper winds around the fuser roller, turn the wheel on the left-hand side of the
fuser unit toward you. The jammed paper will be driven out. Remove the jammed

paper.

Figure 5-13
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5.4 Clearing Paper Jams

If driving the paper in the reverse direction will ease removing the paper, you can
turn the wheel away from you by pressing the stopper lever.

Stopper Lever

Figure 5-14

9 Set the green lever on the front of the primary transfer unit clockwise to the position
of six o’clock (usually this lever is in a position of four o’clock). This unlocks the
primary transfer unit.

Primary Transfer Unit

Green Lever

Figure 5-15

10 Grasp the handle at the end of the primary transfer unit and pull the unit out.

Primary Transfer Unit

Figure 5-16
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5.4 Clearing Paper Jams

1 1 Turn the wheel (with gear teeth) on the right-hand side of the primary transfer unit
away from you. The primary transfer unit will turn at the same time. Remove the
jammed paper.

Gear teeth

Figure 5-17
fI? Use care not to touch the drum component of the primary transfer unit.
1 Push the primary transfer unit back in. To do this, lower the lock button close to the

bottom end of the lever to unlock the lever. Set the lever (in the position of six o’clock)
back to the original (four o’clock) position. See the figure below.

Green Lever

Lock Button

Figure 5-18

1 3 Push the fuser unit back in and close the top cover. To close the cover, be sure to pull
the left and right lock levers (the lock levers are green) toward you. See Figure 5-11 on
page 5-20. The top cover cannot be closed properly if you skip this.

1 4 Close the front cover.

5.4.8 [Paper Jam — Side Cover]

The paper jammed in the face-up tray. After checking and clearing the jam in the face-up tray,
also check the side cover for the face-up tray. Clear any paper jams in these components.
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5.4 Clearing Paper Jams

1 Open the side cover for the face-up tray.

/

ALIARAAANRY

Figure 5-19

Remove the jammed paper gently. If the paper is stuck under the roller, grasp the
green-colored knob and rotate the roller so that the paper is driven out.

Figure 5-20

3 Close the side cover. Close the face-up tray.

5.4.9 [Paper Jam — Option Stacker]

The mailbox/sorter, bulk stacker, and the document finisher are optional equipment. When
this message is displayed, refer to the appropriate documentation for the option attached
with the printer.
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Chapter 6 Maintenance

This chapter describes basic maintenance tasks you can perform on the printer. You can
replace the following component according to the printer’s display:

¢ TK-82 C/M/Y/K Toner Kits
*  Waste Toner Bottle

« OilKit

¢ Maintenance Kit D

Also, the following parts need periodic cleaning:

e Paper Feed Unit
*  Main Charger Unit



6.1 Toner Container Replacement

6.1 Toner Container Replacement

6.1.1  Frequency of toner container replacement

The life of the toner containers depends on the amount of toner required to accomplish your
printing jobs. When 5 % coverage (a typical business document) of individual toner colors
is assumed for A4 or letter size paper in landscape orientation, without using draft (EcoPrint
[monochrome printing only]) mode:

*  The black toner container lasts an average of 25,000 monochrome pages.
* The cyan, magenta, and yellow toner containers last an average of 10,000 color images.

You can print a status page to check how much toner remains in the toner container. For
details, see Chapter 3 Using the Operator Panel, section 3.3.2 Printing a Status Page on
page 3-16 . The Toner Gauge section on the status page shows a progress bar for each color,
which roughly represents how much toner is left in the toner container.

Starter Toner Containers

The toner containers packed with the new printer are starter toner containers. The black
starter toner container lasts an average of 12,500 monochrome pages. The cyan, magenta,
and yellow starter toner containers last an average of 5,000 color images for each.




6.1.2 Toner Kits

6.1 Toner Container Replacement

It is strongly recommended to use the new Kyocera Mita TK-82 Toner Kit supplied from
Kyocera Mita to prevent printer troubles and ensure a long printer life.

The TK-82 Toner Kits are supplied in each of the following four colors. The letter following
TK-82 describes the color of toner included in the container as follows:

TK-82C Cyan
TK-82M Magenta
TK-82Y Yellow
TK-82K Black

A new TK-82 toner kit for each color contains the following items:

Toner Container

Cleaning cloth

Grid cleaner for main charger cleaning

Plastic waste bags for old toner container and old waste toner bottle
Waste toner bottle

Installation Guide

printer.

: ? Do not remove the toner container from the carton until you are ready to install it in the

Note

6.1.3 Understanding Messages Requesting Toner Container Replacement

The printer displays messages for individual colors at two stages of toner usage. This message
is automatically alternated with the other printer message (such as Ready):

When the printer becomes low on toner, for example in the cyan container, the printer
displays the message Toner low TK-82C as the first caution. Note the replacement
is not always necessary at this stage.

If you ignore the above message and continue printing, the printer displays the message
Replace Toner/Clean printer — just before the toner is used up. The toner
container must be replaced immediately. After the replacement is finished, the massage
automatically changesto Clean printer Press GO. Clean the separate charger
wires, etc. After the cleaning is finished, however, the message does not automatically
change to Ready. To restart printing, you must press the GO key and make the printer
ready.

In either case, to replace the toner container, see Section 6.1.4 Replacing the Toner Container
on page 6-4.




6.1 Toner Container Replacement

6.1.4

Replacing the Toner Container

s

Note

During toner container replacement, temporarily put storage media and computer
supplies (such as floppy disks) away from around the toner container. This is to avoid
damaging media by the magnetism of toner.

This section explains how to replace the toner containers. When replacing the toner
container of any color, always replace the waste toner bottle at the same time. If this bottle is
full, the printer may be damaged or contaminated by the waste toner that may spill over the
bottle.

You do not have to turn printer power off before starting the replacement. Any data
that may be under printing process in the printer will be deleted if you turn printer
power off.

To replace the toner container, first make sure of the color of the toner container requiring
replacement. In this example, it is assumed that you are replacing the black toner container.

1 Open the front cover.

= Black (K
Yellow (Y) AN\ AL ack (K)

Magenta (M)

|
Cyan (C) E‘\}\ l ‘ 0 %ﬁ
<

Front Cover

<

Figure 6-1

2 While lowering the lever (blue-colored) at the end of the toner container to unlock
the container, pull the black toner container out.

Lever

Figure 6-2




6.1 Toner Container Replacement

Take the new toner container out of the toner kit. To loosen and redistribute the toner
inside, hold the container and shake the container back and forth at least 5 times.

New Toner
Container

Figure 6-3

Insert the new toner container all the way in. The container is locked automatically
when it is properly seated.

Figure 6-4

Put the old toner container in the plastic waste bag (contained in the toner kit) and
discard it later according to the local code or regulations for waste disposal.

/ —_
’ \’/ / Plastic Waste Bag

Figure 6-5

To replace the other color toner container, use the same procedure above.

Proceed to the next section and replace the waste toner bottle.




6.2 Replacing the Waste Toner Bottle

6.2

Replacing the Waste Toner Bottle

Replace the waste toner bottle each time you replace the toner container. A new waste toner
bottle is included with the toner kit. The printer will not operate without replacing the waste
toner bottle.

1 Pull the paper feed unit all the way out. Tilt to the right the lever on the right-hand
side of the bottle and remove the bottle. Do not place the removed bottle upside
down.

Waste Toner Bottle

Paper Feed Unit

Figure 6-6

The old waste toner bottle has a cap. Remove the cap (black) on the top of the bottle
and put the cap onto the opening as shown below. This is to prevent the toner from
spilling.

Figure 6-7




6.2 Replacing the Waste Toner Bottle

Put the old waste toner bottle in the plastic waste bag (contained in the toner kit) and
discard it later according to the local code or regulations for waste disposal.

Plastic Waste Bag

Figure 6-8

Insert the new waste toner bottle (contained in the toner kit) upright until it snaps into
place.

New Waste Toner Bottle

Figure 6-9

Do not put the lid on the opening of a new waste toner bottle. This could cause damage to
the printer.

After replacing the toner containers and the waste toner bottle, clean the paper feed unit and
the main charger unit. For instructions, see Section 6.5 Cleaning the Printer on page 6-16.




6.3 Replacing the Oil unit

6.3 Replacing the Oil unit

The oil unit lasts an average of 25,000 pages and must be replaced when the printer displays
the Replace 0il kit message.

1 Open the front cover.

Front Cover

Figure 6-10

2 Grasp the handle at the end of the paper feed unit and pull the unit out completely.

Paper Feed Unit

Figure 6-11
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6.3 Replacing the Oil unit

The fuser unit is very hot. Never touch the fuser unit until the fuser cools down.

&

Fuser Unit

Figure 6-12

3

Open the front and rear release levers outward and remove the oil unit.

Figure 6-13
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6.3 Replacing the Oil unit

4 Take out the new oil unit from the cover. Remove the sealing tapes at both ends.
Attach the new oil unit. Seat it securely by pressing on the front and rear sides (the
PUSH HERE areas).

H . New Oil Unit

Figure 6-14
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6.3 Replacing the Oil unit

5 Push the paper feed unit back in completely.

Figure 6-15

6 Close the front cover.

Figure 6-16




6.3 Replacing the Oil unit

7 Put the cover (that was used with the new oil unit) to the old oil unit and put the oil
unit in the plastic waste bag (contained in the oil kit) and discard it later according to
the local code or regulations for waste disposal.

Figure 6-17




6.4 Replacing the Maintenance Kit D (Separation Charger Unit)

6.4 Replacing the Maintenance Kit D (Separation Charger Unit)

4

Note

The following procedure is not necessary for European countries and Australia.

The separation charger unit needs to be replaced after every 100,000 pages of printing. When
the printer displays the message Install MK [D] (ATTENTION indicator flashes),
replace the separation charger unit as follows.

1 Open the front cover.

2 Grasp the handle at the end of the paper feed unit and pull the unit out completely.

Paper Feed Unit

Figure 6-18

3 Remove the old separation charger unit from the secondary transfer unit. When you
pull the projecting pin on the front end of the separation charger unit towards you as
shown, the back end of the separation charger unit lifts up. Hold the back end of the
separation charger unit to remove it.

Separation Charger
Unit

™~ Projecting pin

Secondary Transfer Unit

Figure 6-19




6.4 Replacing the Maintenance Kit D (Separation Charger Unit)

Hold the new separation charger unit so that the projecting pin is in front of you and
pass the green knob (separation charger wire cleaning knob) through the secondary
transfer unit. Press the back side to lock the unit.

Green knob (Separation Charger
Wire Cleaning Knob)

Figure 6-20

5 Push the paper feed unit back in completely and close the front cover.

Paper Feed Unit

Figure 6-21

6 Use the operator panel to reset the counter. Press the MENU key. Press the [A] or
[V1] key repeatedly until Others > appears.

Others >




6.4 Replacing the Maintenance Kit D (Separation Charger Unit)

7 Press the [[>] key. Press the [A] or [V] key repeatedly until >Service > appears.

>Service >

8 Press the [[>] key again. Press the [A] or [V] key repeatedly until >>Maintenance
[D] appears.

>>Maintenance [D]

9 Press the ENTER key. A question mark (?) appears.

>>Maintenance [D]?

10 Press the ENTER key again. A question mark disappears and the counter of
maintenance kit D is reset.

11 Press the MENU key. The message returns to Ready.




6.5 Cleaning the Printer

6.5 Cleaning the Printer

As discussed earlier, the following parts must be cleaned each time the toner container and
waste toner bottle are replaced:

*  Paper feed unit
*  Main charger unit

In addition to this, it is recommended that these parts are cleaned periodically at least once a
month.

6.5.1 Cleaning the Paper Feed Unit

Print problems such as soiling of the reverse side of printed pages may occur if the paper
feed unit becomes dirty. To clean the paper feed unit, the following tool must be used:

*  Cleaning cloth (included in the toner kit)
Clean the paper feed unit according to the procedure that follows:

1 Open the front cover.

Figure 6-22




6.5 Cleaning the Printer

2 Grasp handle on the paper feed unit and slowly pull it out.

Paper Feed Unit

Figure 6-23

3 Clean the registration roller (metal) using the cleaning cloth.

Registration
Roller [Metal]

Figure 6-24
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6.5 Cleaning the Printer

4 Clean the rubber belts using the cleaning cloth.

: ? Be careful not to touch the black, sponge roller (secondary transfer roller) during
cleaning as this may adversely affect print quality.

Figure 6-25

Grasping the tab of the separation charger cleaning knob, gently pull the cleaning
knob out and push it back in. Repeat this 5 to 7 times. This cleans the separation
charger wires inside.

Cleaning knob (Green)

Figure 6-26
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6.5 Cleaning the Printer

6 Push the paper feed unit back in completely.

Paper Feed Unit

Figure 6-27

7 Close the front cover.

Front Cover

Figure 6-28
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6.5 Cleaning the Printer

6.5.2 Cleaning the Main Charger Unit

The main charger unit needs to be cleaned periodically as it gets contaminated with dioxide
after a long usage. The main charger is comprised of two main parts — the wire and the grid
— which should be cleaned separately as instructed below.

To clean the main charger unit, proceed as follows:

1 Open the front cover.

2 First we clean the main charger wire. Grasp the tab of the cleaning knob (green-
colored). Gently pull the cleaning bar out and push it back in. Repeat this 3 to 5
times.

Cleaning knob

Figure 6-29

Next, we clean the main charger grid. Take the grid cleaner out of the toner kit. Take
the grid cleaner out of the protective bag and remove the cap.

Cap
Grid Cleaner
Figure 6-30
: ? The pad of the grid cleaner contains water. Clean the grid quickly so that the pad may
not dry off.
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6.5 Cleaning the Printer

4 Attach the grid cleaner to the printer with the pad facing up.

Figure 6-31

5 While pushing the main charger unit lock lever upward as shown in Figure 6-32,
slightly lift the main charger unit, and gently pull the gray-colored main charger
handle out and push it back in. Repeat this 2 to 3 times. These movements clean the
grid.

Lock Lever

Main Charger Unit

Figure 6-32

After cleaning is finished, remove the grid cleaner from the printer and discard it.
The grid cleaner cannot be reused. Close the front cover.

If the front cover does not fully close, although the printer shows Ready, open the front
cover and push the main charger unit until it is fully inserted in the printer.
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6.5 Cleaning the Printer
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Appendix A Options

Your printer can be installed with various options indicated in this appendix.
You can select the options that will satisfy your printing requirements.
For availability of the options, consult your Kyocera Mita dealer.

weight in the printer and the upper paper drawers. To prevent the FS-8000C printer from
tipping over, the optional CA-31B caster kit must be installed when the printer is
installed with more than one paper feeder or a duplex unit. For detailed information on
the CA-31B caster kit, see page A-11.

—lﬂ CA-31B is a caster kit to prevent the FS-8000C printer from tipping over because of



A.1 Options

Options

A1

The FS-8000C series printers have the following options available. For instructions on

installing individual options, refer to the documentation included with the option. Some

options are explained in the following sections.

Expansion Memory
(DIMM 32/64/128 MB)
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AR

Hard Disk
HD-3 (3.2 GB)
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Expansion Memory Modules

A.2 Expansion Memory Modules

To expand the printer memory for more complex print jobs and faster print speed, you can plug
in optional memory modules (dual in line memory modules) in two memory slots provided on
the printer main controller board. You can select additional memory modules from 32, 64, or
128 MB (the maximum memory size is 256 MB, including the base 64 MB memory).

f ? Only an authorized Kyocera Mita dealer should install the expansion memory. Kyocera
Mita shall not be liable for any damages caused by improper installation of expansion
Note memory.

Precautions on handling the printer's main controller board and memory
modules

»  To protect electronic parts, discharge static electricity from your body by touching a water
pipe (faucet) or other large metal object before handling the memory modules. Or, wear an
antistatic wrist strap, if possible, when you install the memory modules.

*  Always hold the main controller board or a memory module by its edges as shown below
to avoid damaging electronic parts.

YES

NO

Figure A-2




A.2 Expansion Memory Modules

A.2.1 Installing the Memory Modules

1 Power off the printer and unplug the printer power cord.

2 Unscrew three screws at the back of the main controller board.

Main Controller Board

AN

LN

Figure A-3

3 Pull out the main controller board gently.

AN
AN

==
==
==
==
==
==
==
==
=

Figure A-4




Installing the Memory Modules

4 Push out the clamps on both ends of the memory socket on the main controller board.

Clamps

|

{ @\‘

Figure A-5

Remove the memory module from its package. Aligning the cutouts of the memory
module with the matching keys of the socket, carefully plug the memory module into
the memory socket until it clicks in place.

Cutouts

Figure A-6




A.2 Expansion Memory Modules

6 Push down the two socket clamps to secure the memory modules.

Clamps

Figure A-7

After you finish installing the memory modules, reinstall the main controller board
and fasten it with screws.
Removing a Memory Module
To remove a memory module, remove the main controller board, then carefully push out the
two socket clamps. Ease the memory module out of the socket to remove.
Testing the expanded memory
To verify that the memory modules are working properly, test them by printing a status

page. To print a status page:

1 Make sure the printer is switched off. Plug in the printer power cord into an AC
outlet and power on the printer.

2 Wait until the printer becomes Ready. When ready, press the MENU key.

3 Press the V key repeatedly until the message display shows Print Status
Page.

4 Press the ENTER key twice. A status page is printed.

Check the Memory field in the upper right area. It shows information about the memory
modules installed in memory slots 1 and 2. If you see an increase in the total memory size,
the installation is successful. (Note that the printer is shipped with 64 MB of base memory.)




Memory Card

A.3  General Discription of Options

A.3.1 Memory Card

The printer is equipped with a slot for a memory card with the maximum size of 64 MB. A
memory card is useful for storing fonts, macros, and overlays. You can use the IC Link for
Windows utility to download fonts, etc., to a flash memory card. This software is included in
the CD-ROM supplied with the printer.

Reading Font from the Memory Card

Once inserted in the printer’s slot, the contents of the memory card can be read from the
control panel or automatically when you power on or reset the printer. To manually read read
data in the memory card, see Chapter 3 Using the Operator Panel, section 3.9.2 Reading/
Writing to an Option Storage Device on page 3-70.

—lﬂ Before inserting a memory card in the printer, make sure that the printer is switched off.

Insert the memory card in the memory card slot.

Memory Card Slot

Figure A-8




A.3 General Discription of Options

A.3.2

PF-30A Paper Feeder

&

The PF-30A paper feeder has two paper cassettes allowing a large number of sheets of paper
to be fed continuously for printing. The paper cassette can hold up to approximately 500
sheets of ISO A3, ISO A4, ISO A5, JIS B4, JIS BS, ledger, letter, and legal size (80 g/mz)
paper. This feeder is attached at the bottom of the printer as shown below.

To prevent the printer from tipping over because of weight in the printer and the upper
paper drawers, the CA-31B caster kit must be installed at the bottom-most paper
feeder, when an optional paper feeder or duplex unit is installed with the printer.

For detailed information on installing the paper feeder, see the manual supplied with the
paper feeder.

Figure A-9




PD-30 Duplex Unit

A.3.3 PD-30 Duplex Unit

This duplex unit is provided as a standard accessory for the FS-8000CD printer.

The PD-30 is similar to the PF-30A paper feeder but has a duplexer (required for printing on
both sides of a sheet) in place of the first paper cassette. Printing on both sides can be
performed using ISO A3, ISO A4, ISO A5, JIS B4, JIS BS5, ledger, letter, and legal sized paper.

The paper cassette can hold up to approximately 500 sheets of ISO A3, ISO A4, ISO AS, JIS
B4, JIS BS, ledger, letter, and legal size (80 g/mz) paper. This unit is attached at the bottom of
the printer as shown below.

To prevent the printer from tipping over because of weight in the printer and the upper
paper drawers, the CA-31B caster kit must be installed at the bottom-most paper feeder,
when an optional paper feeder or duplex unit is installed with the printer.

For detailed information on installing the duplex unit, see the manual supplied with the duplex
unit.

Figure A-10




A.3 General Discription of Options

A.3.4 SO-30 Sorter

The SO-30 sorter has nine output trays that can be used to separate printouts in accordance
with different print driver settings—sorting or collating. You can also use it in mailbox
mode to prevent loss or mishandling of printouts by assigning dedicated output trays to
specific departments or individuals.

The sorter is attached to the left side of the printer as shown below.
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Figure A-11

A.3.5 ST-30 Bulk Stacker

This bulk stacker can hold up to 3,000 copies for a continuous, voluminous output. It
incorporates the jog feature to avoid loss or mishandling of printouts by staggering and
dividing the stacked printed sheets.

The bulk stacker is attached to the left side of the printer as shown below. Use the supplied
dedicated bracket to attach the bulk stacker to the printer.
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Figure A-12




DF-31 Document Finisher

A.3.6 DF-31 Document Finisher

This multipurpose device is used for organizing printouts. The device can staple printed sheets
by electronic means and provides three output trays for stacking printed sheets after dividing
and staggering them according to print jobs.

The document finisher is attached to the left side of the printer as shown below. Use the
supplied dedicated bracket to attach the document finisher to the printer,
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Figure A-13

A.3.7 CA-31 Casters and CA-31B Caster Kit

1

These casters are mounted at the bottom of the bottom feeder for moving or fixing the printer.
The CA-31 is the regular casters that may be used for the standalone FS-8000C, including only
the standard PF-30A paper feeder or PD-30 duplex unit. The CA-31B is the topple-resistant,
heavy-duty caster kit. The CA-31B must be installed when the printer is installed with one or
more extra paper feeders.

The manufacturer is not liable for any damages or injuries that may be caused when the
CA-31B is not used to support the printer having more than one paper feeders.
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CA-31 CA-31B
Figure A-14

A-11



A.3 General Discription of Options

A.3.8

A.3.9

HD-3 Hard Disk

The HD-3 hard disk is provided as a standard accessory for the FS-8000CN printer.

The HD-3 is a hard disk for storing print data and electronic sorting as controlled by the
printer driver. You can use the KM-NET Printer Disk Manager utility to keep track of the
stored data. This software is included in the CD-ROM supplied with the printer.

The hard disk is installed in the OPT2/HDD (upper) slot provided for it at the back of the
printer as shown below.

The hard disk must be formatted before the initial use. To format the hard disk, use the
printer operator panel or the KM-NET Printer Disk Manager. Before you install the hard
disk in the printer, power off the printer and unplug the power cord.

OPT2/HDD Slot

Figure A-15

* Do not install the hard disk in the OPT1 (lower) slot.

* This printer remains energized for 30 minutes even after it is powerd off
for internal cooling. Unplug the power cord before installing the hard disk
in the printer. Power on the printer immediately after you finish the hard
disk installation.

BC-1 Barcode Reader

The barcode reader allows your printer to use bar codes for the management of stored print
jobs. This barcode reader is connected to the printer’s serial interface.

Serial Connector

Figure A-16




IB-20/IB-21E Network Interface Cards

: ? The printer’s serial interface must be switched to barcode mode when using the barcode
reader.

cooling. Unplug the power cord before installing the barcode reader to the printer. Power

—lﬂ This printer remains energized for 30 minutes even after it is powerd off due to internal
on the printer immediately after you finish the barcode reader connection.

A.3.10 IB-20/IB-21E Network Interface Cards

The IB-21E network interface card is provided as a standard accessory for the FS-8000CN
printer.

Either of these two network interface cards is required to connect your printer to a network.
The network interface cards support TCP/IP, IPX/SPX, NetBEUI, and EtherTalk protocols so
that the printer can be used on network environments including Windows, Macintosh, UNIX,
NetWare, etc. Install the network interface card in either the OPT1 or OPT2/HDD slot located
on the lower right side of the printer rear as shown below.

AN
AN

OPT2/HDD Slot

OPT1 Slot

&

Figure A-17

The two cards differ in their support for connectors and operating voltages. The IB-20 supports
connectors for 10Base-T, 100Base-TX, and 10Base-2, whereas the IB-21E supports
connectors for only 10Base-T and 100Base-TX. The IB-20’s printer interface accepts 3.3 V
and 5 V and allows memory sharing, whereas the IB-21E’s printer interface accepts only 3.3 V
and does not allow memory sharing.

Instructions on installing and operating the IB-20/21E Network Interface Cards are fully
detailed in the documentation that comes with this product.

This printer remains energized for 30 minutes even after it is powered off due to internal
cooling. Unplug the power cord before installing the network interface card to the printer.
Power on the printer immediately after you finish the network interface card installation.
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Appendix B Computer Interface

This appendix describes the signals used by the printer’s parallel and serial (RS-232C)
interfaces. It also describes pin assignments, signal functions, timings, connector
specifications, and voltage levels for these interfaces. Furthermore, the appendix explains the
RS-232C protocol and how to use the printer in a multi-computer environment.



B.1 Parallel Interface

B.1 Parallel Interface

B.1.1 Communication Modes

The printer provides high-speed data transmission on a parallel interface. You can select the
parallel interface communication mode from the operation panel. To change communication
mode, see Chapter 3 Using the Operator Panel, section 3.5.1 Changing Parallel Interface
Mode on page 3-38 .

: ? Use a parallel interface cable that complies with the IEEE 1284 standard.

You can choose from four communication modes:

* Auto (default)

The printer automatically changes its communication mode to the one that is currently
used by the host computer.

* Nibble
Allows high-speed data communications in compliance with the IEEE 1284 standard.

e Normal
The standard communications method for Centronics interfaces.

* High-speed
Enables high-speed data transmission between host computer and printer.
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B.1.2

Interface Signals

Interface Signals
Table shows the connector pins and corresponding input and output signals of the parallel
interface. Explanation of each signal is also given in the table.

The description in [ ] indicates signal names in Auto mode and Nibble (high) mode (IEEE
1284-compliant). In Auto and Nibble modes, these signals are bidirectional.

Pin Inor Signal Description
out
1 In Strobe’ [nStrobe] A negative-going-strobe pulse causes the printer to read
and latch the data on the Data 0 [1] to Data 7 [8] signal
lines.
2 In Data0[Datal] These eight signals form one byte of data sent from host
3 In Datal [Data2] computer to printer. Data 7 [8] is the most significant bit.
4 In Data2 [Data3]
5 In  Data3 [Data4]
6 In Data4 [Data 5]
7 In Data5 [Data6]
8 In  Data6[Data7]
9 In Data7 [Data 8]

10 Out  Acknowledge! [nAck] This negative-going pulse acknowledges the previous
character received.

1" Out  Busy [Busy] When this signal is high, the printer is busy. When it is low,
the printer is able to receive more data.

12 Out  Paper Empty This signal goes high when the printer runs out of paper. "

[PError]

13 Out  Online (Select) [Select] This signal goes high when the printer is online and low
when the printer is offline. The signal goes low when you
press the GO key to make the printer go off line.

14 In  —[nAutoFd] Ignored

15 — — Not used

16 — 0VDC

17 —  Chassis Ground

18 — +5VDC This pin is used for the printer’s +5 V DC power supply
(+5£0.5 V, 400 mA maximum, with fuse)

19 —  Ground return

20 —  Ground return

21 —  Ground return

22 —  Ground return

23 —  Ground return

24 —  Ground return

25 —  Ground return

26 —  Ground return

27 —  Ground return

Table B-1
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B.1 Parallel Interface

Pin Inor Signal Description
out

28 —  Ground return

29 —  Ground return

30 —  Ground return

31 In — [nInit] Ignored

32 Out  Error' [nFault] When the high-speed parallel line control is set to on ('R!
FRPO 02, 2; EXIT;), this line returns an error status.

33 —  — Not used

34 —  — Not used

35 Out Power Ready This signal goes high when the printer is powered on.

36 In  SelectIn[nSelectIn]  When this line is high, IEEE1284 mode is enabled.

Table B-1

t  Indicates signals that are low active.
+1 The Paper Empty , Online, and Error signals work only after you have enabled them using the O2
parameter of the FRPO command.

B-4



Interface Signals

B.2 Serial Interface

B.2.1 Interface Signals

Table B-2 below shows the pins and corresponding input and output signals of the RS-232C
interface connector.

Pin In or out Signal Description
1 — FG Frame Ground. This pin is connected directly to the
printer frame.
2 Out TXD Transmit Data. This pin is used to output asynchronous

data sent from the printer to the computer. This signal is
often used in handshaking.

3 In RXD Receive Data. This pin is used to input serial asynchro-
nous data sent from the computer to the printer.
4 Out RTS Request To Send. This output is always high (above 3
volts).
In CTS Clear To Send. Not used.
In DSR Data Set Ready. Not used.
7 — SG Signal Ground. This pin is used to establish acommon ref-

erence level for the voltages of all signals other than
Frame Ground.

20 Out DTR Data Terminal Ready . This pin is used to notify the status
of the printer buffer (i.e., nearly full or nearly empty)
when handshaking is used. The pin goes high (above 3
volts) when the buffer is able to accept more data.

Table B-2

B.2.2 Interface voltage levels

The voltage levels of the interface signals conform to EIA RS-232C specifications. The
voltage level of SPACE is 3 to 15 volts. The voltage level of MARK is -3 to -15 volts. Voltages
between -3 and 3 volts are undefined.

B.2.3 Serial connector

The serial interface connector (RS-232C) is a DB-25S connector. Use a cable with a DB-25P
connector or its equivalent for this connector.




B.3 RS-232C Protocol

B.3

B.3.1

RS-232C Protocol

Parameters of the RS-232C Protocol

A protocol is a set of rules followed by various devices to send or receive data. The
parameters of the RS-232C protocol are stored in the battery-powered memory of the
printer. You can verify these parameters on the status printout as marked by the following
identifications:

HI:
H2:
H3:
H4-:
H5:
Heé:
H7:
HS:

Baud rate

Number of data bits

Number of stop bits

Parity

Protocol logic
Buffer-nearly-full threshold
Buffer nearly-empty threshold
Received data buffer size

The parameters can be changed from the printer operator panel. To change the value for the
serial interface parameters, see Chapter 3 Using the Operator Panel, section 3.5.2
Changing Serial Interface Parameters on page 3-39.

This following section outlines the parameters and their values you can select on the
operator panel:

H1: Baud rate

Parameter value Baud rate

12
24
48
96
19
38
57
11

1200
2400
4800
9600
19200
38400
57600
115200

The factory setting is 96 (9600 baud).

H2: Number of data bits

7 or 8. The factory setting is 8.

H3: Number of stop bits

1 or 2. The factory setting is 1.




PRESCRIBE FRPO D0 Command

H4: Parity

Parameter value Meaning
0 None

1 Odd

2 Even

3 Ignored

The factory setting is 0 (none).

H5: Protocol logic

Parameter value Meaning

0 Combination of DTR (positive logic) and XON/XOFF
1 DTR (positive logic)

2 DTR ( negative logic)

3 XON/XOFF

4 ETX/ACK

The factory setting is 0.

H6: Buffer nearly-full threshold

A percentage value from 0 to 99. The factory setting is 90.

H7: Buffer nearly-empty threshold

A percentage value from 0 to 99. The factory setting is 70. The factory settings of the buffer
nearly-full and nearly-empty thresholds (H6 and H7) are subject to change without notice.

The difference between the nearly-full and nearly-empty thresholds allows the computer to
send a fairly large amount of data in a continuous stream.
H8: Received data buffer size

The input buffer size is specified in increments of 100 kB. The factory setting is 5 (500 kB).

B.3.2 PRESCRIBE FRPO D0 Command

The PRESCRIBE FRPO D0 command is provided to allow manipulating XON/XOFF when
an error has occurred on the serial interface. Table B-3 summarizes the error status
corresponding to different DO values.

Timing of XON transfer to Serial interface error

host while Ready or Waiting error not handled error handled
XON sent every 3-5 seconds DO0=0 (default) D0=1

XON not sent D0=10 DO=11

Table B-3




B.4 RS-232C Cable Connection

B.4 RS-232C Cable Connection

B.4.1 Preparing an RS-232C Cable

After you procure an RS-232C cable, check its wiring against the pin assignments shown in
page section B.1.2 Interface Signals on page B-3. If you have an IBM communications
adapter cable type 1502067, use the procedure below to solder the wiring at the end (printer
side) of the cable:

1

3

oO~N O O

Unscrew the plastic cover at the end (printer side) of the cable.

A bare shield wire is provided for each wire in the cable. Solder all shield wires
together into a single bundle.

Connect the bundled shield wires to the connector metal face using a piece of flat
cable about 3 mm wide and 15 mm long,. Make sure that the soldered connections
are secure.

Unsolder wires 2 and 3, then resolder them in a crossover configuration. In other
words, solder wire 2 to pin 3 and wire 3 to pin 2. Cover the solder joints with a
thermofit tube.

Cut wires 4, 5, 6, and 20.

Solder wires 5 and 6 together and connect them to pin 20. Cover the solder joints
with a thermofit tube. Leave wire 4 unconnected.

Tape all remaining loose ends together, or seal them with a thermofit tube.

Screw the plastic cover back on the cable end.

B.4.2 Connecting the Printer to the Computer

Make sure that both computer and printer are powered off.

1

a O DN

Discharge static electricity from your body by touching a metal object such as a
doorknob.

Plug the end (printer side) of the RS-232C cable into the printer's serial interface
connector and screw it on securely.

Plug the other end of the cable into the computer’s serial interface connector.

Power on the printer.

The printer’s parameters are set at the factory as follows:

Baud rate = 9600 bps, data bits (character length) = 8, stop bits = 1, parity = none

The two RS-232C protocols are XON/XOFF and DTR. The printer executes both of
these protocols simultaneously, using positive logic for DTR.




Connecting the Printer to the Computer

If you are not sure about the printer’s current parameter settings, reset them to the
values shown above (i.e., baud rate = 9600 bps, etc.). You can perform parameter
settings from the operation panel. See Chapter 3 Using the Operator Panel, section
3.5.2 Changing Serial Interface Parameters on page 3-39.

On the computer, set the same parameters as that of the printer. Most computers allow
you to do this by DIP switch settings that should be made before power is turned on.

Otherwise, you can make the parameters settings on a Windows 95/98 platform as
follows:

Click the Start button from the Task Bar of Windows 95/98, point to Settings, and
click Control Panel.

On the Control Panel window, double-click System.

The System Properties box opens. Select the Device Manager tab and click the
COM port you want to use.

System Properties [ 2] ]

General Dievice Manager | Hardware F‘rohlesl F’erformancel

% Yiew devices by lype € \iew devices by connection

Computer

-5 COROM

(- Disk dives

@ Display adapters

% Floppy disk controllers

-2 Hard disk controllers

@ Kepboard

Maritors

Mouse

HP Metwork adapters

= Ports (COM & LPT)

B2 Corirurications Port [COM1)
Communications Port [COMZ2)
- Prirter Port LPT1)

1B System devices
-8 Universal senal bus controller

Properties | Refresh | Remove | Print |

Cancel |

Figure B-1

4

Press the Properties button.
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B.4 RS-232C Cable Connection

5 The Properties sheet is displayed for the selected COM port. Select the Port
Settings tab and set the port properties.

Communications Port [COM1) Properties [ 2] ]

General Port Settings |Dnver I Hesnurcesl

Biits per secand: -
Diata bits: m
Parity: lﬁ

Stop bits: lﬁ

Flow contral: lm

Advanced | BRestore Defaults |

Cancel |

Figure B-2

6 After setting the properties, click OK.

Using DOS for Serial Connection

To set the computer’s serial parameters to, for example, 9600 bps, etc., at the DOS
command prompt, enter the following:

C:\>MODE COM1:96, N, 8, 1, P
C:\>MODE LPT1:=COM1
To test the interface, enter the following:

CTRL P
C:\>DIR
CTRL P

B-10



Appendix C Technical Specifications

The technical specification may be changed for improvement purpose.

Note



C.1 Printer Specification

CA1 Printer Specification

Item

Specification

Printing method

Electrophotographic four color (CMYK) printing using
laser diode.

Printing speed

See section C.2 Printing Speeds on page C-4.

Resolution

600 dpi (horizontal and vertical)

First print (A4, 23 °C)

Approximately 17 seconds (monochrome)
Approximately 28 seconds (color)

Warm up time (23 °C)

300 seconds or less

Main Controller CPU

PowerPC 750CX (400 MHz)

Main memory

64 MB, expandable up to 256 MB maximum

Expansion Memory Module 32, 64, or 128 MB (for 2 slots)
Operating system Windows 3.1, Windows 95/98/Me, Windows N'T/2000,
Macintosh, Linux
Protocol support IPX/SPX, TCP/IP, DLC
Interfaces Parallel IEEE1284, 1
Serial RS-232C, 1
Option 2, Network interface card or hard disk (KUIO)
Memory card slot Compact flash memory card, maximum 64 MB
Self-diagnostics Performed at power-on
Maximum duty cycle (for standard dry A4 100,000 pages per month for monochrome; 25,000 pages
plain paper) per month for color
Imaging drum Amorphous silicon drum
Developers Four (CMYK) dual-component dry developers
Main charger Positive scorotron charger
Transferring Primary Drum system
Secondary Roller system
Separation Corona charger
Drum cleaning Blade cleaner
Primary transfer drum cleaning Brush cleaner
Drum discharging LED array
Fuser Heat rollers

Toner saving

EcoPrint mode (monochrome printing only)

Paper

See Chapter 2 Handling Paper, section 2.1.2 Paper speci-
fications on page 2-2.

Paper sizes

Cassettes

A3, B4, A4, BS, A5, ledger, legal, and letter sizes, adjust-
able

Multi-purpose tray

80 X 148mm to 310 X 458 mm

Unprintable areas

A top, bottom, left, or right margin of 4 mm

Paper capacity

Cassettes

500 sheets (80 g/mz)

Multi-purpose tray

150 sheets (80 g/mz)

Table C-1
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Printer Specification

Item Specification
Output tray capacities Face-down tray 500 sheets (80 g/m?)
Face-up tray 150 sheets (80 g/m?)
Operating environ- ~ Temperature 10 t032.5°C (50 to 90.5 °F)
ment Relative humidity 15 to 80 %
Optimum condi- 23 °C (73 °F), 60% (relative humidity)
tions
Altitude 2,000 m (6,500 feet) maximum
Illumination 1,500 lux or less
Power supply U.S.A. and Canada 120V, 60 Hz, 11.5 A max
Europe, Asia, 220t0240V, 50 0r 60 Hz, 5.8 A max. at 230 V
Oceania
Allowable voltage + 10 % maximum
fluctuations
Allowable fre- +2 % maximum
quency fluctuations
Power con- U.S. A  Maximum 1,318 W
sumption  and -
Canada Normal operation 412W
Standby 177TW
Sleeping 34 W (FS-8000C/FS-8000CD)
37 W (FS-8000CN)
Europe, Maximum 1,323 W
Asia, B
. Normal operation 437 W
Oceania
Standby 184 W
Sleeping 35 W (FS-8000C/FS-8000CD)
38 W (FS-8000CN)
Noisel Printing LpA =49.7dB (A) (color), 51.1dB (A) (monochrome)
Standby LpA=353dB(A)
Sleeping Negligible
Dimensions Printer 590 (23-1/4) wide X 429 (16-7/8) high X 585 mm (23-5/16
inches) deep
Paper feeder 560 (22-1/16) wide X251 (9-7/8) high X 566 mm (22-5/16
inches) deep
Weight Printer 76.3 kg (168-3/161b)
Paper feeder 19.1 kg (42-1/8 1b)
Duplexer 22.1kg (48-3/41b)

Table C-1 (Continued)

+  Inaccordance with ISO 7779 (Bystander Position, sound pressure level at the front)
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C.2 Printing Speeds

C.2

Printing Speeds

Mode Paper Size Print Speeds
Color Monochrome
Simplex print- A4, Letter 8 pages/minute 30 pages/minute
ing AS 8 pages/minute 15 pages/minute
A3, Ledger, Legal, 4 pages/minute 15 pages/minute
B4, BS
A4 thick, Transpar- 3.5 pages/minute 8 pages/minute
ency (A4)
Duplex print- A4, Letter 8 pages/minute 15 pages/minute
ing' A5 8 pages/minute 15 pages/minute
A3, Ledger, Legal, 4 pages/minute 7.5 pages/minute
B4, BS
Table C-2

¥ The PD-30 duplex unit is required.
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Index

A
Audible alarm
how to set 3-111
Auto-continue
changing recovery time 3-113
how to set 3-112

Cc

Carriage return
how to select 3-62
Cleaning
belts 6-18
main charger unit 6-20
paper feed unit 6-16
registrtion roller 6-17
separation charger cleaning knob 6-18
using the grid cleaning tool 6-20
CMYK 4-13
Color adjustment
CMYK 4-13
Color space 4-14
custom setting 4-12
customizing 4-12
HSL 4-14
Hue 4-14
RGB 4-13, 4-14
Saturation and Lightness 4-14
Color control
calibration 3-100, 4-12
ink simulation 3-99
matching colors to monitors (RGB) 3-98
selecting monochrome or color printing 3-97, 4-13
using the printer driver 4-12
Counters
reading the life counters 3-101
reading the oil kit life 3-102
reading the total printed pages 3-101
toner, how to reset 3-103

D

Data dump
receiving data for damping 3-108
Document finisher
option, diagrammed A-11
Duplex printing
binding modes 3-85
clearing paper jam 5-17
description 3-85
note on using the MP tray 3-87

Duplex unit
option, diagrammed A-9

E
EcoPrint
description 3-64
how to select 3-64
e-MPS
as software feature 1-3
changing configuration 3-32
general information 3-20
how to change hard disk spaces 3-32
printing a list of code jobs 3-29
Emulation
appearing on the status page 3-18
KC-GL, setting pen width and color 3-48
KPDL, printing errors 3-51
KPDL, setting the alternative emulation 3-50
setting the default using the operator panel 3-47
Envelope
requirements 2-10
Error log
on the status page 3-19
Error messages 5-7
of hard disk 5-11
of memory card 5-11
of RAM disk 5-12
tabled, with corrective actions 5-7

Face-down tray
location and function 1-6
Face-up tray
location and function 1-6
Font
adjusting character pitch for fixed fonts 3-55
changing the default size 3-54
printing lists of fonts 3-56
sample of the font list 3-57
selecting regular or dark Courier/Letter Gothic 3-53
setting the default using the operator panel 3-52
TrueType, handling using the printer driver 4-12
Formfeed
changing timeout time 3-105
Fuser unit
location 1-8
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G

Gloss mode
how to select 3-67

H

Handling 2-1

Hard disk
as an option A-12
deleting data 3-74
formatting 3-75
location of the slot 1-9
writing data 3-72

HSL 4-14

|

Indicators

Interface 3-3

Paper Size 3-4

Paper Type 3-4

Ready, Data, Attention 3-4
Ink simulation

SWOP, Euro-scale 3-99

J
Job retention
functions tabled 3-20
private job, how to use 3-25
proof-and-hold, how to use 3-23
quick copy, how to use 3-21
Job storage
functions 3-20

K
Keys
arrow keys 3-7
basic operation 3-6
Cancel 3-6
Enter 3-7
Go 3-6
Menu 3-7
KIR
description 3-63
how to select 3-63
KPDL3
as software feature 1-4

L

Label
required composition 2-9
requirements 2-10

Linefeed
how to select 3-61

Macintosh

available printer drivers and utilities 4-2

Main charger unit
location 1-7
Memory
expanding memory A-3
installing memory modules A-4
on the status page 3-18
Memory card
deleting data 3-74
formatting 3-75
inserting in the slot A-7
location of the slot 1-9
writing data 3-72
Menu map
how to print 3-14
sample 3-15
Menu selection system
road map 3-8
Message display
changing the language 3-104
for replacing toner containers 6-3
indicators included 3-3
Online help messages 5-14
status information 3-2
MP tray
clearing paper jam 5-16
first mode, cassette mode 3-79
location and function 1-6
setting the paper size 3-80
setting the paper type 3-81

N

Network interface

a sample of the network status page 3-46

interface cards, diagrammed A-13
location of the slot 1-9
printing a network status page 3-44
protocols and parameters 3-41
resolving the IP address 3-43
Network printing
general guideline 4-16
Number of copies
how to select 3-58
N-up (Pages per sheet)

printing N-up using the printer driver 4-14
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o)
Oil unit
life and replacement 6-8
Oil kit 6-8
Online help messages
for clearing paper jams 5-14
Operator panel
configuring the printer defaults 3-47
diagram 3-2
function 1-5, 3-2
Options
a list of, diagrammed A-2
barcode reader, diagrammed A-12
Orientation
how to select 3-59
Output device
configuring using the printer driver 4-6
how to select 3-93
setting the default using the printer driver 4-7
sorter 3-94
Override A4/Letter
description 3-88
Ozone filter
location 1-9

P
Page protect mode
how to select 3-60
Paper
available paper 2-2
basic requirements 2-5
colored 2-10
envelopes 2-10
guidelines for choice 2-4
label 2-9
minimum and maximum sizes 2-3
other properties 2-7

paper sizes tabled, as Paper Size indicator 3-4

paper types, as Paper Type indicator 3-4
recommended makes and types 2-3
recycled 2-10
selecting default 4-8
special paper 2-8
specifications, tabled 2-2
standard sizes 2-4
transparencies 2-9
Paper cassette
as hardware feature 1-3
clearing paper jam 5-15
diagram 1-5
selecting the paper feed source 3-84
setting paper type 3-82
Paper feed unit
clearing paper jam 5-18
location and function 1-8

Paper feeder
diagrammed A-8
Paper jam
general considerations 5-14
messages and corrective actions,
diagrammed 5-15
possible locations, diagrammed 5-13
Paper size
setting the default 4-8
Paper type
creating custom 3-88
custom paper type, fuser mode 3-91
how to create custom paper types 3-89
resetting the custom paper type 3-92
Parallel interface
changing parallel inteface mode 3-38
connector, location 1-8
signals and definitions B-3
understanding the modes B-2
Partition
a sample of the partition list 3-77
printing a list of 3-76
type, name, length 3-74
PRESCRIBE
as software feature 1-3
Primary transfer unit
location 1-8
Print quality
EcoPrint 3-64
Gloss mode 3-67
KIR 3-63
Tone mode 3-66
Printer driver
configuring the printer properties 4-5
installing in Macintosh computers 4-16
installing using CD-ROM 4-3
macintosh, how to install 4-17
summarized per OS 4-2
Printer Properties
accessing from the application software 4-10
Printing
advanced printing tasks
using the printer driver 4-10
basic printing tasks using the printer driver 4-9
Printing problems
error messages, tabled 5-7
general guidelines tabled 5-2
print quality problems, blank printing, etc. 5-3

R
RAM disk
setup 3-69
Registration roller 6-17
Reset
resetting the printer 3-109

Index-3



Resource protection \"/
description 3-110 Virtual mailbox
RGB 4-13, 4-14 how to change the maximum space 3-36
printing a list of mailboxes 3-30
retrieving jobs from 3-30
S Vitual mailbox

Separation charger functions 3-21

location of its wire cleaner 1-8
Serial interface

cabling B-8 w
changing parameters 3-39 Waste toner bottle
computer interface B-9 location 1-7
connector, location 1-9 location and replacement 6-8
connector, type B-5 Windows
protocol, RS-232C B-6 available printer drivers and utilities 4-2
signals and definitions B-5
Service

service menu 3-115
Setting the Timer 3-106
Sleep timer
setting the timer 3-106
setting timeout time 3-107
Software utilities
summerized per OS 4-2
Sorter
how to select 3-94
option, diagrammed A-10
sorter mode, collator mode, mailbox mode 3-94
Stacker
bulk, option, diagrammed A-10
Status page
how to print 3-16
understanding 3-17
Storage device
reading fonts from 3-70
reading/writing 3-70
writing data 3-72

T

Tone mode

description 3-66

how to select 3-66
Toner containers

diagram 1-7

how to replace 6-4

kits 6-3

replacement 6-2

replacement, messages 6-3

service life 6-2

starter containers 6-2
Transparency

recommended makes and types 2-9
Two-dimensional barcode

as software feature 1-4
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